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Legal Notices
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special, incidental or consequential damages in connection with the 
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Restricted Rights Legend. Use, duplication or disclosure by the U.S. 
Government is subject to restrictions as set forth in subparagraph 
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in DFARS 252.227-7013.
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Copyright Notice. © Copyright 2001, 2002 Hewlett-Packard Company
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Trademark Notices

Adobe  and Acrobat  are trademarks of Adobe Systems Incorporated.

Java  is a U.S. trademark of Sun Microsystems, Inc.

Microsoft  is a U.S. registered trademark of Microsoft Corporation.

Oracle  is a registered U.S. trademark of Oracle Corporation, Redwood 
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SQL*Net  is a registered U.S. trademark of Oracle Corporation, 
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UNIX  is a registered trademark of the Open Group.

Windows NT  is a U.S. registered trademark of Microsoft Corporation.
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Microsoft Corporation.
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Preface
This document describes procedures for configuration and maintenance 
of HP OpenView Service Desk 4.5. Included in the document are 
instructions for setting up and maintaining user accounts and roles, 
localization, database maintenance and backup.

This guide is intended for use by any application administrator who has 
the responsibility to set up and maintain the Service Desk application 
server for client usability. This will generally mean ensuring Service 
Desk meets the procedural requirements of the user organization. HP 
OpenView Service Desk 4.5 is an extremely flexible product, and 
virtually all functionality is customizable. This great flexibility, however, 
implies that careful consideration must be applied to the set up and 
maintenance of the product.

This guide is organized as follows:

• Chapter 1, “Reviewing the Server Status,” on page 31 describes the 
information displayed in the Server Status Console.

• Chapter 2, “Accounts Administration,” on page 43 explains how to 
create and maintain accounts and roles.

• Chapter 3, “Implementing Languages from the Localization Pack,” 
on page 81 describes how to install a localization pack.

• Chapter 4, “Business Logic,” on page 97 provides guidance on using 
database and UI rules.

• Chapter 5, “Opening Forms from the Command Line,” on page 137 
explains how to use the command line interface to pass data from 
third party software to Service Desk.

• Chapter 6, “Configuring Service Pages,” on page 149 details the 
processes required to configure Service Desk Service Pages.

• Chapter 7, “Multiple Servers,” on page 171 describes how to use 
Service Desk in a multiple server environment.

• Chapter 8, “Multiple Sessions,” on page 179 explains how multiple 
clients sessions can be set up on a single client PC.

• Chapter 9, “Reporting,” on page 187 provides explanations of the 
reporting facilities provided by Service Desk.
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• Chapter 10, “Using E-mail with Service Desk,” on page 215 describes 
how to set up Service Desk for inbound and outbound e-mail 
messaging.

• Chapter 11, “Archiving,” on page 249 explains how to archive Service 
Desk items.

• Chapter 12, “Administrator Console Export Settings,” on page 265 
describes how to use the export settings functionality in the 
administrator’s console.

• Chapter 13, “System Maintenance,” on page 285 suggests procedures 
for backing up your Service Desk system.

• Chapter 14, “Database Sizing,” on page 297 provides information on 
how to maintain sufficient “growing” space on your database. This 
Chapter can be used in conjunction with the two Excel spreadsheets, 
SD Oracle8 sizing.xls and SD SQL Server sizing.xls, provided 
on the Service Desk Windows  CD-ROM.

• Chapter 15, “Support Tools,” on page 309 explains how to use the 
support tools provided with Service Desk 4.5.
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Revision History

When an edition of a manual is issued with a software release, it has 
been reviewed and tested and is therefore considered correct at the date 
of publication. However, errors in the software or documentation that 
were unknown at the time of release, or important new developments, 
may necessitate the release of a service pack that includes revised 
documentation. Revised documentation may also be published on the 
Internet, see “We Welcome Your Comments!” in this preface for the URL. 

A revised edition will display change bars in the left-hand margin to 
indicate revised text. These change bars will only mark the text that has 
been edited or inserted since the previous edition or revised edition.

When a revised edition of this document is published, the latest revised 
edition nullifies all previous editions.

Table 1 Revision History

Edition and Revision 
Number Issue Date Product Release

First Edition July 2002 Service Desk 4.5 
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Related Publications
This section helps you find information that is related to the information 
in this guide. It gives an overview of the Service Desk documentation and 
lists other publications you may need to refer to when using this guide.

The Service Desk Documentation
Service Desk provides a selection of books and online help to assist you in 
using Service Desk and improve your understanding of the underlying 
concepts. This section illustrates what information is available and 
where you can find it.

NOTE This section lists the publications provided with Service Desk 4.5. 
Updates of publications and additional publications may be provided in 
later service packs. For an overview of the documentation provided in 
service packs, please refer to the readme file of the latest service pack. 
The service packs and the latest versions of publications are available on 
the Internet, at http://support.openview.hp.com/cpe/patches and 
http://ovweb.external.hp.com/lpe/doc_serv respectively. See the section 
“We Welcome Your Comments!” in this preface for the URLs.

• The Readme.htm files on the Service Desk CD-ROMs contain 
information that will help you get started with Service Desk. The 
Readme files also contain any last-minute information that became 
available after the other documentation went to manufacturing. 

The Service Desk 4.5 server is coded in Pure Java and is platform 
independent. The installation software for each platform varies. 
Service Desk is therefore distributed on three CD-ROMs, one each 
for Microsoft Windows (2000 and NT4), HP-UX, and Sun Solaris. A 
different readme file is available on each CD-ROM. 

• The HP OpenView Service Desk: Release Notes give a description of 
the features that Service Desk provides. In addition, they give 
information that helps you:

— compare the current software’s features with those available in 
previous versions of the software;

— solve known problems.
  22
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The Release Notes are available as a PDF file on the HP OpenView 
Service Desk 4.5 for Windows CD-ROM . The file name is 
Release_Notes.pdf.

• The HP OpenView Service Desk: User’s Guide introduces you to the 
key concepts behind Service Desk. It gives an overview of what you 
can do with Service Desk and explains typical tasks of different types 
of Service Desk users. Scenario descriptions are provided as 
examples of how the described features could be implemented.

The User’s Guide is available as a PDF file on the HP OpenView 
Service Desk 4.5 for Windows CD-ROM. The file name is 
User’s_Guide.pdf.

• The HP OpenView Service Desk: Supported Platforms List contains 
information that helps you determine software requirements. It lists 
the software versions supported by Hewlett-Packard for Service 
Desk 4.5.

The Supported Platforms List is available as a PDF file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Supported_Platforms_List.pdf.

• The HP OpenView Service Desk: Installation Guide covers all aspects 
of installing Service Desk.

The Installation Guide is available as a PDF file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Installation_Guide.pdf.

• The HP OpenView Service Desk: Administrator’s Guide provides 
information that helps application administrators to set up and 
maintain the Service Desk application server for client usability. 

The Administrator’s Guide is available as a PDF file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Administrator’s_Guide.pdf.

• The HP OpenView Service Desk: Data Exchange Administrator’s 
Guide explains the underlying concepts of the data exchange process 
and gives instructions on exporting data from external applications 
and importing it into Service Desk. The data exchange process 
includes importing single service events and batches of data. 

The Data Exchange Administrator’s Guide is available as a PDF file 
on the HP OpenView Service Desk 4.5 for Windows CD-ROM. The 
file name is Data_Exchange.pdf.
  23



• The HP OpenView Operations Integration Administrator’s Guide 
explains the integration between Service Desk and HP OpenView 
Operations for Windows and UNIX . This guide covers the 
installation and configuration of the integration and explains how to 
perform the various tasks available with the integration. 

The OpenView Operations Integration Administrator’s Guide is 
available as a PDF file on the HP OpenView Service Desk 4.5 for 
Windows CD-ROM. The file name is OVO_Integration_AG.pdf.

• The HP OpenView Service Desk: Migration Guide provides a detailed 
overview of the migration from ITSM to Service Desk, to include an 
analysis of the differences in the two applications. Detailed 
instructions in this guide lead through the installation, configuration 
and other tasks required for a successful migration. 

The Migration Guide is available as a PDF file on the HP OpenView 
Service Desk 4.5 for Windows CD-ROM. The file name is 
Migration_Guide.pdf.

• The HP OpenView Service Desk: Web API Programmer’s Guide 
contains information that will help you create customized 
integrations with Service Desk using the Service Desk Web API. This 
API is particularly suited for developing Web applications. 

The Web API Programmer’s Guide is available as a PDF file on the 
HP OpenView Service Desk 4.5 for Windows CD-ROM. The file name 
is Web_API_pg.pdf.

• The HP OpenView Service Desk: Data Dictionary contains helpful 
information about the structure of the application.

The Data Dictionary is available as an HTML file on the HP 
OpenView Service Desk 4.5 for Windows CD-ROM. The file name is 
Data_Dictionary.htm.

• The HP OpenView Service Desk 4.5 Computer Based Training (CBT) 
CD-ROM is intended to assist you in learning about the functionality 
of HP OpenView Service Desk 4.5 from both a user and a system 
administrator perspective. The CD-ROM contains demonstration 
videos and accompanying texts that explain and show how to 
perform a wide variety of tasks within the application. The CBT also 
explains the basic concepts of the Service Desk application. 
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The HP OpenView Service Desk 4.5 Computer Based Training (CBT) 
CD-ROM will be shipped automatically with the regular Service 
Desk software. The CBT will be available for shipment shortly after 
the release of the Service Desk software.

• The online help is an extensive information system providing:

— procedural information to help you perform tasks, whether you 
are a novice or an experienced user;

— background and overview information to help you improve your 
understanding of the underlying concepts and structure of 
Service Desk;

— information about error messages that may appear when 
working with Service Desk, together with information on solving 
these errors;

— help on help to learn more about the online help.

The online help is automatically installed as part of the Service Desk 
application and can be invoked from within Service Desk. See the 
following section entitled “Using the Online Help” for more 
information.

Reading PDF Files
You can view and print the PDF files with Adobe  Acrobat  Reader. 
This software is included on the HP OpenView Service Desk 4.5 
CD-ROM. For installation instructions, see the readme.htm file on the 
CD-ROM.

The latest version of Adobe Acrobat Reader is also freely available from 
Adobe’s Internet site at http://www.adobe.com.

Using the Online Help
You can invoke help from within Service Desk in the following ways:

• To get help for the window or dialog box you are working in, do one of 
the following:

— Press F1.

— Click the help toolbar button .

— Choose Help from the Help menu.

— Click the help command button  in a dialog box. 
  25
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• To search for help on a specific subject using the table of contents or 
the index of the help system: choose Help Contents & Index from 
the Help menu.

When you are in the help viewer, you can find help on how to use the help 
system itself by clicking the Help toolbar button:

Service Desk also provides tooltips and “What’s This?” help for screen 
items like buttons, boxes, and menus.

A tooltip is a short description of a screen item. To view a tooltip, rest the 
mouse pointer on the screen item. The tooltip will appear at the position 
of the mouse pointer.

“What’s This?” help is a brief explanation of how to use a screen item. 
“What’s This?” help generally gives more information than tooltips. To 
view “What’s This?” help:

1. First activate the “What’s This?” mouse pointer in one of the 
following ways:

• Press Shift+F1.

• Click the “What’s This?” toolbar button .

• Choose What’s This? from the Help menu.

• In dialog boxes, click the question mark button  in the title bar. 

The mouse pointer changes to a “What’s This?” mouse pointer .

2. Then click the screen item for which you want information. The 
“What’s This?” help information appears in a pop-up window.

To close the pop-up window, click anywhere on the screen or press any 
key on your keyboard.
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Typographic Conventions
The table below illustrates the typographic conventions used in this 
guide.

Font What the Font 
Represents Example

Italic References to book titles See also the HP OpenView 
Service Desk: Installation 
Guide.

Emphasized text Do not delete the System 
user.

Bold First-time use of a term 
that is explained in the 
glossary

The service call is the 
basis for incident 
registration.

Courier Menu names You can adjust the data 
view with the commands 
in the View menu.

Menu commands Choose Save from the 
menu.

Button names Click Add to open the Add 
Service Call dialog box.

File names To start the installation, 
double-click setup.htm.

Computer-generated 
output, such as command 
lines and program listings

If the system displays the 
text
C:\>dir a:
The device is not 
ready
then check if the disk is 
placed in the disk drive.

Courier 
bold

User input: text that you 
must enter in a box or after 
a command line

If the service call must be 
solved within 30 minutes, 
enter 30.
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Courier 
italic

Replaceable text: text that 
you must replace by the text 
that is appropriate for your 
situation

Go to the folder 
X:\\Setup, where X is your 
CD-ROM drive.

Helvetica 
bold

Keyboard keys

A plus sign (+) means you 
must press the first key (Ctrl 
in the example), hold it, and 
then press the second key 
(F1 in the example).

Press Ctrl+F1.

Font What the Font 
Represents Example
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We Welcome Your Comments!
Your comments and suggestions help us understand your needs, and 
better meet them. We are interested in what you think of this manual 
and invite you to alert us to problems or suggest improvements. You can 
submit your comments through the Internet, using the HP OpenView 
Documentation Comments Web site at the following URL:

http://ovweb.external.hp.com/lpe/comm_serv

If you encounter errors that impair your ability to use the product, please 
contact the HP Response Center or your support representative.

The latest versions of OpenView product manuals, including Service 
Desk manuals, are available on the HP OpenView Manuals Web site at 
the following URL:

http://ovweb.external.hp.com/lpe/doc_serv

Software patches and documentation updates that occur after a product 
release, will be available on the HP OpenView Software Patches Web site 
at the following URL:

http://support.openview.hp.com/cpe/patches
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1 Reviewing the Server Status

This chapter explains the layout and functionality of the application 
server status console.
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Whether the application server status interface is displayed or not 
depends on the Show Server Status check box that is located on the 
General tab of the Server Settings Editor (see Configuring the 
Application Server in the HP OpenView Service Desk: Installation 
Guide). This check box is not checked by default when the application 
server is installed. The server status console will not be displayed until 
the checkbooks is checked and the server service started. The check box 
setting is only picked up when the server is started. If the check box is 
cleared once the server is running, or the GUI is closed using the Close 
button, the console will still not be displayed until the check box has 
been checked again and the server re-started.

The Server Status console allows you to monitor the current situation of 
the application server. 

Use the Stop Server button to close the server status and stop the 
server running. 

Use the Refresh button to display the latest values in all fields. The 
values are updated at regular intervals, but the Refresh button can be 
used to force the interval.

The Close button closes the server status console, while the server 
remains running. This is effectively the same as clearing the Server 
Interface check box on the General tab of the Server Settings 
Editor, and the server must be restarted for the interface to be 
displayed again.

The following data is displayed:

Logfile tab

The Logfile tab contains the following fields:
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Figure 1-1 Application Server Interface - Logfile tab

Logfile name

The full path and file name of the server log is displayed. 

Server log

The Server Log field displays all events, excepting database rule events, 
that have occurred on the server. The log records all events since the 
server was last started until the screen buffer is full, at this point the log 
is truncated back to half the number of events. This is done to make 
room for new events to be recorded without using up too much memory. 
The actual logfile at the location given above does not get truncated.
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NOTE There is no record of errors at the server startup before the server log file 
is initialized.

General tab

The General tab contains the following fields:

Figure 1-2 Application Server Interface - General tab

Server information

• Total up-time: This field displays the total amount of time since 
the server was last started.
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• Server name: This field displays the name of the machine where the 
server is installed.

• IP Address: The IP address of the server machine is displayed.

• Server version: This field displays the version number of the 
server software.

• Settings file: The full path and file name of the server settings 
file is given.

Operating system information

• Operating system: The operating system the application server is 
running on.

• Version: The version number of the operating system software.

• Architecture: The machine that the server is running on.

Java  runtime information

• Java runtime name: The name of the Java runtime software 
installed on the server is displayed.

• Java runtime vendor: This field displays the supplier of the Java 
runtime software be used by the server.

• Java runtime version: This field displays the version number of 
the Java runtime software be used by the server.

• Java home: The full path and file name for the Java runtime 
software is given.

Performance tab

The Performance tab shows data related to how the application server is 
performing: 
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Figure 1-3 Server Status Console - Performance tab

ITP Requests

These figures provide a rough estimation of the server’s workload. If the 
figures become to high it may be worth considering adding an extra 
server to the multiple server environment.

• Average (# requests): the average number of itp requests per 
second. This figure is calculated by counting the number of itp 
requests per minute and dividing the count by 60. 

• Maximum (# requests): this figure represents the highest level the 
Average value has reached since the server was started.

• Total: the total number of itp requests made since the server was 
started.
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Memory

The memory the Virtual Machine makes available for Service Desk. The 
sum of the allocated memory and free memory equals the total memory 
made available for the server by the virtual machine.

• Allocated Memory: the amount of memory currently allocated in the 
virtual machine. 

• Free Memory: the amount of memory available for Service Desk but 
currently unallocated.

Clicking the Free Memory button forces the virtual machine’s garbage 
collector to clean up the memory.

Database tab

The Database tab shows details of the database used by the application 
server:
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Figure 1-4 Server Status Console - Database tab

Type

This field shows the type of database currently used by Service Desk.

JDBC driver name

This field shows the type of Java Database Connectivity (JDBC) driver 
used by the server.

JDBC driver version

This field shows the current version of JDBC driver used by the server.

Instance

This field shows the name of the database server instance. In the case of 
a server connection to an Oracle database the instance field will display 
the servername, port number and sid (Oracle instance identifier) in the 
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form servername:port:sid. A SQL Server database may show only the 
server name. See the Chapters 2 and 3 in the HP OpenView Service Desk 
Installation Guide.

Datastore

This field shows the account name for the datastore user.

Repository

This field shows the account name for the repository user.

Error Count

This field shows the number of errors registered in the log file displayed 
on the General tab.

Connection Pool

The connection pool settings are defined using the advanced button on 
the Connection tab of the Database Account Properties dialog box. 
This is described in the Configuring the Application Server of the HP 
OpenView Service Desk 4.5 Installation Guide.

• Datastore minimum: the minimum number of connections the server 
should keep open to the datastore account.

• Datastore maximum: the maximum number of connections the 
server should keep open to the datastore account.

• Repository minimum: the minimum number of connections the 
server should keep open to the repository account.

• Repository maximum: the maximum number of connections the 
server should keep open to the repository account.

Services tab

The Service tab shows details of the services provided by the Service 
Desk application server. 

The Services and the port numbers they use are defined using the 
Configuration Editor. This is described in the Configuring the 
Application Server of the HP OpenView Service Desk 4.5 Installation 
Guide.
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Figure 1-5 Server Status Console - Services tab

Number of Threads

The number of threads currently being used by the server, this will vary 
and is related to the number of services running.

Running Services

These field show the service currently be run by Service Desk.

• ITP Service Port: shows the port number the ITP service listens 
on, this is set on the ITP tab of the configuration editor.

• HTTP Service Port: shows the port number the HTTP service 
listens on, this is set on the HTTP tab of the configuration editor.

• SMTP Service Port: shows the port number the SMTP service 
listens on, this is set on the SMTP tab of the configuration editor.
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• Agent Service Port: shows the port number to Service Desk Agent 
communicates on.

• Health Service Port: shows the port number used by the health 
service. The health service communicated through the itp port to 
monitor how many servers are currently running in the network. A 
list of active servers is maintained in the database.

• Event Service Port: shows the port number used for Service Desk 
events. Events are communicated through the itp port.

• Message Service Port: shows the port number used for messages. 
Messages are communicated through the itp port.

• Schedule Service Port: shows the port number used for scheduled 
tasks. Scheduled tasks are communicated through the itp port.

Disabled Services

When the Activate ITP, HTTP, or SMTP protocol check box on the 
relevant tab page of the configuration editor is cleared, the service is 
disabled. Disabled services are moved from the Running Services list 
above to the Disabled Services list.

Connections tab

The Connections tab shows details of the clients and servers:
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Figure 1-6 Application Server Interface - Connections tab

Total client and server connections

This field shows a list of all itp connections, both clients and servers, 
currently connecting to the application server process.

Servers

The Servers field shows a list of all servers currently running in the 
multiple server environment. The list will update within a few minutes 
of a server disconnecting or connection to the Service Desk environment.
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2 Accounts Administration

This chapter discusses the administration and maintenance tasks 
associated with User and Administrator Accounts, their permitted access 
rights and other security related issues.
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In a typical set-up, Service Desk requires three types of accounts you will 
need to set up; a database user, an application administrator, and at 
least one end user. This relationship between client, server, and database 
is not affected by the number of clients or the number of servers used in a 
multiple server environment. 

When you install the Service Desk application server, you will also have 
to define a new, or specify an existing, database administrator account. 
This account is only used for the installation and configuration. Once the 
database is setup and the application server installed, Service Desk will 
not use it again.

Types of Accounts

As mentioned above, there are three types of accounts:

• Database user accounts. 
The Service Desk application server uses these to communicate with 
the database, and they are set up at installation using the sever 
settings editor (see Chapter 5, Configuring the Application Server in 
the HP OpenView Service Desk 4.5: Installation Guide). Once these 
are set up, they will not normally be modified. If you are using an 
SQL Server database there is only one database user needed per 
Application Server - Database relationship, but if you are using an 
Oracle database there could be one or two accounts (a single user, or 
a database user and a repository user) per AppServer - Database 
relationship. By Application Server - Database relationship we refer 
to the communication between a single application server and a 
single database. The database and server accounts are accessible by 
selecting Programs from the start menu, then hp OpenView service 
desk 4.5 and then finally Accounts from the service desk sub menu.

• Service Desk Administrator account.
Each installation of the Service Desk application server must have at 
least one Service Desk administrator account. This administrator 
account has all the roles and authorization requirements to access 
every function of the Service Desk application. The Service Desk 
administrator does not count as one of your licensed users.
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The Administrator account has the default user name of “system” 
with the default password of “servicedesk”, both are case sensitive.

• User accounts.
The number of end user accounts, using the Service Desk client 
software, is dictated by the number of licenses purchased, and their 
access to Service Desk functionality is limited by the Roles assigned 
to them. Roles are assigned to user accounts by the Service Desk 
administrator at the time the accounts are created and they can be 
modified at any time. The Service Desk user account details are 
stored in the file user_settings.xml in the user’s Windows profile 
by the connections wizard. 

The client accounts used to connect to the application server are 
maintained using the client account screen described in the section 
Client Account Settings of Chapter 6, Installing the Client in the HP 
OpenView Service Desk 4.5: Installation Guide.

The users will not have to enter their log on name and password each 
time they start Service Desk as it will be read from the Windows 
registry, although you can specify that clients must log on each time 
they connect to application server (see “Logon Screen” on page 78). 
However, each time a user tries to access Service Desk from a client 
machine that he has not used before, the connection wizard will be 
started. When the connection is made entries will be added to the 
Windows registry.

There are two variations of the standard client account. These are 
non-UI accounts for integrations and Service Pages (SP) users. These 
accounts can not log in to Service Desk, but they can send data to the 
application server and database. However, they are not counted 
among the licensed users.

Licensing

For information about how to get and install your license keys, see 
Chapter 4 of the HP OpenView Service Desk 4.5 Installation Guide.

Three types of licenses are supported with Service Desk 4.5:

• Named user licenses:
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A named user license allows you to create the specified number of 
Service Desk user accounts that will have access to the Service Desk 
graphical user interface (GUI) no matter how many other users are 
connected (as long as the maximum number of named users specified 
in the license is not exceeded). Such an account is especially suited 
for system administrators and key users that need to be able to 
access the application at all times. A named user can access up to 
three sessions at the same time.

• Concurrent user licenses:

A concurrent user license allows the specified number of Service 
Desk user accounts access to Service Desk simultaneously (not 
counting the named users that are connected). You can create as 
many concurrent user accounts as you wish, but no more than the 
licensed number of concurrent user accounts can access Service Desk 
at the same time. Concurrent users can access multiple sessions at 
the same time, but each session counts as a concurrent user.

• Module licenses:

A module license gives all your named and concurrent users access to 
the module or modules specified in the module license. 

You always need one or more module license in addition to your 
named and concurrent user licenses.

You must not create more user accounts than your license permits. If you 
have used a temporary license key to create more users than you have a 
permanent license for, you must delete the extra users before the 
temporary license key runs out. If you do not, all user access to Service 
Desk will be denied at the expiry date. A system administrator however, 
will still be able to access Service Desk.

When entering your license key in Service Desk, enter it exactly as 
shown, without quotation marks; it is case-sensitive. 

Creating Accounts

Once you have created their accounts, the users must connect to the 
Server using the Connections Wizard before they can log onto the Service 
Desk client on their machine. 

The first time a user logs on the connection wizard will guide him 
through the connection procedure. To complete this wizard the user will 
need to know the following information:
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• server host name

• account name

• initial password

It is worth bearing in mind before creating user accounts that it may be 
worthwhile to prepare some standards in advance. For instance, you may 
decide that the user’s login name for Service Desk should be the same as 
that for NT to minimize confusion, or that the Friendly Name (which the 
user can edit in the wizard) should follow some sort of specific format for 
consistency. 

Before users can access Service Desk, their accounts must each be 
assigned a Role. There are two ways to assign a role to an account, one is 
described at the end of this section, and the other is described in the 
following section that discusses Roles.

NOTE To create a Service Pages User Account see “Service Pages User 
Accounts” on page  150.

To create an account, do the following: 

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node below 
the Service Desk icon.

4. In the Access branch, select Application Account.
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Figure 2-1 Administrator console dialog box

5. Right-click in the Account view and choose New Application 
Account from the popup menu. The Account dialog box is displayed:
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Figure 2-2 Account dialog box

6. Type the name to be displayed when referring to this account. This is 
the name that will normally be displayed, for instance, in the Active 
Service Desk sessions tab page.

7. Enter the Login name that the user will use to log in to Service Desk. 
This may be the same as the user’s NT log in, but it is not required. 

8. Enter a password, and confirm the entry. This may be the same as 
the user’s NT password. The rules for the passwords are described 
below in the section “Setting the Password Limitations” on page  79. 
If you provide the user with a password they can change it by using 
Options from the Tools menu and then selecting Accounts and then 
Change Password.
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9. Enter the name of the users ‘home’ machine in the Host field, this 
will be used by the Service Desk agent when processing actions. If 
the user logs onto Service Desk from a different machine, actions 
processed by the agent will still be routed to the user’s home machine 
unless this field is changed to the new machine.

10. Enter the user’s Default language, by selecting a language from 
the drop down list. Only languages displayed in the list have been 
installed in the Service Desk database for localization. 

11. Select the user’s Default time zone from the drop down list. All 
records are stored on the database as Greenwich Mean Time, and 
adjusted by the difference dictated by the user’s time zone setting 
when created, viewed, or modified.

12. Choose an Account type from Named User, Concurrent User, or 
Integration user. A Named User is a user who is specifically named 
in a license agreement, a Concurrent User is one of a specified 
number of users in a license agreement who can be logged on at any 
one time (named users and concurrent users are counted separately 
for licensing), and an Integrations user is an account created for 
passing data to and from other software programs. An Integrations 
user is not counted in the license agreement.

13. Use the Blocked check box if you want to ensure that the account 
cannot be used. This may be a useful alternative to deleting an old or 
redundant account, as described below. A blocked account is no 
longer counted in the licensing.

Relating Accounts to Person Items in Service Desk

Before an account can be used, a Service Desk person record must be 
created (or an existing one modified) and the account name linked to the 
person record using the Account field in the person record. For more 
information about creating and modifying Person items see the Service 
Desk Online Help.

Modifying Accounts

Once created, a user account can be changed at any time. 

To modify an account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.
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3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Application Account.

5. Select the account you want to modify. Right-click in the Account 
view and choose Open from the popup menu.

6. In the account dialog change the details as required.

Blocking and Removing Accounts

User accounts can be fully removed from the system, or blocked so that 
they cannot be used. 

When you delete an account you must first remove or re-assign any 
associated records in the database, for example, service calls. For this 
reason it is often preferable to block an account rather than physically 
delete it. Once an account is blocked it no longer counts towards the total 
for licensing purposes.

To block an account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Application Account.

5. Select the account you want to block. Right-click in the Account view 
and choose Open from the popup menu.

6. In the accounts dialog box, use the Blocked check box to ensure that 
the account cannot be used. 

To remove an account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Application Account.

5. Select the account you want to remove. Right-click in the Account 
view and choose Delete from the popup menu. A popup dialog box is 
displayed.
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6. Choose Yes to delete the account. If the account has no links to other 
items, for example, a person record, or work orders, it will be deleted. 
If the account does have links to other items a dialog box will be 
displayed listing all the associated items:

Figure 2-3 Account - Remove linked items dialog box

7. You can select each item individually and click Modify or Remove. 
Modify will enable you to access the linked record and edit it in such 
a way to break the link between the record and the account. For 
instance, in the Person record you can remove the account name 
from the Account field. This will ensure the connection between the 
person record and the Application Account is broken, but the person 
record will still be linked to any related service desk items. This will 
retain the system’s data integrity. Remove will physically remove the 
record from the database, and you will lose the data. When all linked 
items have been removed or modified, you can delete the account.

Adding a Role to an Account

Before an account can be used to access Service Desk, a Role must be 
assigned to the account. 

To assign an existing role to a new account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.
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3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Application Account.

5. Right-click in the Account view and choose New Account from the 
popup menu. The Account dialog box is displayed. Create a new 
account as described above in the section “Creating Accounts” on 
page 46. 

6. Click the Roles tab, and select the check boxes for the roles that the 
user needs. An account can have multiple roles.

Figure 2-4 Account - Adding a role to an account
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The access rights that an account has to Service Desk are defined by 
applying a Role, or multiple roles, to the account. 

Role gives a user access to items and specific rights to manipulate those 
items. An item is a specific type of database record, for instance a Service 
Call, a Work Order, or a Change. There are 11 types of items used in 
Service Desk. Each item type can be Inserted (created), Modified 
(edited), Viewed (read), and Removed (deleted). Some item types also 
have templates that need to be maintained. 

A role therefore can be created for each particular job function in an 
organization that needs access to Service Desk. Roles can be combined to 
create high level roles, or tailored for single individuals.

To create a Role:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Role.
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Figure 2-5 Administrator console dialog box

5. Right-click in the Role view and choose New Role from the popup 
menu. The Role dialog box is displayed:
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Figure 2-6 Role dialog box

6. Enter a name for the new Role, this is the name that will be 
displayed in the Role view of the Administrator Console. 

7. Select the check boxes for the access rights you want the role to have. 
If you select the main check box for each item (to the left of the icon), 
all the access rights for that item will be selected. If you don’t want to 
give the role the ability to use all access rights for any item, select 
just the access rights needed.

8. Roles can be fine tuned to allow or deny access to particular fields, 
forms, views, templates, and actions using the Advanced button.

9. Roles can be used to grant access to view, modify, create, and remove 
items only when assigned to the users who a specific role. These 
rights can be applied to History lines too. To set these access rights 
select the required item and click the Detailed button. Entitlements 
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to perform these specific actions in customer created folders are also 
granted using the Detail button. See “Folder Entitlements” on page 
67.

Advanced Item Access 

For fine tuning, access to selected items can be further defined so that 
specific fields, forms, views, templates, and actions can be hidden from 
all users with particular roles.

To allow or restrict access to fields, forms, views, templates, and actions:

1. In the role dialog box select the item you wish to further define. Click 
Advanced. The Advanced Item Access dialog box is displayed.

2. Click the tabs to select fields, forms, views, templates, or actions. 

3. When you select the Fields tab, a list displays all fields available for 
the item you selected in the Roles dialog box. The default is that all 
fields are writable. Select the fields that you want to make invisible, 
or view only, to the user with the previously select role. Click the 
Write, View, or Hide buttons.
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Figure 2-7 Roles - Item Access dialog box

4. Select the forms, views, templates, or actions tabs and do the 
following: The default is that there are no forms, views, templates, or 
actions assigned to the item, these can be added to the item by either 
creating new or adding existing ones. To create new forms, views, 
templates, or actions click the Add button (this procedure is described 
in the on-line help). To add existing forms, views, templates, or 
actions click the Relate button and select an item from the displayed 
list.
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Figure 2-8 Roles - Forms, Views, Templates, and Actions dialog box

5. Once forms, views, templates, or actions have been added they can be 
modified or removed by clicking on the Modify or Unrelate buttons. 

6. With forms, views, and templates, you can define one of the available 
items as a default.

Detailed Item Access

Detailed Item Access will allow you limit users with a particular role to 
only being able to do specific actions like view, modify, create, or delete, 
when the service desk item is assigned to them, or their workgroup. 
These limitations can be applied to history lines too.

To define assignment access rights to an item:

1. In the role dialog box select the item you wish to further define 
access rights to. Click Detailed. The Detailed Item Access dialog 
box is displayed.

2. Select the Access tab. Select the check boxes for the rights the user 
should have (these will default from the item check boxes in the Role 
dialog box). You can select whether the user can view and modify all 
items, or only items that are assigned to the user, or assigned to the 
user’s workgroup. Click OK.
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Figure 2-9 Detail Item Access dialog box

To define assignment access rights to item history lines:

1. In the role dialog box select the item you wish to further define 
access rights to. Click Detailed. The Detailed Item Access dialog 
box is displayed.

2. Select the History Line tab. Select the check boxes for the rights 
the user should have (these will default from the item check boxes in 
the Role dialog box). You can select whether the user can view and 
modify history lines for all items, or only items that are assigned to 
the user, or assigned to the user’s workgroup. Click OK.
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Figure 2-10 Detailed Item Access - History Lines dialog box

Including Roles within Roles

On some occasions it may be more efficient to combine two or more 
existing roles to create a new role, rather than to duplicate the work. 

However, it should be remembered that any existing roles you use to 
create a new role may already have other roles included within them. 
When a role is created using a combination of existing roles, the new role 
will have the access rights of all the included roles. This could mean that 
the new role may end up having as much access as the system 
administrator role. 

To include a role within a role:

1. Access the Role dialog box as described above.

2. In the Role dialog box, click the Include Roles tab.

3. Select the roles to be included in the new or modified role.
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Figure 2-11 Role - include role

Linking Roles and Accounts

Roles can be linked to one or more existing user accounts at the time the 
role is created, or at any time using the method described below. The 
dialog box displays all your licensed users.

To link a role to an account:

1. Access the Role dialog box as described above.

2. In the Role dialog box, click the Accounts tab.

3. Select the check boxes for the accounts that will utilize the new or 
modified role.
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Figure 2-12 Role - Link accounts

Customization Rights for a Role

Using Roles you can authorize users to customize their shortcuts and 
tool bars. With this ability they can set up Service Desk to be more in 
tune with the procedures and work load of their job function.

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Role.
Chapter 2  63



Accounts Administration
Roles
Figure 2-13 Administrator Console dialog box

5. Right-click the Role you want to edit and select Open from the pop-up 
menu. The Role dialog box will be displayed:
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Figure 2-14 Customization - Role dialog box

6. Check the boxes of those features you want to allow on the role, the 
default is all boxes but Customize System Views Allowed checked. 
When you clear a check box, the option is not allowed for the role and 
is grayed out from any menu where it might appear.

• Customize Toolbar Allowed - When allowed the users can 
access the Customize option of the Toolbars submenu on the 
View menu and customize their toolbars.

• Define Shortcuts Allowed - When allowed the users can add 
or remove shortcuts in the Service Desk shortcut bar.

• Define Shortcut Groups Allowed - When allowed the users 
can add or remove shortcut groups in the Service Desk shortcut 
bar.

• Define/Customize Views Allowed - When allowed the users 
can access the Define Views option of the Current View 
submenu on the View menu on the toolbar and define their own 
views.

• Customize System Views Allowed - If this check box is not 
selected (default), when a user uses the Define/Customize 
Views feature they are unable to modify the actual views 
propagated by the system. They only make the changes to a copy 
of the system view. Customize System Views Allowed enables 
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the users to edit the view propagated to their client. However, 
their personal customizations will stop any new view propagated 
by the system administrator from being installed on their 
machine as the new view cannot overwrite the modified one.

• Change Options Allowed - When allowed the users can access 
the Options option of the Tools menu on the toolbar.

• Internet Browser Allowed - When allowed the users can open 
an internet browser in the Service Desk interface.

• Update All Allowed - When allowed the users can update a 
group of selected Service Desk items. For example, it is possible 
to select a group of service calls and change a particular field 
value to the same value in all the selected service calls 
simultaneously. However, this process uses a great deal of system 
resources and is best avoided. Clearing the Update All Allowed 
check box stops this feature being used.
  Chapter 266



Accounts Administration
Folder Entitlements
Folder Entitlements
Folders are a resource for pooling data across Service Desk items, for 
example a folder could be created for a customer called Inventions inc. 
and all services calls, work orders, etc. can be stored in this folder. 

Using the Folder Entitlements feature is a way to further refine user 
access capabilities. This is done by providing the means to limit access to 
folders for each Service Desk item. The effect this will have on the user is 
that when they do a Quick or Advanced Find, or they create a view, they 
will only be able see items in the folders they have access to. For 
example, a user with a particular role could be permitted to modified 
service calls for Inventions inc. but only view work orders. The users will 
only be able to create, view, modify, or delete those items in the folders 
that their folder entitlements permit.

New Service Desk items are assigned to folders by making a selection 
using the Folder field on the item’s form. This field is not in any forms 
by default and so must be added to forms using the Form Designer before 
folder entitlements can be effective. For more information about using 
Form Designer, see the Service Desk Online Help.

Creating Folders 

Before folder entitlements can be set, folders must exist. 

To create folders:

1. From the Tools menu select System to open the Administrator 
Console.

2. In the Administrator Console, expand the Data branch.

3. In the Data branch open the Codes branch and then the General 
branch.

4. In the General branch select Folder. 
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Figure 2-15 Administrator Console Folder view

5. Right-click on the root level in the Folder view (you can create sub 
folders by right clicking on existing folders). Select New Folder from 
the pop-up menu, and enter a folder name in the New - Folder 
dialog box. Click Ok.

Figure 2-16 New - Folder dialog box

Enabling Folder Entitlements

To enable the folder entitlements feature:

1. From the Tools menu select System to open the Administrator 
Console. 

2. In the Administrator Console, select System Panel and then 
General Settings.
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3. In the General Settings dialog box select the Enable Folder 
Entitlement check box.

Figure 2-17 Enable Folder Entitlements

Setting Folder Entitlements

Folder entitlements are set up and maintained in the Items Tab of the 
Roles screen. Just as access can be granted for Role items, so too can the 
access rights to perform view, create, modify, and delete actions for items 
in folders and history lines be granted. 

Folder access entitlements and history line entitlements can both be set 
so that the user can only modify items in their own workgroup, or items 
they have created themselves. For folder access these same restrictions 
can be applied to views. For history lines these restrictions can be 
applied to delete rights.

To set entitlements for Folder Access:

1. From the Tools menu, choose System.

2. In the Administrator Console, expand the Security node.
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3. In the Access branch, select Role.

4. Right-click on the Role you want to modify in the Role view and 
choose Open from the popup menu. The Role dialog box is displayed:

Figure 2-18 Role dialog box

5. Expand the Item you want the entitlement to apply to, by clicking on 
the plus sign.

NOTE When you apply entitlements to an Item, all access rights granted at 
the higher level will be cascaded down to the lower levels. For 
example, if you give a role Modify access at item level, all subfolders 
will also have modify rights. By granting folder entitlements you are 
extending the users access rights in the subfolders. So, an account 
that has Modify rights set at the highest level, may have its rights 
extended to also include New, or Delete in a subfolder. Any rights 
given at a higher cannot be denied at a lower level.

6. Select the folder you want to set Entitlements for, and click the 
Detail button. The Detailed Item Access dialog box is displayed:
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Figure 2-19 Entitlements - Folder Access dialog box

7. Select the check boxes for the entitlement capabilities you want to 
allow. Any access rights cascaded down from the higher level are 
unavailable.

8. Select the History line tab. To grant entitlements for viewing or 
editing the history lines, select the required check boxes.
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Figure 2-20 Entitlements - History line dialog box
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Status Entitlements
Using the Status Entitlements feature is a way to further refine user 
access capabilities. This is done by providing the means to limit user 
access to only a specified range of Statuses. Users will only be able to 
modify those items that are in the statuses their entitlements permit.

To enable the status entitlements feature:

1. From the Tools menu select System to open the Administrator 
Console. 

2. In the Administrator Console, select System Panel and then 
General Settings.

3. In the General Settings dialog box select the Enable Folder 
Entitlement check box.
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Figure 2-21 Enable Status Entitlements

Setting Status Entitlements

Status entitlements are set up and maintained through the Items Tab of 
the Roles screen. Access granted to Role items can further refined so 
that the user can only have the access rights to view, modify, and delete 
items in a certain status, or within a specified range of statuses. 

To set status entitlements for an item:

1. From the Tools menu, choose System.

2. In the Administrator Console, expand the Security node.

3. In the Access branch, select Role.

4. Right-click on the Role you want to modify in the Role view and 
choose Open from the popup menu. The Role dialog box is displayed:
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Figure 2-22 Role dialog box

5. Select the Item you want the status entitlements to apply to, and 
click the Detail button. The Detailed Item Access dialog box is 
displayed:
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Figure 2-23 Entitlements - Status Access tab page

6. Click the Status Access tab. Select a status from the drop-down list 
for each of the Status from and Status to fields to define a range. 
To limit the entitlement to a specific status select the same status for 
each field. Click OK.

NOTE When Roles are combined (see “Including Roles within Roles” on page  
61) you can only extend, not limit, the range at lower levels. Thus the 
final range of the combined Roles will be from the lowest status to the 
highest status specified in any of the included Roles.
  Chapter 276



Accounts Administration
Windows Startup Account Authorization
Windows Startup Account Authorization
It is important that the Windows (2000 or NT) account that starts up the 
HP OpenView Service Desk Service has access rights to all servers, 
drives, and folders that Service Desk may need to use. 

If the startup account does not have sufficient rights, some of the 
functionality of Service Desk may not be available. For example, one 
feature of Service Desk is that it can be set up to automatically create a 
service call when it receives an e-mail from a customer, and include with 
the service call as an attachment. However, e-mail messages are stored 
in a specified attachments folder (sometimes on a dedicated file server). 
If the startup account does not have access rights to this folder a service 
call is not created and the e-mail message is not stored. 

Ensuring that the startup account has sufficient access right is also 
relevant when making database dumps to shared drives, the startup 
account must have access to the shared drive.

When Service Desk was installed the default startup account for the 
service was set as the system account. 

To check or change the start up account:

1. From the Windows Start menu choose Settings. 

2. Select Control Panel from the Settings submenu. The Control 
Panel dialog box will be displayed.

3. Double-click on the Services icon in the Control Panel dialog box. 
The Services dialog box will be displayed.

4. In the Services dialog box select HP OpenView Service Desk 
Service and click the Startup button. The Service dialog box is 
displayed.

5. The currently selected startup account is shown in the Log On As 
area of the Service dialog box. To change this account select the This 
Account radio button and choose an account using the ‘more’ button.

NOTE Regardless of which account you choose to set as the startup account, it 
is recommended that you switch off the password expiry period.
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Service Desk provides a logon screen to ensure that only users with 
properly authorized Service Desk user accounts can log on to the system. 

Logon Screen

Service Desk can be set up to display a dialog box whenever a user tries 
to connect to the application server. The user will be required to enter 
their user name, password, and the database to which they will connect. 
This feature applies to all client connections.

To enable the Display Logon Screen:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, select System Panel.

4. In the System Panel view double-click the General Settings icon.

5. In the General Settings dialog box select the Display Logon 
Screen On Startup check box.
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Figure 2-24 General Settings dialog box

Setting the Password Limitations

You can define the limitations and requirements for user defined account 
passwords. The password limitations will apply to all user accounts.

To set the password limitations:

1. In the Administrator Console, select System Panel, and double-click 
the Password Settings icon.

2. In the Password Settings dialog box select the settings you want to 
enforce and click OK.
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Figure 2-25 Password Settings dialog box
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3 Implementing Languages from 
the Localization Pack

This chapter explains how to implement the translated user interface 
and online help supplied in the Service Desk localization pack.
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About the Localization Pack
Shortly after the release of the English language version of Service Desk, 
a localization pack will be available from the HP OpenView Software 
Patches Web site at http://support.openview.hp.com/cpe/patches. The 
localization pack contains translations of the Service Desk user interface 
for the following languages:

• French

• German

• Spanish

• Japanese

• Korean

• Simplified Chinese

• Traditional Chinese

To enable Service Desk client users to work with one or more of these 
language versions, you must first implement the localization pack on the 
application server and import the translated text into the Service Desk 
database. Then the localization pack must be installed on the client 
machines. After that, the users can select their preferred language. The 
next sections explain how to implement the localization pack on the 
application server and the client machines.

The localization pack consists of:

• Data Exchange import files for the translated labels and messages.
After installing the localization pack, you must import these .xml 
files into the Service Desk database with Service Desk’s Data 
Exchange function. This is explained in “Implementing Languages 
on the Application Server” on page 84. 

• Translated online help files. 
These files are automatically installed when you install the 
localization pack. More information about these help files can be 
found in “Online Help Files” on page 93.

• Files containing translated error messages for sd_event and 
sd_export.
These files are automatically installed when you install the 
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localization pack. More information about these files can be found in 
“Translated Error Messages for sd_event and sd_export Errors” on 
page 94.
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Implementing Languages on the Application 
Server
To install the localization pack on the application server and import the 
translated labels and messages, perform the following steps:

Step 1. Download the localization pack from the HP OpenView Software Patches 
Web site at http://support.openview.hp.com/cpe/patches.

Step 2. Install the localization pack: open the downloaded .exe file and follow the 
instructions displayed on the screen.

NOTE The following steps must be repeated for each language you want to 
implement.

Step 3. Create a new language in Service Desk:

1. Choose System from the Tools menu to open the Administrator 
Console.

2. Open the System Panel node and then Regional Settings. The 
Regional Settings dialog box opens:
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Figure 3-1 The Regional Settings dialog box

3. In the Regional Settings dialog box, select English in the Default 
Language box.

4. Click Add. The New Language dialog box appears.

5. In the New Language dialog box, select the new language from the 
drop-down list. Select only one of the language versions shown below: 
if you select a different language, for example Spanish (Modern), the 
localization will fail as the localization packs are available for the 
specified version of each language only. 

Table 3-1 Languages Available in the Localization Pack

Windows NT Windows 2000

German (Standard) German (Germany)

French (Standard) French (France)

Spanish (Traditional Sort) Spanish (Spain - Traditional Sort)

Japanese Japanese
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6. Click OK in the New Language dialog box.

7. Click OK in the Regional Settings dialog box. You return to the 
Administrator Console.

The new language is created, based on the English labels and messages: 
Service Desk copies the English text to the new language. The next step 
is to replace the English text in the new language by the translated text: 

Step 4. Import the translated labels and messages:

a. Import the .xml file containing the translated labels and messages:

NOTE The import process described below makes use of Service Desk’s Data 
Exchange functionality. For more information about Data Exchange, 
refer to the Data Exchange Administrator’s Guide.

1. In the Administrator Console, open the Data node, then Data 
Exchange and Data Exchange Task.

2. Double-click the import mapping sd_lang. 

Korean Korean

Chinese (PRC) Chinese (PRC)

Table 3-1 Languages Available in the Localization Pack (Continued)

Windows NT Windows 2000
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Figure 3-2 Opening the sd_lang import mapping

3. The Data Exchange Task - Sd_lang dialog box appears:
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Figure 3-3 Data Exchange Task dialog box

Fill in the Data Exchange Task - Sd_lang dialog box as follows:

• Clear the Export data from a storage device check box.

• Click the Browse button under the Exchange file box to 
select the .xml file for the language you want to import. 
The .xml files are located by default in the 
data_exchange\xml subfolder of the folder where Service 
Desk is installed, for example: C:\Program 
Files\Hewlett-Packard\OpenView\Service Desk 
4.5\Server\data_exchange\xml. Select one of the following 
files: 

sd_lang_de.xml for German

sd_lang_es.xml for Spanish

sd_lang_fr.xml for French
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sd_lang_ja.xml for Japanese

sd_lang_ko.xml for Korean

sd_lang_zh-cn.xml for Simplified Chinese

• Select the Import data into Service Desk database 
check box.

• In the Account box, enter the user name of a Service Desk 
account that is authorized to import data into the Service 
Desk database, for example System administrator.

• In the Password box, enter the password for the account.

• In the Import mapping box, select the import mapping 
sd_lang.

• Select the Debug check box if you want additional information 
in the log files. Log files will be created during the import 
process; if the Debug check box is selected, more information 
will be logged than with the check box cleared. 

• Clear the Use delta processing check box.

4. Click Start. 

5. A dialog box appears asking if you want to exchange data now. 
Click OK to start the import process. 

The import process will take a few hours; the exact duration 
depends on the processing speed of the machine. During the 
import process, error messages may be displayed on the screen. 
These messages are also logged in the log file. After the import 
process is completed, you can check if the import was successful, 
as described in the next step.

Step 5. Verify that the import was successful:

a. Examine the import log files. 

Two log files are created during the import process: 

• sd_lang_imp_error.log
This file contains information about serious errors only.

• sd_lang_imp.log
This file contains information about serious errors as well as 
other information, including information about successful actions. 
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The log files are located in the data_exchange\log subfolder of the 
folder where Service Desk is installed, for example C:\Program 
Files\Hewlett-Packard\OpenView\Service Desk 
4.5\Server\data_exchange\log.

To examine the log files:

1. In the Data Exchange Task dialog box, click the List log files 
button.

2. Open the sd_lang_imp_error.log or sd_lang_imp.log file.

3. Check the log file for errors and warnings. 

The following errors and warnings can be ignored:

• Attribute not defined: Comments on entity x (ID=y)

• No changes to save (including stack trace in debug 
mode)

• Program error: the attribute “Language” of this 
label text cannot be modified, because the label 
text record was opened in view mode or because the 
attribute is read-only while processing attribute 
Language (text can appear in the imported 
language).

• Program Error: the attribute “Localizable item” of 
this label text cannot be modified, because the 
label text record was opened in view mode or 
because the attribute is read-only while 
processing attribute Object ID (text can appear in 
the imported language).

• More than one item found while processing attribute 
Object ID. This is a common error message in the LABELS 
section and can be ignored there.
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The following are common errors:

b. Check the new language in the repository.

The localization pack contains two SQL scripts that allow you to 
verify that all texts for the new language have been translated in the 
repository. During the installation of the localization pack, these .sql 
files have been placed in the data_exchange\sql subfolder of the 
folder where Service Desk is installed, for example: C:\Program 
Files\Hewlett-Packard\OpenView\Service Desk 
4.5\Server\data_exchange\sql. To check the repository:

1. Run one of the SQL scripts, depending on your database: 

• For an Oracle database, run checkloc-oracle.sql in 
SQL*Plus , as the SD repository owner, for example 
sd_repo.

• For a SQL Server database, run checkloc-sqlserver.sql in 
the Query Analyzer (for SQL server), as the SD repository 
owner, for example sd_repo.

2. Examine the log file checkloc.log on:

• The maximum length of 255 characters has exceeded 
while processing attribute “Text”.
Most texts, like message texts and “What’s this” texts, have a 
limit of 255 characters. The text is imported, but it is 
truncated to 255 characters.

• com.hp.ifc.ext.ExternalException: you are not 
allowed to create new items of this type.
The text has not been imported. During the import process, 
the translated texts can only replace existing texts in the 
new language: the import process can only update existing 
objects in the repository; it cannot create new objects. This 
error occurs if a text in the imported .xml file does not exist 
in the new language. This occurs if:

— Views, actions, forms, or tab controls have been removed 
after Service Desk was installed, so the object cannot be 
translated anymore.

— No language has been created yet. In this case all 
imported items result in this error message.
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• Items that have not been translated: these items do not have 
a recent modification date. 

This is not necessarily an error: this also occurs if the 
translated text in the imported .xml file is the same as the 
original English text. In that case, the import log file 
sd_lang_imp.log will contain the message No changes to 
save for this text.

If you suspect there is an error, you can find out what the 
message is in the import log file: the log file checkloc.log 
mentions an object ID for the unchanged text. In the .xml file, 
search for an entry that has this object ID as its OID value 
(PROPERTY NAME=”OID”, VALUE=”the searched object 
ID”). Then look up the ID value of the object this entry 
belongs to (PROPERTY NAME=”ID”). Look up the found ID 
in the import log file sd_lang_imp.log or 
sd_lang_imp_error.log.

• Items that have a new creation date in English (language 
code 1033). These items have been added by an upgrade or by 
a user, for example new form titles or tab controls. The 
imported .xml file does not contain translations for these 
items. These items must be translated manually, in the 
Administrator Console. More information about translating 
items manually can be found in the online help.

NOTE You can use the same import procedure to import an extended or 
modified localized .xml file, to fit your specific needs. For example, extra 
form titles can be added or translations can be changed. As long as 
the .xml-specific format remains correct, you can alter the file or take 
portions to do partial imports.
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Implementing Languages on Client Machines
After a language has been implemented on the application server, the 
following steps must be performed on client machines to enable Service 
Desk users to use the language: 

1. Download and install the localization pack as described in Step 1 and 
Step 2 on page 84.

NOTE Instead of installing the complete localization pack, you can choose to 
copy only the files needed for a specific language to the client system. 
See “Required Files” below.

2. To use the language, select it in Service Desk:

a. Choose Options from the Tools menu. 

b. In the Options dialog box, click the General tab. 

c. From the Language list, select the language you want to work in. 

d. Click Apply.

e. Close and restart Service Desk for the changes to be applied. 

Required Files

This section explains which files must be placed on the client machines. 
If you install the localization pack, all of these files, for all of the 
available languages, are placed on the user’s system automatically. To 
save disk space, you can choose to copy to the client machine only those 
files that are needed for the language the user wants to work with. 

Online Help Files

The localization pack creates a locale folder for each language and places 
the translated online help files in these folders. The locale folders are 
created in the repo\locales subfolder of the folder where Service Desk 
is installed, for example C:\Program Files\Hewlett-Packard\
OpenView\Service Desk 4.5\Server\repo\locales. The following 
locale folders are created:
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• 1031 for German

• 1034 for Spanish (Traditional Sort)

• 1036 for French

• 1041 for Japanese

• 1042 for Korean

• 2052 for Chinese (Simplified)

The 1033 folder contains the files for English (US). 

The locale folder for the language the user wants to work with must be 
copied into - or created in - the repo\locales folder on the client 
machine. At least the following files must be copied into the locale folder 
to enable the client user to work with the translated online help:

• all .chm files

• all .h files

Translated Error Messages for sd_event and sd_export Errors

While most of the Service Desk messages are translated in the .xml file 
imported on the application server, the translations for the error 
messages for sd_event and sd_export are in separate files in the 
localization pack. 

The translated message files for sd_event and sd_export are only used 
for Service Desk integrations. They only need to be installed on server 
and client machines where Service Desk integration software is 
installed.

The message files are installed in the same locale folders as the online 
help files (see “Online Help Files” on page 93). The message files are 
named sd_event_languagecode.msgs and 
sd_export_languagecode.msgs, where languagecode is one of the 
following language codes:

• de for German

• es for Spanish (Traditional Sort)

• fr for French

• ja for Japanese

• ko for Korean
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• zh-cn for Chinese (Simplified)

The language code en-us is for English (US).

The .msgs files for the language the user wants to work with must be 
copied into the locale folder for that language. For example, for a user 
who wants error messages returned by sd_event to be displayed in 
German, the sd_event_de.msgs file must be placed in the 
repo\locales\1031 folder.

For integrations with software applications running under Windows, the 
translated message file or files for sd_event must also be placed on the 
machine the integrated software application runs on. For example, if you 
work with Service Desk’s OVO for Windows (OVW) integration and OVW 
is installed on a different machine than Service Desk, the translated 
sd_event_languagecode.msgs file or files must also be placed on the 
OVW machine. On those machines, the .msgs file must be placed in the 
folder where the sd_event.exe file is located.

By default, the sd_event and sd_export messages will be displayed in 
US English. You can change that with the LANGUAGE keyword in the 
configuration files. In the sd_event.ini file, the LANGUAGE keyword can 
be specified under [SD_EVENT]; in sd_export (extractor) .ini files, it can 
be specified under [SYSTEM]. For example, to display sd_event error 
messages in German, include the line LANGUAGE=”DE” under [SD_EVENT] 
in the sd_event.ini file.
Chapter 3  95



Implementing Languages from the Localization Pack
Implementing Languages on Client Machines
  Chapter 396



4 Business Logic

This chapter explains how you can use Business logic in Service Desk to 
create Database and UI Rules to automate your business processes.
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Database Rules are stored on the application server. When the 
application server is closed they are downloaded to the Service Desk 
database. Service Desk can apply database rules when an item is created 
or modified, only created, only modified, or deleted in the database. 
When the conditions you set for the rule are met, the action you specified 
for the rule will be executed. Three different type of actions are available; 
Command Exec action, Send E-mail action, and Update Data in Service 
Desk action. 

Scenarios for Using Database Rules

A number of example database rules are available in the demo data for 
Service Desk. For example you can use database rules to:

• Send a notification showing a banner on the screen of the Service 
Level Agreement manager when an SLA is going to expire within 28 
days. 

• Send an acknowledgement message to an external application.

• Send an e-mail message to the help desk manager when a service call 
is overdue.

• Send an e-mail message to a group when they need to approve a 
change.

• Update a change when a service call or other item is modified in the 
database.

Technical Overview of Database Rules

The following diagram shows the overall concept of how database rules 
are managed within Service Desk:
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1. An event occurs in Service Desk. 

2. The event is sent to the Event Queue by the Service Desk workflow 
layer.
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3. The Rule Manager takes the event from the queue and checks to see 
if there is an applicable rule for the event. If a rule does not exist for 
the event, the event will be discarded.

4. Events that fit a rule are sent to the Evaluation Manager to check 
the conditions set for the rule.

5. If no conditions exist or if all conditions are met the event is sent to 
the Action Manager and executed. 

• Events with timed conditions are sent to the Alarm Engine.

• An alarm goes off at the time specified by the timed condition 
and the timed condition is evaluated by the Evaluation Manager. 
Non-timed conditions are not re-evaluated, they are only 
evaluated once.

6. When the timed condition is met the event is sent to the Action 
Manager.

7. The Action Manager initiates the task specified by the action.

NOTE E-mail actions and Update Service Desk database actions do not use the 
Service Desk agent.

Creating Database Rules

The procedure below explains how to create a database rule. As an 
example we will create a rule to display a Banner for top priority service 
calls:

Step 1. Select the item in Service Desk that this rule will apply to:

1. From the Tools menu select System. In the Administrator Console 
double-click Business Logic and then Database Rules.

2. Select a Service Desk item, for example the Service Call item:
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Figure 4-2 Select a Service Desk Item

3. Right-click in the Database rule window and select New Database 
rule from the menu that appears.

Step 2. Specify when to apply the rule and what conditions to apply:

1. Specify when you want to apply the rule. For this example we want 
to apply the rule to all service calls that are created or modified, so 
select “When service call is created or modified”. 
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Figure 4-3 When to Apply the Rule

Selecting the “Validates only if one or more fields of 
conditions are modified” will cause the rule to be evaluated when 
one or more fields that are specified in the conditions for the rule are 
modified. For example, if you create a rule that is triggered when an 
item is modified and a condition is set for the information field, the 
rule will only be triggered when the information field is modified. If 
the check box is cleared the rule can be triggered whenever any field 
in the item is modified.

Click Next to continue.

NOTE If you select When item is deleted you will not be able to set any 
conditions for the database rule and the actions available will be 
limited. You will be able to use the Command Exec Action and the 
Send E-mail Message action. It will not be possible to enter Field 
information for those actions, because once the item is deleted the 
field data for the item is no longer available. Information such as the 
host and e-mail addresses can be typed in.

2. In the following dialog box, click Add to set conditions for the 
database rule
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Figure 4-4 Add Conditions to the Rule

3. Use the Field button in the Condition dialog box to enter the fields 
for this item you want the rule applied to:

Figure 4-5 Configure Conditions for the Rule

4. Enter an Operator using the drop-down arrow.

5. Put your cursor in Value field and use the Field button to select the 
value you want the fields selected to be measured by. For example, 
this rule will be applied when the Priority field contains the value: 
Top.

6. Select Schedule the validation of this condition at check 
box to enter a timed value for this condition. Set a time range, and 
then a field using the Field button. Setting a time period for the 
condition is not mandatory. 
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If you selected the Schedule the validation of this condition 
at: check box and are creating a database rule for a service call or an 
incident, the Use support hours check box will be available. Select 
this check box if you want the timed condition to take support hours 
listed for the applicable SLA into account. If the check box is clear, 
support hours will not be considered and the scheduled execution of 
the action will be based upon a 24-hour clock.

Select the Only execute once check box to limit the number of 
times a timed condition triggers an action.For example (without 
selecting the check box): a rule is created to be evaluated when an 
item is modified. A timed condition is added to execute the action 
defined for the rule 30 minutes after the triggering condition is met. 
The result is that every time the item is modified a new action will be 
scheduled for execution 30 minutes after the modification that 
triggered it.

7.  Click OK, then Next to continue.

Step 3. Add actions to the database rule:

1. Click Add to add an action.You must specify at least one action for the 
rule. You can select the Command Exec action, Send E-mail 
Message action or the Update Data action. For this example the 
Command Exec action is used to activate the banner program: 

NOTE Multi word parameters (parameters containing spaces) can be used if 
they are enclosed within quotation marks. For example: sd_event 
information=”multiword information”. However, if you need the 
quotes to be passed on to another application the quotes must be 
preceded by a backslash as an escape character. The example 
becomes: sd_event “information=\”multiword information\””
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Figure 4-6 Add Actions to the Rule 

2. Enter an identifying Name for the action:
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Figure 4-7 Create a Command Exec Action

3. In the Description field, enter a brief explanation of the action that 
will be performed.

4. In the Host field, enter the name of the computer the action will take 
place on. In the Host field you can use the Field button to specify 
the host. If the action is in response to a message sent by an external 
application the host name can automatically be taken from that 
account and filled in. 

If you are responding with an acknowledgement message to an 
external application, the host will come from the account, for 
example ManageX_event, that originally sent the incident (external 
event) to Service Desk.

5. Clear the Blocked check box to activate this action. You can create 
more than one action for every rule, and use the Blocked check box 
to turn some of the actions off.
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6. In the Command line field, enter the command you want to execute, 
for example: banner.exe

7. In the Parameters field define additional information for the 
command by inserting parameters using the Field button. In the 
previous figure for example, we want the service call ID number and 
the text to say that the item is assigned. It is possible to add more 
parameters than this.

8. Click OK and then Next to continue.

Step 4. Turn on the action:

1. In the Name field enter an identifying name for the rule. This name 
will appear in the database rule window for that item.

2. Clear the Block this rule check box to turn the rule on.

3. Enter a category to organize your database rules:

Figure 4-8 Add Name and Category to a Database Rule

You can use the drop-down button to select from a list of available 
categories, or you can create your own categories. 

To create a category: in the System Administrator’s console select 
Data, then Codes, then General. Open the Rule Category option 
and right-click in the view and select New rule category. Type the 
name of your new category in the dialog box that appears. 
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You can organize your categories by: selecting the rule and then 
using the Move up and Move down arrows on the toolbar. There are 
two types of views possible; the Database Rule (System) view and 
the Rules by Category (System) view. It is only possible to move 
rules in the Database Rule (System) view:

Figure 4-9 Viewing and Moving Rules

NOTE The order a rule is listed in the Database Rule (System) view will 
determine the order they will be executed in when more than one 
rule is triggered by the same event. The order of items in the 
Category view does not affect the order they are executed in.
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About UI Rules
UI Rules are used to execute actions when fields in the graphical user 
interface of Service Desk are modified. The action specified in the rule 
will take place immediately in the current data form. The key difference 
between UI rules and database rules is that database rules are evaluated 
by events in the database and UI rules are evaluated by events in the 
graphical user interface. Actions executed for a UI rule affect the current 
form or record that is being viewed.

UI rules evaluate the information entered in a field. For text and data 
fields the evaluation takes place as soon as the cursor leaves the field. 
When a drop-down list is used the field is evaluated when a value is 
selected from the list.

UI rules can improve time critical processes by:

• Guiding users to enter the correct data in a form.

• Automatically entering data in a form.

• Restraining users from entering irrelevant or incorrect data.

• Providing problem solving data when needed.

• Providing a means of supporting the workflow process.

Scenarios for Using UI Rules

Following are a few example scenarios of how you can automate 
processes with UI Rules:

• A Help Desk employee enters a service call. When the Caller’s name 
is entered, a list of other service calls assigned to the caller pops up. 
The Help Desk employee can examine the list to see what other 
problems the caller has experienced. This uses an Overview action.

• A Change manager closes a change. The Actual Finish field is 
automatically filled with the current date. This uses the Update data 
action.
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• A specialist changes a service call’s status to completed. 
Consequently, according to the regular workflow path, further 
assignment of the service call is restricted to the help desk group, no 
other group can modify the service call. This uses the limit field 
value range action.

Technical Overview for UI Rules

UI rules are managed in similarly to database rules, see “Technical 
Overview of Database Rules” on page  98. The key differences are that 
the rules are triggered by an event in the user interface and not the 
database, and that the actions are not executed by an agent because they 
are executed on the same machine. Timed conditions are not used for UI 
rules, so the alarm engine is not used.

Creating UI Rules

To create a UI Rule:

Step 1. Select the item in Service Desk that this rule will apply to:

1. From the Tools menu select System. In the Administrator Console 
double-click Business Logic and then UI Rules.

2. Select a Service Desk item, for example the Service Call item:
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Figure 4-10 Select a Service Desk Item

3. Use an existing rule or right-click in the UI Rule window and select 
New UI Rule from the menu that appears.

Step 2. Specify the conditions for the rule.

1. In the following dialog box, click Add to set preconditions for the 
database rule:
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Figure 4-11 Add Preconditions for a UI Rule

2. Enter the preconditions, defining under which conditions you want 
the rule to be evaluated. You must enter at least one field.

Pre-conditions are only used in UI rules and are used to specify a 
condition that needs to exist before a rule will be evaluated. 
Pre-conditions do not trigger the execution of an action, they specify 
when to evaluate the rule:

Figure 4-12 Add Preconditions for the Rule

3. Set the triggering conditions that you want to use to trigger the 
action. When a triggering condition is met it starts the action. A 
triggering condition is necessary for a UI rule to be executed:
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Figure 4-13 Add Triggering Conditions

Step 3. Add actions to the rule.

1. Click Add to add an action. You must specify at least one action for 
the rule. You can select the Command Exec Action, Update Data 
action, Smart Action, Overview Action, System Action, or the Limit 
Field Value Range action. UI rules do not require a host name in the 
Command Exec Action. For additional information about how to 
configure actions, see “About Actions” on page  117. 
For this example the Update Data action is used to create two 
actions for this rule:

NOTE Multi word parameters (parameters containing spaces) can be used if 
they are enclosed within quotation marks. For example: sd_event 
information=”multiword information”. However, if you need the 
quotes to be passed on to another application the quotes must be 
preceded by a back slash as an escape character. The above example 
becomes: sd_event “information=\”multiword information\””
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Figure 4-14 Add Actions to the Rule

2. Enter an identifying Name for the action:

Figure 4-15 Update Data Action Example

3. Clear the Blocked check box to turn on this action.

4. To enter information in the Update fields and related items as 
follows window, use the More updates portion of the dialog box to 
select parameters and then click Add to List to enter them in the 
window.
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5. You can add multiple actions to each rule. To add additional actions 
click OK to return to the previous dialog box, and then click Add.

NOTE For additional information on updating data actions, see “Creating 
Update Data Actions” on page  121.

Step 4. Name the rule and turn it on or off:

1. In the Specify a name for this rule field, enter an identifying 
name for the rule. This name will appear in the UI Rule window for 
that item.

Figure 4-16 Add the Name and Category

2. Enter a Category to group this rule with similar UI rules. 

You can use the drop-down button to select from a list of available 
categories or you can create your own categories. 

To create a category: in the System Administrator’s console select 
Data, then Codes, then General. Open the Rule Category option, 
right-click in the view, and select New rule category. Type the 
name of your new category in the dialog box that appears. 
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You can organize your categories by: selecting the rule and then 
using the arrows on the toolbar. There are two types of views 
possible; the UI Rule (System) view and the Rules by Category 
(System) view. It is only possible to move rules in the UI Rule 
(System) view:

Figure 4-17 Viewing and Moving Rules

3. Clear the Block this rule check box to turn the rule on.
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About Actions
Actions are executed when the conditions for a rule are met. A number of 
different actions can be configured and triggered both on the client 
computer and off. 

The following actions can be triggered by a database rule on the machine 
that triggered the action or on another machine:

• Command Exec Action 

• Update Data 

• Send e-mail message 

The following actions can be triggered by a UI rule. The actions are 
executed on the same machine that they are triggered on:

• Command Exec Action 

• Update Data 

• Limit Field Value Range 

• Smart Actions 

• Overview Actions

• System Actions (not configurable)

Access Rights

Database and UI rules are created by system administrators who have 
system administrator access rights. As a consequence, a user who does 
not have the same access rights may inadvertently trigger an action that 
is beyond that person’s access rights.

The following example demonstrates one possible scenario:

Your system administrator created a rule that sets the Status of a service 
call to Closed when the Actual Finish date is entered. A specialist enters 
the Actual Finish date in a service call (after completing it), but does not 
have the rights to change the status of a service call item. The rule is 
triggered, the service call is automatically given the Closed Status, and 
the history line will show that the Actual Finish field was entered by the 
specialist and that the status was changed by the system administrator.
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Creating Command Exec Actions

The Command Exec Action is used to execute a command with a set of 
parameters specified by you. This action can be used to send event 
information to a third-party application, or to start another application 
such as a banner program, for example. A number of examples are 
provided with the demo data for Service Desk.

To configure a Command Exec Action:

1. Enter a Name for the action in the action dialog box:

Figure 4-18 Command Exec Action

2. In the Description field, enter a brief explanation of the action that 
will be performed.

3. Enter the name of the Host computer the action will take place on. If 
the action is in response to a message sent by an external 
application, the host name will automatically be taken from that 
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account and filled in. For example, if an acknowledgment message is 
being sent to ITO, the host will come from the account that originally 
sent the incident to Service Desk. 

UI rules don’t require a host machine because they are executed 
locally.

4. Enter the Command you want to execute, for example: 
c:\programfiles\ITO\Bin\ITO_ack.exe

5. In the Parameters field, define additional information for the 
command by inserting parameters using the Field button.

Creating Send E-mail Message Actions

The Send E-mail Message action uses parameters to determine the 
message text used when sending e-mail messages. For example, this 
action can be used to send an e-mail message about a service call to a 
manager when the service call is approaching the resolution deadline. 
The parameters entered might include; the Service call number, the 
person the service call is assigned to, the deadline, status, caller, and the 
text from the Information field. 

To configure the action:

1. Enter a Name for the action.

2. In the Send to field, enter the e-mail addresses where the e-mail 
messages should be sent. You can also use the Field button to enter 
field related addresses such as [person:Assignment], this will send 
the e-mail message to the person or group selected:
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Figure 4-19 Send E-mail Message Action

3. Enter the Subject. Use the Field button to insert the service call 
number or other information taken from the Service Desk item.

4. In the Message window compose the e-mail message to be sent by 
inserting parameters with the Field button, for example:
Service call [Number] is almost overdue.
Specialist [Assignment to person].
Deadline [Deadline].
Status [Status].
Caller [Caller].
Information [Information]. (information from the Service call 
information field will be inserted)

NOTE Outbound mail settings must be configured properly, refer to “Using 
E-mail with Service Desk” on page  215 in the Administrator’s Guide for 
additional information.
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NOTE To enable sending an e-mail message to a specific machine you may have 
to add an "MX" record to the DNS tables to explicitly allow that machine 
to use it’s SMTP port. (There are two kinds of DNS authorizations: A 
scheme that allows anything that is not forbidden, and a scheme that 
needs explicit approval for anything that is possible.)

You can check whether your machine is registered at the DNS tables by 
running the following from a DOS prompt: C:\> nslookup -type=mx 
<hostname>

If the DNS tables are set up OK, then the <hostname> machine should 
appear in the list of MX preferences and one of the mail-exchanger 
settings points to <hostname>.

Creating Update Data Actions

The Update Data action is used to update data in the Service Desk 
database. For example, you could use this action to automatically enter 
the Actual Finish date when a service call is put in a Closed status. 

It is possible to configure the action to set an attribute using a selected 
static value or to dynamically update a field with the value of another 
field.

NOTE When creating an update value the new value will always be a 
replacement for the current value and cannot be added to the current 
value.

Update using a static value

1. Enter a Name for the action:
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Figure 4-20 Update Data Action

2. Use the Field button to select the fields you want updated, then 
select an Operator using the list button.

NOTE If you copy information between fields and the source field is longer 
than the destination field the information can be truncated; for 
example, if you try to copy the contents of the information field to a 
Name field.

3. Select the value to be applied to the field using the list button.

4. Use the Add to List button to move the information you selected to 
the Assign new values to fields window.

5. If you are creating an Update Data action for a Database Rule you 
will have the additional option of updating fields in related items. 

To update the field of related item:

a. Select the Select a related item? check box and use the 
drop-down arrow in the field on the right to select a related item. 
The items shown are dependent on what item the rule is based 
on.
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b. You can select from a list of fields available for the related item 
by clicking Fields.

c. Select an Operator with the drop-down arrow and then select 
the value that you want to apply to the field:

d. Click Add to list to add the update. You can select additional 
items and fields for updating. 

Figure 4-21 Update Data and Related Item Fields

NOTE It is not possible to update a related item with a many to one 
relationship. For example, you cannot create an action to update the 
status of a Change when all of the work orders related to it are closed. 
One to many relationships are possible, such as the example mentioned 
above. Many to many updates, such as multiple work orders updating 
multiple configuration items are also possible.

Update using a dynamic value

1. Enter a Name for the action:
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Figure 4-22 Update Data Action

2. Use the Field button to select the fields you want updated. 

3. Select an Operator set to value of.

NOTE The layout of the next field will change on setting this operator 
value. The label will change from Value to Field and a button will be 
visible to the right of the field.

NOTE Multi word parameters (parameters containing spaces) can be used if 
they are enclosed within quotation marks. For example: sd_event 
information=”multiword information”. However, if you need the 
quotes to be passed on to another application the quotes must be 
preceded by a back slash as an escape character. The above example 
becomes: sd_event “information=\”multiword information\””
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Figure 4-23 Add Actions to the Rule

Figure 4-24 Update dynamic data

4. Select the value to be applied to the field using the button to the 
right of the text box. 

Figure 4-25 Dynamic data field button

5. Use the Add to List button to move the information you selected to 
the Assign new values to fields window.
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NOTE The list shown by using the button to the right of the Field text box only 
lists fields of the same type as the selected base field; but not the same 
field.

Creating Limit Field Value Range Actions

This action makes it possible to limit the options available in a field. The 
field can be limited by setting fixed options or by making the options 
available dependent on the option selected in another field in the form.

To create a Limit Field Value Range action:

1. Enter the Name you want to give this action:

Figure 4-26 Limit Field Value Range Action

2. Clear the Blocked check box to turn the action on.

3. Click Fields to select the field you want to place a limitation on.

4. Use the drop-down arrow to select an Operator from the list. The 
operators available are based on the item and the field you have 
selected to limit.

5. Use the drop-down arrow in the Value field to enter the limit. 

6. Click Add To List to enter the selection. Repeat this process to limit 
more fields, if required.
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Creating Smart Actions

Smart actions call an external application when you are working in 
Service Desk. You can call the application using parameters that may or 
may not be dependent on fields in the Service Desk item you are working 
with. For example, you can create a smart action to open a knowledge 
base program when you enter data in one of the fields in a service call. 
When adding a smart action to a UI rule you will select from a list of 
smart actions that the system administrator has already configured.

For information about creating Smart Actions refer to the Online Help.

The following dialog box shows a configured smart action:

Figure 4-27 Smart Action - Activating Knowledge base

Creating Overview Actions

Overview Actions can be used to define a view. When the shortcut is 
activated the overview you defined is presented. Overview actions are 
usually related to an item you are currently working with. For example, 
you can activate an overview showing all of the open calls for a caller 
when you are working on a service call for that person. A number of 
examples are available in the demo data provided with Service Desk. 
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When adding an Overview Action to a UI rule you will be selecting from 
a list of overview actions that have already been created by your system 
administrator.

For additional information about creating Overview actions, refer to the 
Online Help.

The following dialog box shows a configured Overview action:

Figure 4-28 Overview Action dialog box

Creating System Actions

System actions are actions that have been defined by the developers of 
Service Desk. The system actions are complex actions that cannot be 
modified. You can select existing actions for use. For example, you can 
create a UI rule to start the Checklist system action whenever the caller 
is entered in a service call. The checklist provides a list of questions to 
guide the help desk engineer in answering the service call.

For additional information about System Actions or the Checklist, refer 
to the Online Help.

Sending Failed Actions

When a Rule Manager action cannot reach the agent it is intended for, 
that action is stored on the Service Desk application server with the 
agent’s name. Events can be stored for up to 24 hours before they expire. 
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When the agent is active again it calls the Service Desk application 
server and gathers the actions assigned to it. The Service Desk 
application server is only capable of storing events that failed to reach 
the agent. If the server goes down all of the waiting actions will be lost. 
Scheduled actions are not discarded after 24 hours, they are saved in the 
database until the time comes for them to be executed. 
Chapter 4  129



Business Logic
Rule Manager Reports
Rule Manager Reports
A detailed report containing information on the UI and database rules is 
available from the Business Logic tree within the Administrator console. 
To view the separate directories and reports for the database and UI 
rules expand the Business Logic tree.

The view for the database and UI rules will contain the following 
descriptions:

NOTE The view cannot be modified.

Figure 4-29 Rule view

The report can be printed by selecting Print on the File menu.

Table 4-1 Report information

Column Information

Name Name of the rule

Blocked Yes/No

Category Rule category

Condition Lists all the conditions in the rule

Actions Lists all the actions in the rule
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View Scheduled Rule Actions
Whether an action associated with a database or UI rule is executed 
depends on the condition that has to be met. 

This condition can be scheduled. This means that the validity of this 
condition is not an issue the moment the rule is triggered but at a later 
moment in time. 

An overview of all the scheduled tasks is available for viewing by the 
system administrator. This view can be found within the Administrator 
console under Business Logic/Scheduled Tasks.

There are two types of tasks reported in this view, they are database rule 
actions and SLA reports.

The columns within the view show the following information:

NOTE An overview of all scheduled tasks are only available to users with 
administrator rights.

To view a table of scheduled tasks:

1. Select System from the Tools menu.

2. Select Business Logic.

3. Select Scheduled Tasks.

An example of the view of scheduled tasks:

Table 4-2 Details of scheduled actions view

Field Information

Date Time/date of action

Type Rule or SLA

Description Short name of the rule plus an associated entity id

Server Application server name or IP address
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Figure 4-30 Scheduled tasks view

There are two types of tasks: database rule action and SLA report. A 
view shows all the scheduled tasks. A task can be opened in a form. 
Tasks can be printed as a multi-record report.

NOTE It is not possible to delete scheduled actions.
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Rescheduling of Scheduled Tasks
All scheduled tasks are assigned to a particular server and if, for any 
reason, this server is not connected or working at the time the task is 
scheduled the task will not be executed and therefore become overdue. 

To avoid tasks becoming deleted, it is possible to reschedule the task to 
another server from the Scheduled Tasks view.

NOTE It is not possible to reschedule a task before the server the task has been 
assigned to is disconnected or not working. If a server is scheduled to be 
offline during the time that actions are due to be executed it is not 
possible to reschedule them until the server is actually disconnected.

To Reschedule a Task

The Administrator discovers that a server that has been assigned tasks 
has not been able to execute them due to for example, being offline.

NOTE If the server was not down, but just connected to another database at the 
time of execution, the task will not be able to be rescheduled. If you wish 
to reschedule a task because you are moving a server to a different 
database the rescheduling must be completed while the server is not 
connected to the network.

1. Open the View Schedule Tasks form from the Administrator Console.

2. Choose Reschedule Tasks from the Actions Menu.

3. In the Reschedule Tasks window select OK to reassign the tasks to 
the server currently connected.
Chapter 4  133



Business Logic
Rescheduling of Scheduled Tasks
Figure 4-31 Reschedule tasks

NOTE The rescheduling process cannot be aborted.
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Monitoring Rule Actions
It is possible to monitor actions performed by the rule manager for 
Database rule information and UI rule information.

To enable monitoring of the rule actions open the General Settings dialog 
within the administrator console. (../hpOpenView/System 
Panel/General Settings) and check the check box Rule Manager 
Debug (More Detailed Entries in Log Files).

Figure 4-32 Administrator Console /General Settings

The information that can be monitored includes the following:

• an object of a particular entity is changed and verified

• a condition is fulfilled

• a scheduled action has been executed

• an action has been scheduled (DB rules)

Database rule information is written to the file logserver.txt and UI 
rule information is written to logclient.txt.
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About the Agent
The Service Desk agent is only used to execute Command Exec Actions. 
It is not used when performing actions to update the Service Desk 
database. For installation and activation instructions refer to the HP 
OpenView Service Desk: Installation Guide.
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5 Opening Forms from the 
Command Line

Included with Service Desk is an executable that can be started by other 
products to initialize specific parts of Service Desk.
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Examples of Use
The command-line interface can be used in various integrations. In a 
command-line integration an external application calls Service Desk 
classes and passes arguments in the call. The call can be made through 
the DOS prompt. 

For example: help desks often make use of CTI (Computer Telephony 
Integration) applications. CTI applications are used to route telephone 
calls automatically to the right help desk employee. The CTI application 
can call external programs, passing the telephone number of the caller 
over the command line. The command string passed along the command 
line can identify and search for all previous or open Service Calls from 
that caller. The help desk employee can then see an overview of the 
service calls logged by the caller in the Search Results dialog box before 
picking up the telephone. 

NOTE The application triggering the command line action and Service Desk 
(client) must be installed on the same computer.
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Use the executable sd_dataform.bat to open a specific form in Service 
Desk from the command line of another application. The form can be a 
standard form, or one created specially for the purpose, but the form 
must exist before it can be called by the executable. You will need to 
know the exact name of the form for the command line argument. Forms 
are created and edited in the Form Designer feature of the 
Administrators Console. To open the Form Designer, select System from 
the Tools menu, then open the Forms branch from the Presentation 
node. 

Command Line Syntax

The syntax for the command line is:

<service desk path\bin> SDDataForm <Form name> <Display 
option> <Search criteria>

For example:

SDDataForm “Service call” -ListAlways ID=200

The above example searches for the form Service Call, and any service 
call records with the ID number 200. The results are displayed in the 
Search Results dialog box even if no matching database records are 
found. Each element of the command line argument is in the following 
section.

General Rules for Arguments

When composing command line arguments, the following points should 
be kept in mind:

• Whenever a form name or field name value contains any character 
not recognized by DOS or that DOS gives a different meaning (for 
example a space,’ >’ symbol, or a period) the form name or search 
criterion must be included in quotation marks. If you need to include 
a string in quotation marks, you cannot include quotes within 
quotes. A single set of quotation marks must include all illegal 
characters in the argument.

• All arguments are case-sensitive.
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• The search value entered in the command line argument must be 
identical in format to the value stored in the database. For example, 
if a CTI application identifies a telephone number of an incoming call 
as 0123456789, but the number is stored on the database as 012 345 
6789 (with spaces), no occurrences of the telephone number will be 
found, and the search will fail.

• Command Line arguments must contain the path variable unless the 
DOS command indicates the correct directory (folder) at the DOS 
prompt. The executable file sd_dataform.bat is located in the 
Service Desk client\bin folder of both the client and server 
installations.

• The client user must have access rights to the form being called.

Command Line Executable

The executable file used by Service Desk to do a database search, and 
open forms from data passed via the command line is sd_dataform.exe. 
This executable is located in the Service Desk \client\bin. 

Sd_dataform.bat must be named first in the command line string 
unless DOS needs to be told where to find it, in which case the path to its 
location must be included. If the DOS prompt is already in the \bin 
directory nothing needs to be inserted before sd_dataform.bat. For 
example:

With a prompt in the correct folder:

C:\Program Files\Hewlett Packard\OpenView\service desk 
4.5\client\bin\> sd_dataform.bat .....

Without a prompt in the correct folder:

C:\>Program Files\Hewlett Packard\OpenView\service desk 
4.5\client\bin\sd_dataform.bat .....

Alternatively, the path can be set in the Windows Environment Path 
settings to ensure the prompt is in the correct folder. There is a slight 
variation between Windows NT4 and Windows 2000 when setting the 
Environment Path.

To set the Environment path in Windows NT:

1. From the Start menu select Settings and then Control Panel.
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2. In the Control Panel double-click the System icon, and then select 
the Environment tab.

3. Select Path from the list of systems variables.

4. Append ;<SD product path>\client\bin or ;<SD product 
path>\client\bin to the existing path variables, where <SD 
product path> is the actual path of Service Desk on your computer.

To set the Environment Variables path in Windows 2000:

1. From the Start menu select Settings and then Control Panel.

2. In the Control Panel double-click on System, and then select the 
Advanced tab.

3. Click Environment Variables.

4. Select Path from the list of variables and click Edit.

5. Append ;<SD product path>\client\bin or ;<SD product 
path>\client\bin to the existing path variables, where <SD 
product path> is the actual path of Service Desk on you computer.

Another alternative is to edit the autoexec.bat file, by appending the 
following to the SET PATH parameter:

;<SD product path>\client\bin or ;<SD product 
path>\Server\Bin, where <SD product path> is the actual path of 
Service Desk on your computer.

Form Name

The first argument in the command string must be the name of an 
existing form. If two or more forms have the same name, the first one 
created will be used. There are several ways to find the name of a form: 
simply open the form in service desk and take the name from the title 
bar, generate the data dictionary (see “Generating a Data Dictionary” on 
page  198 for more information), or open the forms branch in the 
Administrator’s Console (described below). The data dictionary will give 
you a full list of all form and field names in Service Desk. Each of these 
methods will provide the localized names.

To find the form names in the Administrator’s Console, do the following:

Step 1. In Service Desk, choose System from the Tools menu.
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Step 2. In the Administrator Console, open the Presentation node and then 
the Forms node.

Step 3. Find the Form you want from the list.

Step 4. Double-click the Form title to open the form to check if it is the form you 
require. 

Display Options

The display options define how the results of a database search are 
treated. There are three possible outcomes of any database search; no 
matching records are found, one matching record is found, or multiple 
matching records are found. How Service Desk responds to these three 
possibilities can be defined using one of three display options:

• No option defined. The Service Desk default is that if you do not 
define a specific display option, the following actions will occur: 

1. When no records are returned from the search, a new form will 
be opened.

2. When a single record is returned, that record will be opened 
automatically in Modify mode.

3. When multiple records are found, the Search Results dialog box 
will open displaying a list of all returned records.

• -ListAlways will cause the Search Results dialog box to be 
displayed even when no records, or only one record is returned. The 
user will have to click the New button if they then want to create a 
new record.

• -ForceNew will cause a new instance of the named form to be 
displayed, regardless of any search criteria.

When Service Desk finds more than one item in a search, or when the 
display option is set as ListAlways, the Search Result dialog box is 
shown. To open an item shown in the Search Result dialog box, select it 
and click Open.
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Figure 5-1 CLI Search Results dialog box

Search Criteria

Search criteria are optional, however if no criteria are set then a blank 
form will be displayed. Multiple criteria can be defined.

The search criteria syntax is:

FieldnameOperatorValue

There must be no spaces between the three elements of the search 
criteria; Field Name, Operator and Value. Spaces are allowed in the 
Field Name or in the Value as long as the whole name or value is 
enclosed in quotation marks. For example:

Location=B1R103 “Outsourced to=HP”

will find all configuration items located at location B1R103 that are 
out-sourced to HP.

Field Name

As with forms, there are several ways to find the name of a field: simply 
open the form in service desk and take the field name from the UI, 
generate the data dictionary (see “Generating a Data Dictionary” on 
page  198 for more information), or open the forms branch in the 
Administrator’s Console (described below). The data dictionary will give 
you a full list of all form and field names in Service Desk. Each of these 
methods will provide the localized names.

To find the field names you need, do the following:
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Step 1. In Service Desk, choose System from the Tools menu.

Step 2. In the Administrator Console, open the Presentation node and then 
the Forms node.

Step 3. Find the Form you want from the list.

Step 4. Double-click the Form title to open the form. 

Step 5. The fields available for inclusion in the form are listed in the 
Attributes dialog box. Only the fields currently used in the form and 
thus displayed in the Form Designer dialog box should be used for a 
command line search.

Extended field names

You can use the fields of related items to find a service call. If you use 
field names of related items, the field name is extended with the item 
name. Use a period to separate the item name from the field name. For 
example, to open service calls using the caller’s telephone number, you 
can use the field name: Caller.PrimaryTelephoneNumber. Or, to open a 
configuration item using the location’s search code where the 
configuration item is placed, use: Location.searchcode.

NOTE To see an example of what field names and extended field names are 
possible, open the Advanced Find dialog box. In the Advanced Find 
dialog box, click the Advanced tab and then click Fields. The names in 
the fields list can be used as field names. Names in submenus of the 
fields list must be used as extended field names.

Operators

You can use the operators shown in the following table:

Operator (Text) Operator 
(Symbol) Usage

Equal = is equal to

NotEqual != is not equal to

GreaterThan > is greater than
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GreaterThanOrEqualTo >= is greater than or equal to

LessThan < is less than

LessThanOrEqualTo <= is less than or equal to

Between is included in the range 
defined by two values. 
Separate values with AND. 
Text strings with spaces or 
illegal characters should be 
identified by quotation marks.

NotBetween is excluded from the range 
defined by two values. 
Separate values with AND. 
Text strings with spaces or 
illegal characters should be 
identified by quotation marks.

Contains is one of a list. Separate 
values with AND or OR. Text 
strings with spaces or illegal 
characters should be 
identified by quotation marks.

NotContains is not one of a list. Separate 
values with AND or OR. Text 
strings with spaces or illegal 
characters should be 
identified by quotation marks.

Empty is empty (no value given, 
NULL)

NotEmpty is not empty (value given, not 
equal to NULL)

Yesterday date is equal to yesterday’s 
date (system date -1)

Operator (Text) Operator 
(Symbol) Usage
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Standard DOS wildcards (*, ?) can also be used in values, for example: 
sm* will find Smith, Smythe, Smit, etc.

Whenever the text version of an operator is used it must be contained in 
square brackets, with no spaces around it. For example:

ID[Equal]251

Today date is equal to today’s date 
(system date)

Tomorrow date is equal to tomorrow’s 
date (system date +1)

Last7Days date is one of the last seven 
days (Between system date 
and system date -7)

Next7Days date is one of the next seven 
days (Between system date 
and system date +7)

LastWeek date is one of the days of the 
last working week

ThisWeek date is one of the days of this 
working week

NextWeek date is one of the days of the 
next working week

LastMonth date is one of last month

ThisMonth date is one of this month

NextMonth date is one of next month

StartsWith text starts with ......, if the text 
string has spaces or illegal 
characters the string should 
be identified by quotation 
marks.

Operator (Text) Operator 
(Symbol) Usage
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If you need to include a string in quotation marks, you cannot include 
quotes within quotes. A single set of quotation marks must include all 
illegal characters in the argument.

NOTE If you want the data found by the search criteria to be inserted 
automatically in the named form when a new form is called, insert a + 
symbol before each search criterion in the string that you want to be 
included in the form. If the criterion is enclosed by quotation marks, 
because of a space or illegal character, place the + symbol inside the 
quotes.

Value

The value searched for must be entered in the correct format for 
anything to be found, and if that value format contains a space or other 
illegal character, such as a period, the value must be contained in 
quotation marks.

To find an item by date, use the date format specified in the system 
settings of your computer, for example on April 27, 2001 use: 27/04/2001. 
The date format depends on the system settings of your computer.

Search codes must be capitalized. To find an item based on a search code, 
for example for Steven Barns use: BARNSS. 
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6 Configuring Service Pages

The service pages are secure Internet pages that enable your customers 
and specialists to report problems and access data over the Internet. 
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To set up Service Pages Accounts there are four steps that are required:

• Define the Views and Templates.

• Define the Role settings.

• Create a user account, or allow users to create their own accounts.

• Set the password limitations.

All these settings are defined from the Service Desk Administrator 
Console. To open the Administrator Console do the following: 

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. The Administrator Console is displayed:

Figure 6-1 Administrator console dialog box

Defining Service Pages Views and Templates

To create and assign a View for Service Pages accounts:
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1. In the Administrator Console expand the Presentation node below 
the Service Pages icon, and open Views.

2. In the Views branch, select Service Call and right-click in the right 
hand pain, a popup menu is displayed.

3. In the popup menu choose New View. The New View dialog box is 
displayed. Enter a name for the new view in the Name field:

Figure 6-2 New View dialog box

4. Click OK. The View Summary dialog box is displayed. Click the Filter 
button to specify the conditions for the view. The Filter dialog box is 
displayed:
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Figure 6-3 View Summary dialog box

5. In the Filter dialog box, you can click the More Choices tab and 
select Where I am: The Caller check box in the list that is 
displayed. This will ensure that the end users will only be able to 
view their own Service Calls. Click OK:
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Figure 6-4 View Filter dialog box

6. The View Summary dialog box will now show that the Filter is on. 
Click OK. The new view is now displayed in the list of available views.

7. In the Administration Console select View Settings below the 
Service Pages, and Presentation nodes.

8.  Double-click on Service Call in the right hand pane, the Service 
Call - View Settings dialog box is displayed.

9. In the View Settings dialog box select a view from the drop-down list 
for Full and Restricted lists that can be viewed by the end users 
and Support Engineers. Click OK: 
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Figure 6-5 Service Call - View Settings dialog box

Existing Templates can be used for Service Pages accounts. For 
information on creating new templates see the Service Desk Online Help. 

NOTE A Service Pages end user can only enter data to a limited subset of 
Service Call fields, therefore the template used must contain default 
values for any required fields that are not visible to the Service Pages 
user.

To assign Templates for the Service Pages account:

1. In the Administration Console select Template Settings below the 
Service Pages, and Data nodes.

2. Double-click the Service Call template entry in the right-hand pane.

3.  The Service Call - Template Settings dialog box is displayed. 
To select a template, click the icon adjacent to the Template for 
insert field:
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Figure 6-6 Template Settings dialog box

4. The Choose Template dialog box is displayed. Highlight the 
template you want. The check box in the right hand view indicates 
the currently selected default, there is no need to change this. Click 
OK.

Figure 6-7 Choose Template dialog box

Defining Service Pages Role Settings

Once you have established which views and templates are to be used for 
the Service Pages Role other settings for the Role must be defined. These 
tasks are all accessed from the Service Desk part of the tree in the 
Administrator’s Console.
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1. If you plan to limit the access of users to just service calls that are in 
a particular status range then Status Entitlement must be 
enabled. To do this select the Service Desk System Panel and 
double-click on the General Settings icon. The General Settings 
dialog box is opened. Select Enable Status Entitlement, click 
Apply and then click OK:

Figure 6-8 General Settings dialog box

2. In the Administrator Console select the Access node and then Role. 
Double-click the Service Pages role in the right-hand pane, the 
Service Pages - Role dialog box is displayed:
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Figure 6-9 Service Pages - Role dialog box

3. Highlight the Service Call item and click Advanced. The Item 
Access dialog box is displayed. If the views or templates you selected 
above are not displayed on the Views or Templates tab pages, click 
the Relate button and select them from the popup list. Click OK in 
the popup list, to return to the Item Access dialog box, and click 
Close to return to the Service Pages - Role dialog box:
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Figure 6-10 SP Role - Item Access dialog box

4. In the Service Pages - Role dialog box, allow the Role View, New, and 
Modify rights for Service Calls by expanding the Service Call item 
and checking the relevant sub-items check boxes:
  Chapter 6158



Configuring Service Pages
Service Pages User Accounts
Figure 6-11 Service Pages - Role dialog box

5. Highlight Service Call and click Details. The Detailed Item 
Access dialog box is displayed. The Access tab reflects the checked 
items on Role dialog box. Select the History line tab and select the 
View and New check boxes to enable the users to see and add new 
History lines. 
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Figure 6-12 Service Pages History Line dialog box

6. Click the Status Access tab, and select the same status from the 
drop-down lists for both the Status from and Status to fields. This 
will restrict the end users Modify rights to only editing Service Calls 
that they have created and that are still in the selected status. The 
status you select will usually be the status set up on your system for 
service calls that have been created but not yet accepted by a 
specialist or work group:
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Figure 6-13 Service Pages Status Access dialog box

Create a Service Pages User Account

To create a Service Pages user, do the following:

1. In the Administrator Console, expand the Access node below the 
Service Pages icon. In the Access branch, select SP Account.

2. Right-click in the Account view and choose New SP Account from 
the popup menu. The Account dialog box is displayed:
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Figure 6-14 Account dialog box

3. Type the name to be displayed when referring to this account. This is 
the name that will normally be displayed, for instance, in the Active 
Service Desk sessions tab page.

4. Enter the login name that the user will use to log on to Service 
Pages. This may be the same as the user’s NT login, but it is not 
required. 

5. Enter a password, and confirm the entry. Password rules are set up 
using the Password Settings in the System Panel. If you provide 
the user with a password they can change it by using Options from 
the Tools menu and then selecting Accounts and then Change 
Password.

6. Leave the Host field blank. 
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7. Enter the user’s Default language, by selecting a language from 
the drop-down list. Only languages displayed in the list have been 
installed in the Service Desk database for localization. 

8. Select the user’s Default time zone from the drop-down list. All 
records are stored on the database as Greenwich Mean Time, and 
adjusted by the difference dictated by the user’s time zone setting 
when created, viewed, or modified. See the Service Desk online help 
for more information.

9. Use the Blocked check box if you want to ensure that the account 
cannot be used. This may be a useful alternative to deleting an old or 
redundant account.

Relating Accounts to Person Items in Service Desk

Before an account can be used, a Service Desk person record must be 
created (or an existing one modified) and the account name linked to the 
person record using the Account field in the person record. For more 
information about creating and modifying Person items see the Service 
Desk Online Help.

Setting the Password Limitations

You can define the limitations and requirements for user defined account 
passwords. The password limitations will apply to all Service Pages 
accounts.

To set the password limitations:

1. In the Administrator Console, select System Panel below the Service 
Pages branch, and double-click the Password Settings icon.

2. In the Password Settings dialog box select the settings you want to 
enforce and click OK:
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Figure 6-15 Password Settings dialog box

Setting the E-mail Host Name

By setting an e-mail host name you can define which end users are 
allowed to create their own Service Pages account on-line. Subject to two 
criteria, end users with an e-mail address from the specified host can 
create their own account. The two criteria are that a valid person record 
exists in Service Desk and that the person record has an e-mail address 
from the host name set in the e-mail field. A password for the new 
Service Pages account is returned to the e-mail address set in the person 
record.

To specify an e-mail hostname:

1. In the Administrators Console expand the Access branch below the 
Service Pages node, and select E-mail hostname:
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Figure 6-16 Administrator’s Console - E-mail Hostname view

2. Right-click in the view pane, and choose New E-mail Hostname from 
the pop up menu. Enter the new host name in the Hostname field and 
click OK. You can block a hostname from being used by selecting the 
Blocked check box. This will block users from that e-mail domain 
from creating Service Pages accounts without removing the host 
name from the system. This ensures the integrity of any database 
records that have previously used this host name.

Figure 6-17 New E-mail Hostname dialog box
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Setting up Service Pages Accounts for 
Support Engineers
Support Engineers are able to access Service Pages using their existing 
Service Desk accounts if Service Pages views and templates have been 
set up for them. Create views and templates for Support Engineers in 
the same way as for other users. Support Engineers, however, will 
require more views and templates as they will need to access not only 
service calls, but also incidents, problems, changes, and work orders via 
the Service Pages.

To enable Support Engineers full functionality through Service Pages:

1. Create templates for new service calls and incidents created in 
Service Pages.

2. Create views for service calls, incidents, problems, changes, and 
work orders in the same way as for other users.

3. Assign templates for new service calls and incidents.

4. Assign Service Pages views for service call, incident, problem, 
change, and work order overviews.

5. Assign the selected views and templates to the Service Desk support 
engineer role.
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Setting Up E-mail Approval for Service Pages 
Service Desk provides the facility for approval to be sought before 
specified actions can be performed. If this functionality is to work in 
conjunction with Service Pages, the fully qualified host name for the 
server where the Service Pages are resident must be entered in the 
General Settings dialog box.

To enter the Service Pages server name:

1. In the Administrator Console click the System Panel branch of the 
Service Desk node.

2. Double-click the General Settings icon, then click the 
Application tab. Enter the server name in the Service Pages 
Server Host Name field. Click OK:
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Figure 6-18 General Settings dialog box

NOTE If you use the Tomcat web server supplied on the installation CD, 
you must specify the port :8080 after the server name, for example, 

SP_server1.invention-inc.com:8080
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In the Service Pages, you can easily configure the links, fonts and the 
logo in the header. 

To configure the links and the customer header, you must edit the HTML 
files. These can be found in the folder \\Service Desk 
4.5\Sp\SSP_Files.

To configure the logo:

1. Go to the file logo1.html.

2. Open the file with an HTML editor.

3. In FrontPage editor, insert the graphic of your choice in the HTML 
line <IMG src=”xxxx.gif”>, where xxxx is the Hewlett Packard 
logo.

4. Save the file. Make sure that your editor has the character set 
defined as Multilingual (Unicode UTF-8) language.

To configure the links:

1. Go to the file links.html.

2. Open the file with an HTML editor such as Microsoft  FrontPage 
Editor.

3. Replace the default links by the links of your choice.

4. Save the file. Make sure that your editor has the character set 
defined as Multilingual (Unicode UTF-8) language.

To configure the font:

1. In the file sd-sp.css, change the default fonts to the fonts of your 
choice.

2. Save the file.
Chapter 6  169



Configuring Service Pages
Configuring the Service Pages Interface
  Chapter 6170



7 Multiple Servers

Running multiple servers gives a more robust and balanced 
environment. If an application server fails or the network to the server is 
broken, clients connected to that server automatically reconnect to the 
other application servers.
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There is no limit to the number of application servers that can be 
installed on different machines on your network, and no configuring of 
these servers is necessary providing they all connect to the same 
database. When a client connects to the server that is defined in the 
client’s connection settings, the server checks with the database and sees 
what the current load balance and weighting is on all the servers. If the 
defined server has a unbalanced number of connected clients, the new 
client session is routed to another server.

When the Service Desk Application Server software is installed, the 
Multiple servers check box on the General tab of the Configuration 
Editor is checked by default. If, after installation, the multiple servers 
are not communicating with each other, you should check this setting for 
each server. For more information about configuring the application 
server see “Configuring the Application Server” Chapter of the HP 
OpenView Service Desk: Installation Guide.

Service Desk application servers will only recognize others where 
Multiple servers check box on the General tab of the Configuration 
Editor is selected. If multiple servers have been installed, this 
parameter should not be changed as this will create problems. 

Firewalls with port-mapping do not work with multiple servers. If you 
use a firewall with port-mapping, you must use a stand-alone application 
server and clear the Multiple servers check box on the General tab of 
the Configuration Editor.

NOTE The only time you must clear the Multiple servers check box is when 
you are using a stand-alone application server with a firewall that uses 
port-mapping.
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Starting Multiple Servers

In a multiple server environment, when a client connects to an 
application server, a list of all application servers that are currently 
running is sent to the client and stored in the file srv.dat in the user 
profile. When the application server that the client is connected to fails, 
the next server on the list takes over. 

However, if, at the moment the client connects to the application server, 
there is only one server running, and afterwards more servers are 
started, the client will not know about the other servers. Thus, if the 
clients’ server fails, no take-over will take place. This happen because 
the list is only sent to the client when it first connects at the start of a 
session. It is therefore recommended to start all your Service Desk 
application servers in the multiple server environment before clients 
start to connect.

When this happens, the client can be "manually" connected to another 
application server by changing the hp OpenView service desk Server 
name field in the account properties dialog box.

Service Desk Port Allocation

Communication between servers and client computers takes place via 
TCP/IP ports.

The Service Desk application server listens by default on port 30999 for 
incoming connections from Service Desk clients. The port number can be 
changed by modifying the ITP port value in the server configuration file 
server_settings.xml. If the port specified does not match the default 
30999, then all clients will need to specify the correct port number when 
they connect to the application server.

To change the port number used by clients:

1. From the Start menu on the client, select Program Files and then hp 
OpenView service desk 4.5.

2. Select client and then client accounts. The hp OpenView service desk 
Accounts dialog box is displayed.

3. Select the Service Desk account being used by the client and click 
Modify. The account Properties dialog box is displayed.
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4. In the hp OpenView Service Desk Server name field add the port 
number after a colon. For example, myappserver:12345, where 12345 
is the new port number.

The Service Desk application server listens by default on port 30980 for 
incoming HTTP Post requests from the SD_event program. The port 
number can be changed by modifying the HTTP port value in the server 
configuration file server_settings.xml. If you change the default port 
number, SD_event needs to be told to use the new value. SD_event can 
use another port number by specifying the port number on the command 
line with the -p flag or by specifying a port entry in the SD_event 
configuration file.

The application server uses by default port 25 for SMTP connections. 
The port number can be changed by modifying the value in the server 
configuration file server_settings.xml.

The client listens by default on ports 30999-31019 for incoming requests 
from the application server. 

The Service Desk Agent listens by default on port number 50998 for 
incoming requests from the Service Desk application server. The value of 
this port number cannot be changed. Communication between Service 
desk application servers and the database server also takes place via 
TCP/IP ports. If an Oracle database is used then the protocol is Oracle 
Net. Oracle Net uses port 1521. If a Microsoft SQL Server database is 
used the protocol is Tabular Data Stream. Tabular Data Stream uses 
port 1433. When running in a firewall environment, all network traffic 
destined for port numbers listed above must be able to pass the firewall.

Stopping Servers not Allocated Default Port

If you have multiple servers running, or an application server running, 
on a port other than the default port (30999), sd_servermanager should 
be used to select and stop the server(s).
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Multiple Server Instances
Multiple instances of the Service Desk application server can be run on 
one machine, providing it has sufficient capacity. These server instances 
can be started by creating copies of the server configuration file 
server_settings.xml and starting separate instances of the 
application server using the different settings files. This can be achieved 
by running the start server batch file multiple times from the command 
line.

NOTE The ITP default port number must also be changed when creating a 
configuration profile for a new instance. 

Like multiple servers on different machines, you may want to use 
multiple instances for dedicated purposes. 

Starting Multiple Instances on Windows NT or 2000

This procedure assumes you have installed and configured a Service 
Desk application server on the computer where you want to run multiple 
instances.

To run multiple instances:

1. Make a copy of the \server\server_settings.xml file of the 
installed server and place it in a different folder.

2. Run the server settings editor, this will open the original 
server_settings.xml for editing. 

3. Use the editor to create a configuration profile for the new instance 
that you want to run. Click OK to save the modifications.

NOTE Use a text editor to edit the xml file, if you want to add specific 
modifications that are not available in the server settings editor. 

4. Navigate to the server folder and rename the 
server_settings.xml file to identify it. 
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5. Using the command prompt in the server\bin folder, run this 
command: sd_server.bat start “/settings=<new name.xml>”.

6. Repeat this process for any extra server instances you require.

7. Copy the unedited server_settings.xml back to its original 
location.

Installing Instances as Windows Services

To install instances as Windows services:

1. Make a copy of the server\server_settings.xml of the installed 
server and place it in a different folder.

2. Run the server settings editor, this will open the original 
server_settings.xml for editing. 

3. Use the editor to create a configuration profile for the new instance 
that you want to run. Click OK to save the modifications.

NOTE Use a text editor to edit the xml file if you want to add specific 
modifications that are not available in the server settings editor. 

4. Navigate to the server folder and rename server_settings.xml to 
identify the file.

5. Copy the unedited server_settings.xml back to its original 
location.

6. Make a copy of the server\bin\installservice.bat of the 
installed server and place it in a different folder.

7. Edit the file installservice.bat and change the service name to 
the name you want to give the server instance.

8. Add “/settings=<new name.xml>” at the end of the -start 
argument. Save the file, and give the file a new name.

9. Install the service using the new version of 
<new installservice>.bat.

10. Repeat this process for any extra server instance services you 
require.

11. Copy the unedited installservice.bat back to it original location.
  Chapter 7176



Multiple Servers
Multiple Server Instances
Starting Multiple Instances on UNIX  Platforms

This procedure applies to all supported UNIX platforms, and assumes 
you have installed and configured a Service Desk application server on 
the computer where you want to run multiple instances.

To run multiple instances:

1. Make a copy of the server/server_settings.xml of the installed 
server and place it in a different folder.

2. Run the server settings editor: this will open the original 
server_settings.xml for editing. 

3. Use the editor to create a configuration profile for the new instance 
that you want to run. Click OK to save the modifications.

NOTE Use a text editor to edit the xml file if you want to add specific 
modifications that are not available in the server settings editor. 

4. Navigate to the server folder and rename server_settings.xml to 
identify the file. 

5. Using the command prompt in the server/bin folder, start a server 
instance with this command: cd /opt/OV/sd/server/bin; 
./sd_server start “/settings=<new name.xml>”.

6. Repeat this process for any extra server instances you require.

7. Copy the unedited server_settings.xml back to its original 
location.

Starting Server Instances on UNIX at Start-up

If you want the server instances to start when the UNIX server is 
started, you should add the lines for the command prompt to the 
inittab. If you are running the database on the same machine as the 
Service Desk application server instances, you are advised to let the 
database processes start first. For more information about adding 
entries to the inittab, consult the documentation for your UNIX 
system.
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8 Multiple Sessions

Service Desk allows more than one Service Desk client (with the same 
version number) to be run on the same machine, at the same time.
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Using Multiple Sessions
Use multiple sessions when you want to have multiple client 
installations of the same version of Service Desk connecting to different 
application servers with different databases. This need could arise when 
you have different application servers (and databases) for testing, 
development, and production (live system), or multiple production 
environments.

Do not use multiple sessions for different users on the same machine; 
this should be done by setting up proper profiles for each user within the 
operating system.

Defining Multiple Session Parameters

To use multiple sessions, the cache, account details, and user definable 
information must be separated and stored locally on the client machine. 
This is done by setting up /PROFILE and /USERFOLDER parameters that 
are read when Service Desk is started. 

Multiple sessions are created using shortcuts. To set up multi-session 
shortcuts on Windows NT4:

1. Right-click on the desktop and select New from the popup menu and 
then Shortcut from the submenu. The Create Shortcut wizard is 
started.

2. In the Command line field type:
C:\WINNT\wjview.exe com.hp.ifc.ui.AppConsole 
/PROFILE=clientAS1 /USERFOLDER=”C:\Program Files\Hewlett 
Packard\OpenView\Service Desk 4.5\Client\clientAS1”

You can replace the term clientAS1 with anything you like; however 
it must be the same in both places:
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Figure 8-1 Shortcut Wizard Command Line dialog box

NOTE The path parameters depend on where wjview.exe and the Service 
Desk folder are located on the machine. On Windows 2000 
wjview.exe should be found in the System32 folder and on Windows 
98 in the Windows folder. 

3. Click Next and enter a name for the shortcut, for example: Service 
Desk Client AS1. Then click Finish:
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Figure 8-2 Shortcut Wizard Shortcut Name

Once you have created the shortcut, the instance of the client software 
that is started by it still has to be connected to an application server and 
database. This must be repeated for each client shortcut you create:

1. When you use the shortcut for the first time, the Connection Wizard 
is started. You will be prompted for the application server name (for 
example, Application Server 1). Click Next.
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Figure 8-3 Connection Wizard Server Name dialog box

2. Enter the Account Name and Password for the application server 
that the client should connect to. Click Next:
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Figure 8-4 Connection Wizard Account Name dialog box

3. Enter a Friendly Name for the application server account name:
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Figure 8-5 Connection Wizard Friendly Name dialog box

4. Click Next and then Finish. The Client shortcut will now connect to 
the application server with the specified account name.

When the client is running you will be able to identify each multi-session 
client you are using by the title bar and the task bar of the application 
window. This will show the /PROFILE parameter value, for example: 
clientAS1.

Service Desk Accounts

For each Client shortcut you create you will also need to create an 
Application Server Account shortcut. This will enable you to add, modify, 
view, or remove the account associated with the Client shortcut.

To create an Application Server Accounts shortcut, follow the 
instructions for creating a Client shortcut in the previous section, but 
modify the command line path to:

C:\WINNT\wjview.exe 
com.hp.ifc.ui.options.AppServerAccountsDialog 
/PROFILE=clientAS1 /USERFOLDER=”C:\Program Files\Hewlett 
Packard\OpenView\Service Desk 4.5\Client\clientAS1”
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Logically you should name this shortcut to relate it to the Client 
shortcut, particularly if you are going to have a number of shortcuts. As 
with the Client, the dialog boxes started from this shortcut will display 
the value from the /PROFILE parameter in the title bar (for example, 
clientAS1).
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9 Reporting

This chapter describes how you can create database views and a data 
dictionary for use with your third-party reporting tool. Using the 
information provided in this chapter, you can create reports based on 
your Service Desk database entries. 
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Reporting is about the status of things, whether it is about the status of 
services or of the IT-infrastructure. A report can show the current status 
and possibly whether the status is improving or deteriorating.

A report can be comprised of a simple printout of a service call which can 
be useful as a reference. Value would be added to a report by combining 
the information from a number of separate items. This would give the 
reader a complete overview of the current situation. 

To be able to offer the reader a report that presents the information in 
such a manner that it offers a complete overview suitable for analysis it 
might be necessary to use a third-party reporting tool.

Overview of Reporting Tools

Your Service Desk database provides the information used as a basis for 
your reporting tool. Your reporting tool, such as BusinessObjects, Crystal 
Reports, Microsoft Access, or Microsoft Excel, can access the information 
stored in Service Desk when you create database views and a data 
dictionary. If you are using Oracle for your Service Desk database, your 
reporting tool can view Service Desk entries using the ODBC or 
SQL*Net . If you are using SQL Server, your reporting tool can view the 
Service Desk entries using the ODBC. Using queries defined in your 
Service Desk database views, you provide a view into your database 
which can be imported by your reporting tool to create professional 
reports, as shown in Figure 9-1.
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Figure 9-1 Reporting Process
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Service Desk 4.5 supplies two main reporting capabilities. 

• The main Service Desk user console offers tables, charts, cards and 
explorer views you can use to create online overviews of data. 

• The database contains reporting views you can use to create reports 
using an external reporting tool.

The reporting views offer all information in the database in a readable 
format. The tables Service Desk supplies are optimized for operational 
use and are hard to read from outside Service Desk. The reporting views 
collect the information from the operational tables and put that 
information together in a readable report format.

Single Reporting View Reports

You can use the reporting views directly from the operational database if 
you create reports that show the information from a single reporting 
view. Single reporting view reports can give you useful overviews of 
items. The count of items and application of simple functions such as the 
calculation of the sum or average of things can enhance the report.

Advantages

• Simple.

• Good performance with basic reports.

• Always up-to-date data.

Disadvantages

• Limited by the contents of the view.

• May influence Service Desk performance, influence depends on size 
of source tables.

The single reporting view reports supply the same kind of reports as 
those possible from the user console. External reporting tools supply 
better functionality to present reports on paper because you can control 
the layout of the report with much more detail than you can in the 
  Chapter 9190



Reporting
Performance Considerations
Service Desk user console. You can use the external reporting tool, for 
example, to integrate Service Desk information in presentations and 
reports you supply to your customers that need high quality layout.

The single reporting view report is limited by the reporting view’s 
contents. Reporting views only contain the information of one item, 
extended with basic information from related items. The views do not 
contain references to lists of items. For example, the service call view 
contains the name and search code of referred configuration items. 
However, the service call view does not contain the list of work orders 
related to that service call.

Using Reporting Views with Subreports

To create a report of service calls containing a list of related work orders 
based on reporting views, you need to use subreports. Not all reporting 
tools can create reports with subreports, Crystal Reports is an example 
of a reporting tool that has very flexible functionality to create 
subreports. 

Advantages

• Moderately complex, requires knowledge of creating subreports.

• Reasonable performance for moderately complex reports.

• Always up-to-date data.

Disadvantages

• Usage depends on reporting tool.

• Limited by contents of views.

• May influence Service Desk performance.

Subreports can be used as a work-around for poor performance of joined 
views. 

Copying Reporting Views to Tables

The poor performance of joined reporting views is not related to the 
information in the reports, it is limited to the reporting views. In 
reporting views, the information is collected from operational source 
tables by resolving a query. Resolving the query is normally quick, but 
when two views are joined the resolution time is multiplied 
exponentially. Joining tables does not have this drawback because the 
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information in a table does not have to be collected from source tables. 
By copying the contents of the views to tables, you consolidate the 
information and reports based on those tables should perform 
excellently.

Advantages

• Moderately complex, depending on the use of subreports and the 
target location of the copied table.

• Good performance with complex reports.

• Minimal influence on operational use of Service Desk.

• Contents can be copied to other database.

Disadvantages

• Copy task must be scheduled, this determines timeliness of data.

• Copy task requires coordination between report user and database 
administrator.

If you want to create reports that are beyond the limitations of a single 
reporting view report or you have a reporting tool that does not support 
subreports, you may prefer to copy the contents of the views you required 
to a table, the advantages being:

• Tables do not use time to collect information. In general reports 
based on tables have improved performance compared to reports 
based on views.

• You can use standardized names for your target tables. This can be 
useful when exchanging reports between different Service Desk 
implementations.

• The reporting views are in the operational database, when copying, 
you can copy the information in the reporting views to another 
database, this way you can supply an extra layer of security.

To prevent interference with operational use of Service Desk, it may be 
necessary to copy the contents of the reporting views at a moment that 
there is less use of Service Desk. For example, the copying action could 
be scheduled to perform once a day at midnight, but this would result in 
the copied information probably not being up-to-date to the minute. 

How you copy information depends on your database, and where you 
want to copy the information to. Refer to your database manual to find 
how to copy the report view information to a table.
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Data Warehousing

The use of data warehousing tools extends the possibilities for reporting 
considerably. Data warehousing means you copy information from an 
operational database to a reporting database. When copying the 
information you have the possibility to transform the information in 
order to optimize it for reporting. Data warehouses optimize the data for 
retrieval flexibility, standard reporting tasks, and performance of 
reports.

Advantages

• Eventually simple for reporting tool user, requires extra training.

• Excellent performance, both for reporting and Service Desk.

Disadvantages

• Highly complex implementation.

• Requires data warehouse tools.

Although implementing the data warehouse is complex it has the 
following advantages for reporting:

• Performance of reporting. The data is optimized for reporting, so 
most reports will have good performance no matter the size of the 
data warehousing database.

• Performance of Service Desk. The performance of Service Desk is not 
compromised as the information is copied away from the operational 
database. 

• Flexibility of reporting. Data warehouses allow flexible creation of 
reports.

• Best way to customized reporting information to your organization. 
The steps required for data warehousing includes the transformation 
to your organization’s reporting needs.

Using Operational Tables for Reporting

Tables do not have the same performance issues as reporting views have 
so you can use the operational tables directly and avoid copying the 
reporting views. 

Advantages
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• Good performance.

• Always up-to-date data.

Disadvantages

• Complex when creating reports.

• Could require ERD scheme generation tool, depending on database 
knowledge of report developer.

• Could influence operational database performance.

If you have a tool available that can read databases and create ERD 
schemes from database views, you can use such a tool to show the 
relations between the tables that are the sources for a view.
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The first step in the reporting process is the generation of database 
views. Using database views, you can create a professional report, for 
example, by using the Crystal Report Wizard.

Service Desk gives you control over which parts of your database you can 
use. For this reason, you need to take additional steps to create the 
specific views into your database. Each view determines what 
information you want to form the basis of your report.

Database views are localized based on the language of your third-party 
reporting tool.

To generate database views:

1. In Service Desk, choose System from the Tools menu. The 
Administrator Console is displayed.

2. In the Administrator Console, select the System Panel icon.

3. Click the Report Settings icon. The Report Settings dialog box is 
displayed.
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Figure 9-2 Report Settings

4. Click (Re)generate database views for reporting.

5. Select a time zone in the (Re)generate Database Views for 
Reporting dialog box:

Figure 9-3 Selecting a Time Zone for Database Views

6. Click OK. A Warning dialog box is displayed:
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Figure 9-4 Warning Dialog Box

7. In the Warning dialog box, click Yes to continue generating database 
views.

8. Service Desk will generate the database views. 

9. Close the Report Settings dialog box by clicking OK or Apply.
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Generating a Data Dictionary
A data dictionary is a collection of descriptions of the data objects or 
items in the Service Desk database for the benefit of any users who need 
to refer to them. 

Each data object or item is given a descriptive name, its relationship is 
described, the type of data is described, possible predefined values are 
listed, and a brief textual description is provided. This collection can be 
organized for reference into a book. 

To generate a Data Dictionary:

1. In Service Desk, choose System from the Tools menu. The 
Administrator Console is displayed.

2. In the Administrator Console, double-click the System Panel icon.

3. Double-click the Report Settings icon. The Report Settings dialog 
box is displayed.

4. In the Report Settings dialog box, click the Generate Data 
Dictionary button. The Print Preview appears on your screen. 
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Figure 9-5 Print Preview of a Data Dictionary

5. You can choose to print or publish the Data Dictionary.

• Create a report in HTML format using your reporting tool by 
selecting Publish from the toolbar to save the Data Dictionary 
in HTML format; or

• Print your report using your reporting tool by selecting Print 
from the toolbar to print the Data Dictionary.
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Figure 9-6 Publishing a Data Dictionary in HTML Format

6. Click Close in the Data Dictionary Print Preview.

7. Click OK in the Report Settings dialog box.
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Viewing Database Reporting Tables
After you have generated the database views and created the data 
dictionary, you will need to access the database. Consult your database 
administrator for the user name and password to access the database 
tables. 

When viewing the database tables, you will note that all views created 
for reports have the prefix V_. 

NOTE In addition to operational data, repository data such as account 
information will be displayed in the database views. Although you 
cannot modify data using the database views, you will be able to view all 
repository information in the reporting tables. 

You can import the database views with the V_ prefix into your reporting 
tool.
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Gathering Reporting Data
To be able to gather service management reporting data and present it in 
tabulated form to the user, items must first be evaluated and the 
changed information stored.

Items can be evaluated in either one of two modes: batch mode or on-save 
mode. 

If batch mode is used the history lines of items are evaluated. The 
disadvantage of using batch-mode is that a lot of items are evaluated at 
one time causing the performance of the operational database to drop 
during that period. 

In on-save mode, the items are evaluated for changes as they are saved. 
This causes the action of saving a change to take slightly longer but it 
spreads any degradation of performance over normal operational time. 

Batch Mode

Under some circumstances batch mode processing is needed to generate 
the reporting data. For example, the first time that analyzed data is 
generated or when the updating of the reporting database failed. 

In batch mode, the reporting rule evaluates all items at a scheduled 
time. All relevant information is put in the database.

In batch mode, only the history lines are available to find the needed 
historic information. 

Information that is evaluated and stored using batch mode can only be 
guaranteed accurate at the time of the update.

On-save Mode

In on-save mode, the reporting rule evaluates all items that are being 
saved at that time.

Information that is evaluated and stored using on-save mode will have a 
greater accuracy than that saved in batch mode due to data being 
constantly analyzed between changes and the running of a batch save 
process.
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Using Database Views: Examples with 
Third-Party Reporting Tools
After creating your database views, you can use the views to create 
reports from your Service Desk database. Your third-party reporting tool 
accesses database tables to produce a report that you can edit and 
format, combining items such as data, charts, pictures and sound. 

Because third-party reporting tools use a visual layout approach, you can 
specify the data that you want to appear to edit and format reports. You 
can decide the report format, using drag and drop techniques to arrange 
data, graphics, charts and text. 

Creating Reports with Crystal Reports Designer

To create a new report based on Service Desk database views:

1. From the File menu, select New. The Report Gallery appears:
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Figure 9-7 Crystal Reports Gallery

2. Select any report. For our example, we will choose Standard. The 
form Report Expert will appear.

3. Click SQL/ODBC. The Log On Server dialog box appears: 
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Figure 9-8 Crystal Reports Log On Server Dialog Box

4. You must log on to the database where your Service Desk views were 
created. In our example, we are using HP OpenView Service Desk 4.5 
and we select ODBC HP OpenView Service Desk 4.5. The Choose 
SQL Table dialog box appears. 

5. In the Choose SQL Table dialog box, select all file types. Database 
view files will have the prefix V_. Double-click the database view 
files to be used in your report. 

6. The database views which will be included in your report will appear 
in the Report Expert Fields pane. When finished, click Done.

7. Click the Fields tab in the Report Expert dialog box.

8. In the Database Fields pane, double-click the fields from your 
views to be included on your report. The selected database fields will 
appear in the Report Fields pane. 

9. Click the Sort tab. Select a database view field to sort data. For 
additional information, please refer to Seagate Crystal Reports 
User’s Guide.

10. Click the Graph tab. Select a format for your report graph by clicking 
the Crystal Chart Type or selecting Custom Chart to create your 
own. For additional information, please refer to Seagate Crystal 
Reports User’s Guide.
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11. Click the Style tab. You can design a report by adding a company 
logo, or making other stylistic changes. For additional information, 
please refer to Seagate Crystal Reports User’s Guide. 

12. When finished, click Design Report. The report you have created 
with your Service Desk database views will be displayed. 

Adding Database Views to Existing Reports

Database views that you have generated can be added to existing 
reports. You can add Service Desk data to a financial report, for example. 
A report initially designed for financial information could import Service 
Desk database views and present IT infrastructure management 
statistics.

To add database views to an existing report:

1. Select Add Database to Report from the Database menu. The 
Choose SQL Table dialog box will appear.

2. Select the Service Desk database view files to include in your report. 
The database view files will have a V_ prefix.

3. The Visual Linking Expert will appear. Click OK. 

NOTE The Visual Linking Expert helps you link two or more database 
tables. For additional information on using the Visual Linking 
Expert, please refer to Seagate Crystal Reports User’s Guide. 
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Creating Reports with BusinessObjects 
Designer
BusinessObjects utilizes universes to display database data without 
requiring users to have technical knowledge of databases. Universes are 
a tool to provide information about data in understandable terms. 

Universes consist of classes and objects. For example, objects in a Service 
Desk database view could be configuration items, organizations, service 
calls, service call numbers, etc. By grouping objects together, you form 
classes. Classes group objects to form a general description. Each object 
links to data directly in your database view.

Universes provide the ability to query data to incorporate in your 
reports. When creating a query in BusinessObjects, you select objects 
from the universe and run a query on those objects.

To create a universe to access your database view:

1. Start BusinessObjects Report Designer. 

2. Select New from the File menu. The Universe Parameters dialog 
box appears:

Figure 9-9 BusinessObjects Universe Parameters dialog box

3. Enter a name for your universe in the Name field.
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4. You will need to provide your universe with access to Service Desk 
data. To do this, you will need to indicate the database and the type 
of network you are working with and set the parameters to access 
the database views stored in your Service Desk database. Create a 
new connection for your universe by clicking New. 

5. The Add a Connection dialog box will appear: 

Figure 9-10 BusinessObjects Add a Connection dialog box

6. Select the network driver for your Service Desk database. For our 
example, we will select ODBC Drivers. Click OK.

7. Enter a name for the connection in the Name field.

8. Select a database engine from the Database engine drop-down list:
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Figure 9-11 BusinessObjects ODBC Drivers dialog box

9. Select HP OpenView Service Desk 4.5 from the Data Source Name 
drop-down list. 

10. Enter a user’s name and password for the Service Desk database.

11. Click OK.

12. Select Tables from the Insert menu.

13. In the Table dialog box, click the database views you want to add to 
the universe structure. The database views will have the prefix V_. 

To add several database views, hold down the Control key while 
clicking each database view.

14. Click Insert. 

When you have finished designing your report, you can use your basic 
design to create professional reports. For additional information, refer to 
the BusinessObjects User’s Manual.
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Chart Views
Charts are powerful overviews of items. A chart groups items and 
displays the absolute or relative size of the groups in a variety of ways. 
The chart view allows you to use numerous different styles of charts in 
which to present your information. Some of the charts will also allow you 
to view them in 3D. With a chart view, you have an easy-to-read, 
on-screen report that is printable. 

Information that can be made available from charts is dependant on the 
filters and the settings of the x-axis, y-axis and series within the View 
settings dialog box. How to define these settings is detailed in Creating 
Chart Views.

The charts also provide easy access to items in the groups. This is done 
by clicking on a portion of the chart, this will display a table containing 
the items related to that portion, these items can then be selected to view 
more detailed information.

A chart groups items and shows the size of each group. The size of the 
group can mean different things, such as:

• the number of items in the group,

• the total of a summation of field values,

• the average value of a field in the group,

• the minimum of the maximum value of a field in the group. 
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Figure 9-12 Service Calls: Chart View

Creating Chart Views

To create a new chart view:

1. Select View, then Current View.

2. Select Define View, a dialog box appears.

3. Click Add, enter the View type and name in the dialog box.

4. Click OK to display the View Summary dialog box.

5. Select the General tab, from this form you have the options to:

• Drill to a view using the pull-down menu.

• Add a new view type by clicking Add, a popup dialog box is 
displayed.

• Change the appearance of the chart by clicking More to display 
the ChartFX dialog box.

6. Select the X-axis tab, from this form you can:

• Select a field by clicking Quick Find to the right of the field and 
select from the menu offered.
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• Depending on the serie selected the option to select a display 
format for the serie may be available from a pull-down menu. 

Only fields requiring numbers and dates will have a display 
format available.

7. Select the Y-axis tab, from this form you have options to:

• To select a field or a secondary field by clicking Quick Find and 
selecting the appropriate fields from the menus displayed.

• Set upper and lower limits to the y-axis by selecting the limits 
box and either entering the limits directly into the fields or use 
Quick Find to the right of the field to select the values required. 

If limits are not defined then they will take the value of the 
maximum and minimum values of the fields. 

8. Select the Series tab, from this form you can:

• Select a serie by clicking Quick Find to the right of the field and 
select from the menu offered.

• Depending on the serie selected the option to select a display 
format for the serie may be available from a pull-down menu. 

Only fields requiring numbers and dates will have a display 
format available.

9. Click OK and the new chart will appear in the table.

To view the result of your new chart Click Apply view.

NOTE You cannot use the series option and the secondary field option for the 
same chart.

Customizing Chart Views

Chart views can also be customized. Customization will allow, amongst 
other things, to change the appearance of the chart using ChartFX dialog 
box.

To customize a chart view:

1. Select View, then Current View.
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2. Select Customize current view, and then Other. A dialog box is 
displayed.

3.  Follow steps 5 to 8 of Creating Chart Views.

4. Click OK and the customization is complete.

Using Charts in Other Applications

With Service Desk, you can also copy the chart for use in another 
application, such as MS Word or Powerpoint. To do this:

1. Choose Copy from the Edit menu.

2. Switch to the application in which you wish to use the chart

3. Choose Paste from the other application’s Edit menu.
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10 Using E-mail with Service Desk

This chapter explains how you can configure an e-mail integration with 
Service Desk. The following sections explain the options available for 
e-mail messaging with Service Desk. Additional information is available 
in the Service Desk Online help.
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Example Scenario
The following is a hypothetical scenario of how e-mail messaging can be 
used with Service Desk:

1. A caller experiences a problem in the IT infrastructure and sends an 
e-mail message to Service Desk requesting service.

2. The e-mail message is received by Service Desk and a service call 
template is applied. The service call is completed based on 
information from the e-mail message and default values in the 
service call template. 

3. The service call is automatically dispatched to the specialist who was 
entered by default from the service call template.

4. The specialist fixes the problem, and sends an e-mail message to 
Service Desk to update the service call with the solution and changes 
the status field to Solved.

5. A database rule is triggered and the caller is notified of the solution 
and that the service call is solved.

6. The caller applies the solution, then sends an e-mail message to 
Service Desk to change the Service Call status to Closed.
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Sending E-mail Messages to Service Desk
E-mail sent to Service Desk is referred to as Inbound e-mail. Service 
Desk can accept e-mail messages from any standard SMTP based e-mail 
application. Information in the heading (From, To, cc, and Subject lines) 
determines what Service Desk does with the Inbound e-mail message. 
Information in the message body text is used to provide details for the 
action that is performed. 

The e-mail message must be written in plain text. Attachments are 
accepted. Inline attachments, for example a graphic inserted into the 
body of the message, are not. 

Inbound E-mail messaging makes it possible to:

• Create a service call.

• Change the status of a service call. 

• Update the solution field of a service call.

• Request and receive a list of open service calls reported by the caller 
or assigned to the requestor.

• View details of a service call.

• Add a history line to a service call. 

• Accept or reject the solution a specialist has entered for a service call. 

• Recall a service call.

• Ask for help.

Service Calls can be created and updated via inbound e-mail messaging. 
Other items, such as CIs, Persons and Changes cannot be created or 
updated via e-mail messaging.

NOTE For service calls to be created when an inbound e-mail message is 
received, and for that e-mail message to be saved as an attachment to the 
service call, the NT account that starts up the Service Desk service must 
have access rights to the server, where the e-mail attachments are 
stored. 
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The default start up account is the NT System account, either ensure 
that this account has access rights to the file server, or drive, or assign 
another account with the necessary rights as the start up account. Do 
this by selecting Services in the Control Panel. Then select the HP 
OpenView Service Desk service and click the Startup button. In the Log 
On As section of the dialog box change the account details.
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Receiving E-mail Messages from Service Desk
Service Desk can send e-mail messages to people when they are assigned 
a service call, problem, change, work order, or other item, this is called 
Outbound e-mail. The person must be registered with a valid e-mail 
address in Service Desk. 

Outbound E-mail messaging makes it possible to:

• Send notifications to the assignee, when a Service Desk item is 
assigned.

• Send a confirmation message to the caller when a service call is 
created for that caller.

• Send an e-mail message notifying the caller of entries, or changes to 
the status or solution field of a service call created by the caller.

The Rule Manager can also be used for sending e-mail messages based 
on events that occur in the Service Desk database. 

Information on how to use the Outbound E-mail integration after it is 
configured is available in the Online help.

E-mail Integration Using Rule Manager

For information on configuring the Rule Manager to send e-mail 
messages, See “Creating Send E-mail Message Actions” on page 119.
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Configuring the E-mail Integration
This section explains the options that are available to you for configuring 
Service Desk to send and receive e-mail. 

The primary configuration tasks are:

• Set the Activate the SMTP protocol check box and the Port 
number in the server settings editor (For Inbound e-mail).

• Enter e-mail addresses for Person items (Mandatory). 

• Select the option Send me e-mail when items are assigned to 
me in Service Desk. (Option to turn Inbound e-mail on or off at the 
client level)

• Enter General server settings in the System Administrator Console 
(Mandatory).

• Enter one or more Inbound E-mail Addresses for Service Desk in 
the System Administrator Console and link them to a service call 
template (Mandatory).

• Modify the default E-mail Commands in the System Administrator 
Console (optional).

• Modify the E-mail Templates used for Service Calls in the System 
Administrator Console (optional).

• Set your Access Filters in the System Administrator Console 
(optional).

• Define the E-mail Priority Mapping in the System Administrator 
Console (optional).

SMTP Settings

You will need to set the Activate the SMTP protocol check box and 
the Port number in the server settings editor, for Inbound e-mail. The 
other SMTP related configuration tasks can be performed in the Mail 
Properties dialog box in the System Administrators console.
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Activate Outbound E-mail Messaging 

Users who want to receive notifying e-mail messages from Service Desk 
when an item is assigned to them, or when an item needs their approval 
should select these options the Service Desk client application. This 
information is stored in the database by user account. System 
administrators can set this by default during installation. 

1. From the Tools menu, select Options and then the Advanced tab.

2. Place a check mark in the Send me e-mail when items are 
assigned to me check box, and the Send me e-mail if I need to 
approve an item check box:
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Figure 10-1 Advanced User Options

Entering E-mail Addresses

The Person item in Service Desk contains the E-mail field. Service Desk 
uses the e-mail field to send outbound e-mail to the person specified.

Service Desk can be used to send e-mail messages notifying external 
organizations and external persons when a service call is assigned to 
them, if they are registered in Service Desk as a member of a work 
group, or an external organization with a valid e-mail address.

You can set e-mail access filters to limit the addresses that Service Desk 
will accept Inbound e-mail messages from, see “Access Filter” on page  
237 for additional information.
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Entering General Settings for E-mail Messaging

You can perform the majority of configuration tasks for e-mail messaging 
in a series of tabbed pages located in the Administrator Console. From 
the Tools menu, select System. In the Administrator Console open the 
Service Desk System Panel and double-click the E-mail icon to open it:

Figure 10-2 E-mail Properties

The E-mail Properties dialog box will open. The first tabbed page is the 
General tab for entering information about your e-mail server:
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Figure 10-3 General tab

Complete the General tab page as follows:

1. Select the Use New Command As Default check box to create a new 
service call every time Service Desk receives an e-mail message with 
an undefined command in the subject field. For example, if you type 
Create Service Call instead of the New command, the result will 
still be a new service call. All unrecognized commands, will result in 
a new service call being created.

2. Select the E-mail Debug check box to add additional information to 
the log file when e-mail messaging errors occur. The application 
server log file is used for e-mail messaging.

3. Enter the complete name of your e-mail server in the E-mail Server 
field.

4. Enter your SMTP port. You will also need to set the Activate the 
SMTP protocol check box and the Port number in the server 
settings editor if you have not already done so. This is only required 
for Inbound e-mail.

5. In the From Address field, enter the return e-mail address. If you do 
not want this to appear create a From Alias. 
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NOTE Entering the address for your Service Desk application server in the 
From field or the Alias field is not recommended. Doing so may result 
in multiple unwanted e-mail messages and Service Calls being 
created.

6. In the From Alias field you can enter an alternate name that you 
want people to see when they receive e-mail messages from Service 
Desk. The Alias name will overwrite the From Address.

7. Use the Reply To field to enter the e-mail address you want people 
to use when replying to messages from Service Desk. 

8. In the Character Set field, enter the character set that the e-mail 
recipient uses. The default is US-ASCII. If sending e-mail in other 
than US-ASCII format you may need to use the encoding option and 
you will need to use one of the character sets supported by Service 
Desk. Service Desk supports all character sets which are listed and 
implemented by Sun. More information can be found on the Sun Web 
site at: http://java.sun.com/j2se/1.3/docs/guide/intl/encoding.doc.html

If your database or operating system does not support the character 
set used, the item you were creating or modifying may be corrupted. 
For example, a message sent using a Japanese character set will not 
appear correctly on a machine using an English Windows NT 
operating system. If the character set you use is not on the list, we 
recommend you use UTF-8.

Refer to Table 10-1, “Commonly used character set names,” on 
page 226 for examples of what can be entered in the character set 
filed. Note that these names are case sensitive and they are not 
definitive, you are free to enter other character set names if you 
wish.

9. The Use base 64 encoding option allows for customers to turn off 
message encryption and encoding. Encoding ensures the message is 
is not modified by servers or services between the sender and the 
receiver. BASE64 or Quoted printable encoding can be used. 

10. Click Send Test Mail to verify that the settings are correct by 
sending a test message.
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11. If you enter an account in the E-mail Address For Logging 
E-mail Messages field, all confirmation messages for handled 
messages will be Cc’d to that address. 

12. If you enter an account in the E-mail Address For Logging Wrong 
E-mail Messages field, all responding error messages sent from 
Service Desk will be Cc’d to the address specified. 

Table 10-1 Commonly used character set names

Character set name Description

Big5 Traditional Chinese

EUC-JP EUC encoding, Japanese

EUC-KR EUC encoding, Korean

GB2312 EUC encoding, Simplified Chinese

ISO-2022-JP Japanese (JIS X 0201 and JIS X 
0208)

ISO-2022-KR Korean

ISO-8859-1 Latin alphabet No. 1

ISO-8859-2 Latin alphabet No. 2

ISO-8859-3 Latin alphabet No. 3

ISO-8859-4 Latin alphabet No. 4

ISO-8859-5 Latin/Cyrillic alphabet

ISO-8859-6 Latin/Arabic alphabet

ISO-8859-7 Latin/Greek alphabet

ISO-8859-8 Latin/Hebrew alphabet

ISO-8859-9 Latin alphabet No. 5

KOI8-R Russian

Shift_JIS Japanese

US-ASCII American Standard Code for 
Information Interchange
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NOTE Additional information on encoding and MIME compliance is available 
on the Internet at:
http://www.faqs.org/rfcs/rfc1521.html and 
http://www.faqs.org/rfcs/rfc1522.html

Inbound E-mail Addresses

The Inbound E-Mail Addresses tab is used for entering one or more 
e-mail addresses for Service Desk. Each e-mail address entered can be 
linked to one Service Desk template for creating service calls:

UTF-7 Seven-bit Unicode Transformation 
Format

UTF-8 Eight-bit Unicode Transformation 
Format

windows-1250 Windows Eastern European

windows-1251 Windows Cyrillic 

windows-1253 Windows Greek

Table 10-1 Commonly used character set names (Continued)

Character set name Description
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Figure 10-4 Inbound E-mail Addresses tab

To add Inbound e-mail addresses and service call templates:

1. Click Add and enter the account name for the Service Desk e-mail 
address in the New-Inbound E-mail Address dialog box that will 
appear:

Figure 10-5 Inbound E-mail Address

2. Click the Quick Find icon next to the Service Call Template field 
to locate the template you want to use when the new service call 
command is received at this address. 

3. Click OK when done to save your work. Repeat steps 1 and 2 to add 
additional addresses and link them to service call templates.
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NOTE Service calls contain mandatory fields. Before linking a template to a 
Service Desk address, you will need to enter a default value for the 
mandatory fields in that template. Mandatory fields are marked in Bold 
text in the template. 

E-mail Commands

Commands are entered in the subject line of e-mail messages sent to 
Service Desk to tell Service Desk what action to perform. You can modify 
the options set for each command in the E-mail Command tab. You can 
set the access level for each command, specify if attachments are 
allowed, if a history line should be added in Service Desk, to send a 
confirmation message after a command is received and what template to 
use for the command.

Configuring E-mail Commands

Open the E-mail Commands tabbed page from the Mail Properties dialog 
box. The E-mail Commands tab shows the commands provided with the 
default settings:
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Figure 10-6 E-mail Command tab

To edit an inbound e-mail command:

1. Select the command you want to edit and click Modify. The E-mail 
Command dialog box will appear:
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Figure 10-7 E-mail-Command dialog box

2. In the Command field enter the command you want users to send to 
Service Desk. The Name field cannot be changed. For example, the 
New command could be called Service and inbound e-mail users 
would enter Service instead of New in the subject field of their 
e-mail message to create a service call.

3. Set the Access Level for each command by selecting one of the 
following options. These commands only apply to Inbound e-mail: 

• Unrestricted: all e-mail messages sent to a Service Desk 
address will be accepted. The Service Desk system administrator 
account will be used to provide access.

• Only existing persons: The name in the From field of the 
e-mail message must match a Person registered in the Service 
Desk database. The callers name and e-mail address will be 
entered. The system account will be used for access. More than 
one name in the From field or a name not recognized as a Person 
in the Service Desk database will result in an error message 
reply.

• Only existing Person with Account: The name in the From 
field of the e-mail message must match a persons that has an 
account in Service Desk. The name and account name will be 
entered in the service call. The roles and authorizations for that 
person’s account will be used, for example, authorization to 
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create service calls, or authorization to change the Status field 
when updating a service call. Only one name may be entered in 
the From field or an error will occur.

• Unavailable: Turns the command off, e-mail messages will not 
be accepted for the command.

4. You can set additional access restrictions for commands:

• Person does not have to be Caller or Assignee: Any 
person in Service Desk has access to the command, if they meet 
the Access Level requirements. This is the only option available 
for the New service call command.

• Person must be Caller: the name or e-mail address of the 
person who wants to update a service call must match the 
original service call. Service Desk will first look at the service call 
Caller field, if Service Desk cannot find a matching person then 
it will look for the e-mail address in the Information field.

• Person must be Assignee: the name or e-mail address of the 
person who wants to update a service call must be the person 
that the service call is currently assigned to. If the service call 
was assigned to a group the assignee can be any person from that 
group. 

If a service call is assigned to an external person, only that 
person can update the service call, not any member of the 
external organization.

• Person must be Caller or Assignee.

5. Select the Insert Attachments allowed check box if you want 
Service Desk to accept attachments for the command. 

6. Select the Add History Line check box if you want to add a history 
line when the command is executed. Enter the text you want the 
history line to start with in the Subject History Line field. For 
example, New service call from e-mail.

7. Enter the status you want new service calls and updates to receive in 
the Status field. If you do not select a status from the list, a status 
will not be entered when the command is executed unless a status is 
entered in the default template for the New service call command.

8. The E-mail Template field shows the e-mail template for reply 
messages that was assigned to the command in the E-mail Templates 
tabbed page. To change the template, go to the E-mail Templates tab.
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9. Select the Send Confirmation check box if you want Service Desk to 
send a confirmation message to the sender of the e-mail message.

10. Select the Send Attachments check box if you want Service Desk to 
be able to forward attachments. If a Service Call is created with an 
attachment and this option is selected Service Desk will forward the 
attachment.

The following table lists all commands available for inbound E-mail, the 
actions available with that command and the programmed response from 
Service Desk:

Table 10-2 Overview of Inbound E-mail Commands

Command Action System 
Response Remark

New A new service 
call is created 
using attribute 
values from 
e-mail message 
and template.

Send e-mail 
reply to the 
caller with the 
details of the 
service call.

Automatic 
system response 
is optional. The 
caller will be 
identified using 
the e-mail 
address of the 
sender.

Update<id> The service call 
specified will be 
updated based 
on the attribute 
values entered 
in the message.

Send e-mail 
reply to the 
sender with the 
details of the 
modified 
service call.

Automatic 
response is 
optional.

View<id> A history line 
can be added to 
the service call 
specified by the 
<id>

Send e-mail 
reply to the 
sender with the 
details of the 
service call 
specified.

Service call 
attachments can 
also be sent 
(optional).
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List None Send e-mail 
reply to sender 
with a list of all 
open calls from 
that sender.

Service calls 
announced by 
sender and 
service calls 
assigned to 
sender.

RE:RFI<id> A history line 
will be added to 
the specified 
service call. You 
can change the 
status to 
additional info 
received, for 
example.

Send e-mail 
reply to sender; 
“Information is 
received”.

Automatic 
system response 
is optional.

RE:Solution 
Accepted<id>

A history line 
can be added to 
the service call 
specified. 
Change the 
service call 
status to 
“solution 
accepted”, for 
example.

Send e-mail 
reply to the 
sender; 
“Service Call 
closed”

Automatic 
system response 
is optional.

RE:Solution 
Rejected<id>

A history line 
can be added to 
the service call 
specified by 
<id>. Change to 
service call 
status, for 
example 
“solution 
rejected”.

Send e-mail 
reply to sender 
“service call is 
not closed”.

Automatic 
system response 
is optional. 
Caller has not 
accepted the 
solution.

Table 10-2 Overview of Inbound E-mail Commands (Continued)

Command Action System 
Response Remark
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E-mail Templates

E-mail templates exist for the reply message sent in response to 
commands sent via an e-mail message to Service Desk. The templates 
contain standard text and possibly some variable fields, for example the 
help text that is received after sending an e-mail to Service Desk with 
the Help command, or the confirmation message that will be sent when a 
new service call is created. You can edit the text in these templates to 
suit the needs of your company:

Recall<id> A history line 
can be added to 
the service call 
specified by 
<id>. Change to 
service call 
status, for 
example 
“recalled”.

Send e-mail 
reply to sender 
“service call 
recalled”.

Automatic 
system response 
is optional. 

Help None Send e-mail 
reply to sender 
with e-mail 
help text.

Help text is 
editable.

no 
recognizable 
command

None Send e-mail 
reply to sender 
with the 
original 
command and 
a failed 
message.

You can 
configure the 
integration to 
create a new 
service call for 
all e-mail 
messages that 
come in with an 
unrecognizable 
command.

Table 10-2 Overview of Inbound E-mail Commands (Continued)

Command Action System 
Response Remark
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Figure 10-8 E-mail Templates tab

To modify the templates that Service Desk uses for sending e-mail to 
customers:

1. Select the command and template you want to modify and click 
Modify.

2. In the E-mail Template dialog box that appears, edit the information 
that will be in the Subject line of the e-mail by: Changing the text 
and using the Field button to insert variable parameters in the 
Subject field:
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Figure 10-9 E-mail Template dialog box

3. Edit the Body text in the same manner by typing text that you want 
to remain constant and using the Field button to enter parameters 
for information that will vary. Click OK when finished to save your 
changes.

NOTE You may notice some reply templates contain [?], this is used to show a 
variable value that was hard-coded in the template. See “Using Inbound 
E-mail” on page 240 for an explanation of what it represents in each 
template.

Access Filter

The access filter can be used to create a list of addressees that Service 
Desk will accept e-mail messages from and a list of addressees that 
Service Desk will not accept e-mail messages from. The * symbol can be 
used as a wildcard at the start and at the end of an address entry. 

If no addresses are entered in the Access Filter tabbed page, Service 
Desk will allow all e-mail addresses.

If there is a conflict between an allowed address and a denied address, 
the allowed address will take precedence and the user will be given 
access. For example if Jane_Doe@hp.com is allowed and *@hp.com is 
denied, Jane Doe will be allowed access.
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Figure 10-10 Access Filter tab

To set the access filter:

1. Click Add to add an address, Modify to make changes or Remove to 
remove an address from the list.

2. Click OK to save your data and close the dialog box, or Apply to save 
and continue working in this dialog box.

E-mail Priority Mapping

Incoming e-mail messages often have an importance level assigned to 
them in the external e-mail program by the sender. The importance level 
in the e-mail message represents the priority code in Service Desk that is 
assigned to that item. 

Select an importance level and click Modify to change the default 
mapping:
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Figure 10-11 E-mail Priority Mapping tab
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Using Inbound E-mail 
The following sections explain how the commands work. The e-mail 
message must be written in plain text. Attachments are accepted. Inline 
attachments, for example graphics inserted into the body of the message, 
are not. If your e-mail program inserts footers, use the BEGIN and END 
tags to mark the message text.

After a command is sent, a confirmation message can be sent to notify 
the caller that the service call was created or that the creation failed. 
Confirmation messages are based on templates that can be modified in 
the E-mail Templates tabbed page, you will also need to select the Send 
Confirmation option for the command in the E-mail Command tabbed 
page. The message body of the confirmation message can be made of both 
fixed text, and keywords that will be substituted by service call specific 
information.

Using the New Command

When Service Desk receives the New command, a service call is created 
and the default values in the inbound e-mail template that is linked to 
that Service Desk e-mail address are copied into the new service call. 

To use this command:

1. Enter an e-mail address for Service Desk in the To field. Service call 
templates are linked to Service Desk addresses. A number of service 
call templates can be created and linked to multiple Service Desk 
e-mail addresses: 
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Figure 10-12 New Service Call E-mail Message

2. Use the e-mail account that you want Service Desk to use as the 
caller. Service Desk determines the caller for the service call by first 
trying to match the e-mail address in the From field with an e-mail 
address of a Person item in the Service Desk database. If the person 
cannot be found in the database, or there are multiple person items, 
the service call will not be created and a message will be sent back to 
the sender stating the error.

3. Enter the New command in the Subject field of the e-mail message. 

4. Enter the service call description in the Subject field after the 
command. This text is copied to the Description field of the service 
call.

5. Enter additional information about the service call in the message 
body text. The text of the e-mail message body text will be copied to 
the Information field. If the text is too long it will be truncated and 
the complete message body text will be copied to an attachment. A 
comment will be inserted in the Information field: Warning: Text 
truncated, see attachment <file name> for complete e-mail 
text.

Some e-mail programs insert footer text or graphics automatically 
into e-mail messages when they are sent. The Inbound e-mail 
program does not recognize these elements and the e-mail message 
will be rejected. To prevent this problem, insert BEGIN at the start 
of your message text, and END at the end of your message. If you use 
only BEGIN, everything after that point will be used. If you use only 
END, all text before that point will be used.
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6. Additional information can be sent as an attachment if that option is 
allowed. The attachment option is set for each command in the 
E-mail commands tabbed page.

 

Using the Update<id> Command

The Update<id> command can be used to update service call 
information in a service call. All service call fields can be updated.

To use this command:

1. In the Subject line, enter the command Update followed by the 
service call ID, for example: Update 3124.

2. Enter the field you want to modify in the message body text followed 
by a colon or an equal sign (=), and the value. Each field must start 
on a new line. The field names and values used must match those 
used in the service call form:

Figure 10-13 E-mail Update<ID> Command Message

Using the Add History Line<id> Command

When Service Desk receives the Add History Line<id> command, the 
contents of the e-mail message body are copied to a new history line. If 
the text is too long, it will be truncated and the complete message body 
text will be put in an attachment and the following message inserted in 
the History line field: Warning: Text truncated, see attachment 
<file name> for complete e-mail text. 
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To use this command, enter the command Add History Line followed by 
the service call ID in the Subject line, for example: Add History Line 
3124

The [?] represents a hard coded variable, in this case the [?] will be 
replaced with information from the History line field.

Using the View <id> Command

When Service Desk receives the View <id> command, an e-mail message 
containing the details of the service call, specified by the ID in the 
command, will be sent to the requester.

To use this command, in the Subject line, enter the View command 
followed by the service call ID, for example: View 3124.

The default attribute fields will be filled in with information for that 
service call. 

Using the List Command

When Service Desk receives the List command, an e-mail message is 
sent to the requestor containing a list of all open service calls assigned to 
the caller and all open service calls announced by the caller. The service 
call ID and description is included. A service call is considered open 
when the Actual Finish field is empty. 

To use this command, enter the List command in the Subject field.

Using the RE:RFI<id> Command

The RE:RFI<id> command is used to add additional information to the 
history line of a service call. When Service Desk receives the RE:RFI<id> 
command, a history line will be added to the service call specified by the 
ID. The service call status is changed to the status that is defined for 
that command in the E-mail Commands tab, for example, Additional 
information received. 

To use this command, enter the RE:RFI <id> command in the Subject 
line, for example, RE:RFI 3222.

The [?] represents a hard coded variable, in this case the history line 
variable.
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Using the RE:Solution Accepted <id> Command

When Service Desk receives the RE: Solution Accepted <id> 
command, it will change the status of the service call to the status 
specified for that command, solution accepted, for example. The status 
for each command is set in the E-mail Commands tab.

To accept the solution to a service call, in the Subject line, enter the 
RE:Solution Accepted <id> command.

Using the RE:Solution Rejected <id> Command

When Service Desk receives the RE:Solution Rejected <id> 
command, it will change the status of the service call to the status 
specified for that command, solution rejected, for example. 

To reject the solution provided for a service call, enter RE:Solution 
Rejected in the Subject line.

Using the Recall<id> Command

The Recall <id> command is used to withdraw a service call. The 
service call will not be deleted from the Service Desk database. The 
status of the service call will be changed to the status specified for the 
command, Recalled, for example. 

To use this command, in the Subject line, enter the Recall <id> 
command. 

Using the Help Command

When Service Desk receives the Help command, an e-mail message will 
be sent to the person in the From field, containing a list of the commands 
available for use with Inbound e-mail and a short explanation for each. 
The help text can be edited by the system administrator. 

To use this command, enter the Help command in the Subject line.
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Troubleshooting E-mail Problems
This section is provided to assist you in identifying and solving errors in 
your Inbound or Outbound e-mail messaging. 

You may want to start your troubleshooting process by verifying the 
following requirements are met:

• E-mail client is MIME compliant, see “Finding More Information” on 
page 248.

• Database, operating system, and Service Desk server, all support the 
character set used. 

NOTE Service Desk supports all character sets which are listed and 
implemented by Sun. If you are in doubt, use UTF-8. For more 
information please refer to the Sun Web site at: 
http://java.sun.com/j2se/1.3/docs/guide/intl/encoding.doc.html

Identifying Errors

When an error occurs because a command cannot be processed correctly 
by Service Desk, a Command not recognized message or a Mail Error 
message is normally created. A Mail Error message is generated when 
the e-mail command is not executed. A Command Not Recognized 
message will be sent when the command is partially executed. An e-mail 
message is sent to the person who sent the e-mail command. The e-mail 
message that caused the error will be sent to the E-mail address for 
Wrong e-mail.

Other errors may occur that are not directly related to the Service Desk 
e-mail program, or the commands used, for example differences in the 
supported character set.
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The following table lists the possible cause of a variety of errors in your 
Inbound or Outbound e-mail messaging:

Table 10-3 E-mail Errors

Symptom Cause Solution

Items created or 
modified by Inbound 
e-mail are corrupted. 
For example a new 
Service Call is corrupt.

Database doesn’t 
support the 
character set used.

Use a character set 
supported by Service 
Desk and your 
database. 

E-mail sent by Service 
Desk appears garbled 
or malformed on the 
Client machine.

Client machine 
does not support 
encoding.

Turn off the encoding 
option in the General 
Settings dialog box and 
ensure the client 
platform is MIME 
compliant and 
supports the character 
set used. For example, 
Japanese character set 
may be readable if 
used on English 
operating system.

Inbound e-mail results 
in malformed or 
truncated characters 
in Service Desk. 
Characters appear as 
“?”

Unsupported 
character set was 
used.

Use a supported 
character set and if 
using a character set 
other than US-ASCII, 
use the encoding 
option. 

Service call is not 
created.

Caller could not be 
determined for 
new service call 
creation.

Verify the Caller is a 
person in Service Desk 
and include an e-mail 
address. Check the 
Access Level set for the 
command.
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Error messages, sent from the Outbound e-mail program, can be 
modified from the e-mail templates tab. See “E-mail Templates” on 
page 235 for more information.

Service call is not 
changed.

 No authorization 
for updating a 
service call. 
Includes the 
following 
commands:
Update<ID>
RE:RFI<ID>
Recall<ID>
RE:Solution<ID>

Change the 
authorizations for the 
person in Service Desk.

Nothing happens No authorization 
for viewing service 
call data. Includes 
the following 
commands:Update
<ID>
View<ID>

Change the 
authorizations for the 
person in Service Desk.

Nothing happens Command not 
recognized

Use the correct 
command syntax.

Service Desk rejects 
the Inbound e-mail

Message syntax 
not recognized 
because the e-mail 
program inserted 
additional text or 
graphics when the 
message was sent 
to Service Desk

 The Inbound e-mail 
program does not 
recognize footers and 
graphics and the 
e-mail message will be 
rejected. To prevent 
this problem, insert 
BEGIN at the start of 
the message text, and 
END at the end of the 
message. 

Table 10-3 E-mail Errors (Continued)

Symptom Cause Solution
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Finding More Information

Additional information which may be useful in troubleshooting problems 
with your E-mail integration with Service Desk can be found on the 
Internet at:
http://www.faqs.org/rfcs/rfc1521.html and 
http://www.faqs.org/rfcs/rfc1522.html
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11 Archiving

This chapter explains how to archive Service Desk items.
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When information is archived, it is copied to a predetermined archive 
location, and is then deleted from the production database. The archived 
information is stored in XML format.

CAUTION Archiving should not be used as a backup solution. Once information has 
been archived, it cannot be restored. For details of system backups, see 
“System Backup” on page  286.

Although the data exchange mechanism also exports and imports data in 
XML format, there is no connection between archiving and data 
exchange. Data exchange uses the common information model (CIM) 
XML data definition, whereas archiving uses one of two user-selectable 
XML formats: abstract or Service Desk-specific.

Structure of Archived Information

You can choose between two different XML structures when archiving. 
The relative merits of each variant is described below.

Service Desk-Specific XML Structure

The DTD of the Service Desk-specific XML structure is based on the 
Service Desk object model. The types of XML elements are the entities or 
item types in the Service Desk object model. The attributes of the 
individual XML elements correspond to the values of the attributes in 
the individual Service Desk objects they represent. 

Abstract XML Structure

The DTD of the abstract XML structure is based on a generalized 
information model, where the XML elements reflect the abstract 
concepts of objects and their attributes. Reference is made to the Service 
Desk object model by identifying the relevant Service Desk entities or 
item types within the properties of the individual XML elements.
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The advantage of the abstract XML variant is that the DTD does not 
depend on the details of a particular Service Desk implementation. This 
makes it very versatile. The disadvantage of the abstract variant is that 
for a particular implementation of Service Desk, programmers who 
transform XML to another format such as HTML need to fill in the 
actual details of the Service Desk implementation without any help from 
the structure of the XML.

Specifying Archiving Settings

You specify the information to be archived by defining views for each 
item type. Work orders, changes, projects, problems, service calls and 
incidents can all be archived. A separate XML file is created for each 
type of item. New XML files are created each time archiving is 
performed. The following figure shows the Views tab of the Archive 
Settings dialog box in which the archiving views and other archiving 
settings are specified:
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Figure 11-1 Archive Settings Dialog Box: Views Tab

The filters you apply to each view determine the records that are 
archived. The fields you include in the view determine the simple 
attributes that are archived with each record. You can also choose to 
archive attachments and certain entity sets (that is, attributes that hold 
their values in lists), including history lines and service event relations.

You can choose between the default (Service Desk-specific) XML 
structure and an abstract XML structure. If you intend to transform 
archive files from XML format to another format such as HTML, 
programmers may prefer to use the abstract format as a basis. See 
“Structure of Archived Information” on page  250 for a comparison of the 
two structures.

You can choose to generate a document type definition (DTD) file for each 
archive file. The DTD file can be used to simplify the transformation 
process from XML to another format such as HTML.

Archive file name and location settings are specified and displayed on 
the Location tab of the Archive Settings dialog box:
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Figure 11-2 Archive Settings Dialog Box: Location Tab

By default, information is archived to a location on the Service Desk 
client in the Archive folder below the data folder, as specified in the 
client account settings. This location is displayed in the read-only 
Archive Location field. You can specify an alternative location by 
supplying command-line overrides. (See “Initiating the Archiving 
Process” on page 254.)

Other options on the Location tab of the Archive Settings dialog box 
control the organization and naming of archive files:

• Select the Use Sub Folder for Each Item check box if you want 
the archive files for each item type to be stored in separate 
sub-folders below the archive directory. Alternatively, clear the Use 
Sub Folder for Each Item check box if you want all archive files to 
be stored together in the archive directory. 

• You can specify a prefix of up to three characters to help identify the 
archive files.
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• To ensure that archive file names are unique, you can include an 
index number as a suffix to the archive file name. The number is 
incremented each time an archive process is performed. 
Alternatively, you can include the archiving date as a suffix to the 
archive file name. You can include the archiving time as well as the 
date. Including the time is useful if archiving is performed more than 
once on the same day.

Before initiating the archiving process, you should also decide on the 
time zone to be used for archiving dates and times. (See “Time Zone for 
Archived Dates and Times” on page 263.)

Initiating the Archiving Process

After specifying the archive settings, you can start archiving 
immediately by clicking the Start Archiving Now button in the Archive 
Settings dialog box. Alternatively, you can initiate archiving from the 
command line, which enables you to schedule archiving and to override 
certain archive settings, as described below. 

If you schedule archiving, Service Desk uses the account settings of the 
default user as specified in the user settings on the Service Desk server 
(if archiving on the Service Desk server) or in the user settings on the 
Service Desk client (if archiving on the Service Desk client).

• The Client Account Settings program on the Service Desk server can 
be launched by executing one of the following files from the command 
line, depending on the platform the Service Desk server is installed 
on:  

• The Client Accounts program installed on the Service Desk client can 
be launched from the Start menu: point to Programs, then point to hp 
OpenView Service Desk 4.5, then point to Client, then click 
client accounts.

To schedule archiving on the Service Desk client:

Table 11-1 Running the Client Account Settings Program on the Server

Platform Executable Program

Microsoft Windows <install>\bin\sd_useraccounts.bat

HP-UX and Solaris <install>/bin/sd_useraccounts
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• Use the documented procedure supplied with the external scheduler.

When prompted to specify the name of the executable program to 
run, specify the sd_archive.bat file located in the bin directory 
below the client installation folder.

To schedule archiving on the Service Desk server:

• Use the documented procedure supplied with the external scheduler.

When prompted to specify the name of the executable program to 
run, specify one of the files shown in the following table, depending 
on the platform the Service Desk server is installed on:

In the above table, <install> is the installation directory for the Service 
Desk server.

By initiating archiving from the command line, you can override the 
archive settings shown in the following table:

Table 11-2 Archiving from the Command Line

Platform Executable Program

Microsoft Windows <install>\bin\sd_archive.bat

HP-UX and Solaris <install>/bin/sd_archive

Table 11-3 Overriding Archive Settings on the Command Line

Options (an option 
starts with "-" or "/" )

Explanation

usr=<username> Account name

pwd=<password> Account password

srv=<server>[:port] Server name (and optional port)

loc=<location> Archive location

abs=<yes|no> Use abstract XML format

dtd=<yes|no> Generate document type definition

rel=<yes|no> Archive service event relations

his=<yes|no> Archive history lines
Chapter 11  255



Archiving
Overview
NOTE The command line options are not encrypted. If security is an issue, 
specifying user account details on the command line is not recommended.

You may need to enclose certain command line options (both the 
parameter and its argument) in quotation marks, such as when the 
location path contains a directory name with spaces. For example, when 
archiving to the location "/home/archive files", the following syntax 
is recommended:

sd_archive -usr=admin -pwd=abcdefg -srv=sdserver1 
"-loc=/home/archive files"

To override the user account on the command line, you need to specify 
the account name, password, and server name (and optionally, the port 
number, if different from the default port), as in the following example: 

sd_archive -usr=admin -pwd=abcdefg -srv=sdserver1:30998 
-loc=/home/archive

If you supply a user account override on the command line, Service Desk 
applies the default time zone for the specified user. Ensure that the 
default time zone for the specified user is set to the required value. 

During the archiving process, all records of a particular item type are 
copied to the archive location before deletion begins. Items are archived 
in the order in which they are listed in the Archive Settings dialog box 
(see Figure 11-1 on page 252). That is, work orders are archived first (if 
selected for archiving), followed by change requests, and so on down to 
incidents. If an error occurs during copying (for example, the disk 
becomes full), the copying process terminates, and no records are deleted. 

att=<yes|no> Archive attachments

del=<yes|no> Delete records (‘yes’) or suppress deletion 
(‘no’) after they have been copied to the 
archive

Table 11-3 Overriding Archive Settings on the Command Line (Continued)

Options (an option 
starts with "-" or "/" )

Explanation
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By this time, Service Desk may already have created archive files for 
some item types. You can use the archive log file (see “Checking the Log 
File” on page  257) to identify records that were copied but not deleted.

Checking the Log File

After each archiving process is completed, Service Desk records the 
outcome in a log file, which is created in the archiving folder and named 
<date>_<time>.log, where date and time identify the moment the 
archiving process started. The log file can be viewed using any plain text 
editor.

The log file includes the following information:

• Date and time the archiving process was started and finished. 

• For each item type:

— Archive filter settings. 

— Number of items copied and removed. 

• For each individual item, the result of copying and the result of 
removing. 

If errors are reported, the reason for failure is shown. For example, if 
deletion failed due to an item having a relation that cannot be deleted, 
the log identifies the related item that caused the error. 

Viewing Archived Information

Archive files store information in XML format. To view an archive file, 
use any external XML browser. 

Object Identifiers (OIDs)

Archive files use object identifiers (OIDs) to refer to items. The OID 
identifies items uniquely. OIDs are also used in the context of 
attachments, which are archived using the same sub-directory structure 
as on the attachment server. (The structure includes the item type and 
object ID.)
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The use of object identifiers facilitates the development of automated 
search routines. Alternative methods of uniquely identifying items rely 
on combinations of properties, such as the item type combined with the 
functional identifier.

Archiving Attachments

When an item with attachments is archived, the attachments are deleted 
from the attachment server. However, if you choose to archive 
attachments when you specify archiving criteria, Service Desk handles 
the attachments as follows:

• Each attachment is copied to the archive folder using the same 
sub-directory structure as on the attachment server. (The structure 
includes the item type and object ID.) 

• The archive file includes a reference to the object ID of each 
attachment file. 

• The archive file includes a reference to the subdirectory structure 
pointing to the attachment. 

For example, consider a service call with an attachment file named 
details.txt. If the target folder specified in the attachment settings is 
/home/attach, and the service call has object ID 281478288048260, the 
attachment server stores the attachment with a numeric file name (such 
as 281478288048226) in the file 
/home/attach/Servicecall/281478288048260/281478288048226. 
When the service call is archived, the attachment is copied to the 
following file in the archive folder:

Attachments/Servicecall/281478288048260/details.txt
  Chapter 11258



Archiving
Establishing an Archiving Strategy
Establishing an Archiving Strategy
Before you specify archiving criteria and initiate archiving, it is 
advisable to plan an archiving strategy that is appropriate for your 
implementation of Service Desk. This section discusses some of the 
factors you may need to consider.

Archiving Performance

When archiving large amounts of data, it is advisable to schedule the 
archiving process to be performed during quiet periods, such as 
overnight. During a 60-hour period over a weekend, it should be possible 
to archive 175,000 records. 

Quantity of Information

Consider the rate at which records are created in Service Desk. Allow for 
variations due to cyclical or seasonal factors. In general, the more rapidly 
information is created, the more frequently it will need to be archived. 
The amount of disk space consumed by archive files also depends on how 
many attributes you choose to archive, and on the quantity of 
information that tends to be entered in fields. 

TIP Use a test database to experiment with different archiving criteria until 
you have gained a better idea of how much disk space your archive files 
will consume. Identify the most important attributes, and the ones 
responsible for consuming the most disk space. Try to differentiate 
between attributes that must be archived, and attributes that are 
expendable. The -del=no command line argument is useful when 
experimenting with different archiving criteria, because by suppressing 
the deletion of archived records, you do not need to create new records 
each time. See Table 11-3 on page 255 for a list of command line 
arguments.

If storage capacity is limited, consider compressing archives. This can 
reduce disk space consumption by 80% or more.
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Archiving Frequency

The more frequently you archive information, the smaller each archive 
file will be, but the number of individual archive files will accumulate 
more rapidly. This may cause difficulty when searching through archived 
information. 

Dependent Processes

Ensure that information is only archived when it is no longer required by 
other processes. Processes that require information to be retained longer 
than others include the following:

• Service level management

Service level agreements may be active for several years, and each 
evaluation period may span six months or more. Only service calls 
and incidents that have remained closed and unchanged for a period 
no shorter than the evaluation period should be archived. Consider 
the timing of evaluation and archiving processes: arrange to start 
archiving after SLA evaluation is completed.

• Analyzed data

Analyzed data may be required for problem solving and process 
optimization. The archiving process removes analyzed data related 
to archived items, as well as the history lines on which the analyzed 
data is based. If you use analyzed data, it should be consolidated in 
reports or in reporting databases before the items are archived.

Company Policy and Legal Requirements

Ensure that your archiving policy is compatible with company policy. 
Consider official regulations and procedures governing the retention and 
deletion of information. There may be different policies for keeping items 
available for operational use in the database, for immediate reference, 
for indirect use, and for deletion.

Archiving Order

The Archive Settings dialog box lists item types in the order in which 
they are archived. To minimize the possibility that a record cannot be 
deleted because of a dependency (see “Records With Relations” on page  
261), it is advisable to avoid excluding items higher up the list when 
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including items lower down the list. For example, if you archive 
problems, it is advisable also to include change requests and work orders 
in the archiving process. 

For each type of item, Service Desk archives records according to their 
ID: highest ID first, lowest ID last. This minimizes the possibility that a 
record cannot be deleted because of a dependency (for example, a 
subcontract service call has a higher ID than the originating service 
call).

Records With Relations

When you specify archiving criteria for each type of item to be archived, 
avoid setting up a strategy that archives certain records but retains 
related records. Items hold useful information not only in their text 
fields, but also in their relations to other items. It is advisable to aim for 
an archiving strategy that archives all inter-related records in the same 
operation. This ensures that all references to related records are 
retained.

Items related to work orders

Consider the case of a change request related to a work order: 

• If you archive the change request but not the work order, the change 
request will be copied but not deleted. Service Desk will attempt to 
archive the change request the next time the archiving process runs, 
but the archiving process cannot delete the change request until the 
related work order is deleted or archived. This can result in an item 
being archived to more than one archive file. 

• If you archive the work order but not the change request, the work 
order will be copied and deleted successfully, and will contain a 
reference to the change request. The change request will remain in 
the Service Desk database, but all knowledge of its relation to the 
archived work order will be lost.

• If you archive the work order and the change request, both the work 
order and the change request will be copied and deleted successfully. 
The work order will contain a reference to the change request, but 
the change request will not contain a record to the work order. This is 
because by the time the change request is archived, the work order 
has already been copied and deleted (see “Archiving Order” on page  
260).
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Service calls and related subcontract service calls

Consider the case of a service call related to a subcontract service call: 

• If you archive the originating service call but not the subcontract 
service call, the originating service call will be copied but not deleted. 
Service Desk will attempt to archive the originating service call the 
next time the archiving process runs, but the archiving process 
cannot delete the originating service call until the related 
subcontract service call is deleted or archived. This can result in an 
item being archived to more than one archive file. 

• If you archive the subcontract service call but not the originating 
service call, the subcontract service call will be copied and deleted 
successfully, and will contain a reference to the originating service 
call. The originating service call will remain in the Service Desk 
database, but all knowledge of its relation to the archived 
subcontract service call will be lost.

• If you archive the subcontract service call and the originating service 
call, both service calls will be copied and deleted successfully. The 
subcontract service call will contain a reference to the originating 
service call, but the originating service call will not contain a 
reference to the subcontract service call. This is because by the time 
the originating service call is archived, the subcontract service call 
has already been copied and deleted (see “Archiving Order” on page  
260).

Items with service event relations

Consider the case of a change request that has a solved-by service event 
relation to a problem record:

• If you archive either one record without the other, the record 
identified to be archived will be copied and deleted successfully, and 
the archived record will contain a reference to the service event 
relation if you select this option. However, the record that is not 
archived will lose its relation to the archived record. 

• If you archive the change request and the problem, both records will 
be copied and deleted successfully. The change request will contain a 
reference to the problem if you select this option. However, the 
problem will not contain a reference to the change request. This is 
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because by the time the problem is archived, the change request has 
already been copied and deleted (see “Archiving Order” on page  
260).

Time Zone for Archived Dates and Times

To ensure that dates and times are always archived with respect to the 
same time zone, your archiving strategy needs to take into consideration 
the way Service Desk chooses the time zone, which depends on the way 
archiving is initiated: 

• If archiving is initiated from the Archive Settings dialog box, Service 
Desk uses the time zone currently displayed in the toolbar, which is 
the same as the user’s default time zone. 

• If archiving is initiated from the command line, Service Desk uses 
the default time zone of the default user. If a user account is specified 
as a command-line override, Service Desk uses the default time zone 
of the specified user.

Consistency

If required, you can change archiving settings, such as when new custom 
fields are introduced. However, to maximize the consistency of archived 
information, it is advisable to avoid changing the archiving settings as 
much as possible.
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12 Administrator Console Export 
Settings

This chapter describes the actions of exporting and importing 
configuration information.
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Overview
In the Administrator Console an entry is available: hp OpenView service 
desk/Data/ACES. ACES is an acronym for Administrator Console Export 
Settings and is used to allow the exchange of settings between instances 
of the same Service Desk version using the XML file export/import.

ACES comprises five items: ACES Views, Groups, Export and Import 
wizards and Settings. Access to the ACES settings dialog box is via the 
icon in the Administrator Console/System Panel. The following icons are 
used.

ACES Settings

The Aces settings dialog box is where the administrator can define the 
default locations where the export and import XML files and their 
associated log files are to be stored when using either the export or 
import wizards.

This dialog box is accessed via the Administrator console system panel.

Table 12-1 Icons

Icon Definition Location

ACES 
Settings

Administrator Console 
item (System panel)

ACES 
Views

Data/ACES

ACES 
Groups

Data/ACES
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Figure 12-1 Aces settings dialog box

ACES Views

ACES Views are used to capture (part of the) Administrator Console 
information. ACES Views can be inserted into a collective called an 
ACES Group.

Certain conditions within views have to be manipulated by the import 
filter in order for the importation to be successful. These conditions and 
the solutions are detailed in Table 12-3, “General import situations,” on 
page 277 and Table 12-4, “Specific import situations,” on page 278.

CAUTION It is not advisable to complete any other administrator tasks during the 
export or import process.
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To export specific Administrator Console items a view must first be 
created that selects these items. A view is based on a particular setting 
(for example; templates, forms or codes.) 

New Aces Views are created using the right mouse button (right-click) in 
the Aces View pane and selecting New Aces View from the shortcut 
menu, then completing the form that appears. 

Figure 12-2 New View form - ACES View

The selection of tab pages appear after the Name and the Item (via the 
button to the right of the Item box) have been completed.

More details on how to create an export view can be found in the online 
help.

Exporting associated relations

If there are items within an export view that have associated relations 
an Associations tab appears in the filter panel.
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Figure 12-3 Selecting associations

In order to export associated relations, these have to be selected 
manually within ACES views. See “Importing associated relations” on 
page 283.

ACES Group

ACES Groups is the collective for sets of related views. For example, an 
ACES Group called 'Change suite' could contain the export views 
'Change forms', 'Change templates' and all 'Change codes'. ACES groups 
are the selection criteria for the next stage, the ACES export wizard.

The purpose of grouping the export views in this way is to allow the 
export process to be structured to allow the reuse of the definitions.

NOTE It is possible to make a view of a group to enable the exportation of the 
ACES views in an XML file format.

A particular ACES view can be part of several ACES Groups. 
Chapter 12  269



Administrator Console Export Settings
Overview
New Aces Groups are created using the right mouse button (right-click) 
in the Aces Groups pane and selecting New Aces Group from the 
shortcut menu, then completing the form that appears. 

Figure 12-4 New Aces Group Form

NOTE The ordering of the ACES Views within an Aces Group is important for 
the export-import process. Items that have been referred to by other 
items should be imported first to avoid errors and loss of information.

ACES Group elements can be re-ordered (manually or automatically), 
related or unrelated using the appropriate buttons at the bottom of the 
ACES group form.

If the ACES group cannot detect any specific ordering requirements or 
the order is already optimal the Auto Arrange button will be grayed out.

NOTE It is not possible to delete the default forms.
  Chapter 12270



Administrator Console Export Settings
ACES Export-Import Wizards
ACES Export-Import Wizards
Two wizards are available in the Administrator Console to act as 
interfaces to fine-tune the export and import process of Service Desk 
configurations. 

NOTE When file names are defined during the export or import of XML files 
and the creation of log files; if they are to be located in the default 
settings as defined in the ACES Settings then only the filename will be 
shown, maximum 80 characters. If another folder is to be used as the 
location then the full path information is displayed and has a limit of 255 
characters.

The wizards are accessed from the File menu in the Administrator 
Console:

Figure 12-5 Starting a wizard
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Using the ACES Export Wizard

Introduction

The ACES Export wizard enables the service desk administrator to 
select a number of ACES groups and convert the data into files using a 
structured XML format. 

NOTE If you want to export items associated relations with any of the selected 
views these must have been manually selected. See “Exporting 
associated relations” on page 268.

Procedure

NOTE The XML file(s) created during this procedure must not be edited.

1. On the Tools menu, click System to open the Administrator console.

2. In the Administrator console click File, then Aces and select Aces 
Export Wizard.

3. On the first page of the Export Wizard click Next.

NOTE If Cancel is selected during the export process the entire wizard is 
cancelled. The XML file that has been created in this process must be 
deleted manually.
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Figure 12-6 Export wizard

4. Select the ACES Groups required for export.

Figure 12-7 Export file selection screen

a. Move the required ACES Groups to the right-hand window using 
the arrow button, any files that are not required for export must 
be moved to, or remain in, the left-hand window.
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b. Confirm or specify the name of the log file and the XML file to be 
generated and their locations. Ensure that the relevant 
extension is on the file name (.log or .xml) to prevent problems 
when opening or using the files. The browse button can be used 
to define the locations.

NOTE The predefined file names are given a unique date stamp that 
takes the form, prior to the relevant extension, of 
YYYYMMDD_HHMMSS.

c. Click Next.

5. Click Start export. The state of the export is indicated in the 
progress bar. During the export process you will be shown 
information regarding the status of the export. During the export 
process the Next and Back buttons are disabled. At the end of the 
export process you are automatically sent to the next page of the 
wizard. The elements on this screen are used to display the following 
information:

Table 12-2 Element definitions

Element Definition

Groups: Total Total number of groups to be exported

Groups: Exporting Group currently being exported

Groups: Completed Number of groups that have currently been 
exported

Views in Group: 
Total

Total number of views to be exported

Views in Group: 
Exporting

View currently being exported

Views in Group: 
Completed

Number of views that have currently been 
exported

Progress Progress bar for the view currently being 
exported
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Figure 12-8 Export wizard progress screen

6. Select whether you wish to view the Export log by pressing View log 
File, view a different log file by selecting Browse and then View Log 
File or select the option Close the Wizard or Restart the Wizard and 
then Finish.

Status There are three statuses that can be displayed: 
1) Querying; when information is being 
retrieved for extraction; 2) Extracting; 3) Ready; 
when the current view is ready.

Table 12-2 Element definitions (Continued)

Element Definition
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Figure 12-9 Export wizard completed
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Using the ACES Import Wizard

Introduction

The ACES Import wizard allows the service desk administrator to select 
the valid XML file containing the administrator settings in order to 
import them into the current service desk instance.

NOTE The service desk version indicated in the XML file must match that of 
the system into which it is being imported.

During the import several problems or situations may arise and it should 
be clear how the Wizard deals with them. Table 12-3, “General import 
situations,” on page 277 and Table 12-4, “Specific import situations,” on 
page 278.

Table 12-3 General import situations

Problem/Situation Solution/Rule

Item already exists in database 
(same OID)

If the user has indicated that 
existing items mustn't be updated 
then don't import item; otherwise 
overwrite item. 

Item with same search code or 
name exists in database 
(different OID).

Don't import item if search code or 
name must be unique, otherwise 
import. Handled by WF layer.

Item references unknown item. General rule: import without 
reference.

Item that's classified as default 
is imported while another 
default item already exists in 
database

New item will become the default. 
The existing default item won't be 
the default any longer.
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Table 12-4 Specific import situations

Setting Problem/Situation Solution/Rule

Checklist Referenced item 
(Service or 
Classification) 
doesn’t exist.

Import without the 
reference.

Codes Ordered code has a 
specific ordering.

Always assign the 
ordered code the 
highest ordering.

Hierarchical code 
has a parent.

- Start any import 
with parent codes 
first. - If the parent 
code can’t be found 
place code in root.

Custom fields Code doesn’t exist. Import without 
reference.

Overview actions Referenced view 
doesn’t exist

Don’t import action

Required fields Code doesn’t exist. Import without 
reference.

UI rules Referenced code or 
other Entity item or 
action doesn’t exist.

Import without 
reference.

Database rules Referenced code or 
other Entity item 
doesn’t exist.

Import without 
reference.

Smart actions Application doesn’t 
exist

Don’t import action 
(reason: application is 
required field).

Templates Referenced item 
used as default 
doesn’t exist.

Import template with 
reference (unknown 
reference is handled 
by the system).
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Procedure

1. On the Tools menu, click System to open the Administrator console.

2. In the Administrator console select File, then Aces and select Aces 
Import Wizard.

3. On the first page of the ACES Import Wizard click Next.

Figure 12-10 Import wizard

4. Select the XML file(s) required

Views Referenced item in 
Filter doesn’t exist.

Import view without 
specific condition.

Forms Referenced custom 
field is not an 
activated custom 
field

Import form with the 
custom field reference 
(field won’t show up 
runtime)

Table 12-4 Specific import situations (Continued)

Setting Problem/Situation Solution/Rule
Chapter 12  279



Administrator Console Export Settings
Using the ACES Import Wizard
Figure 12-11 Import file selection

a. Click Add.

b. Browse to the directory required and select the necessary XML 
files. 

c. Confirm or specify the name of the log file, and its location by 
means of the browse button.

d. Check or uncheck the Overwrite existing items button as 
required.

If the Overwrite button is left unchecked no existing data will be 
overwritten. If the Overwrite option is checked this can result in 
loss of existing data.

NOTE If you are re-importing an Aces setting that has been previously 
deleted ensure that the overwrite option is checked. This is 
because the OID of the item remains in the database after the 
item has been deleted.

e. Click Next.

5. Click Start import. The status of the import is indicated in the 
progress bar. During the import process you will be shown 
information regarding the status of the import. The import process 
the Next and Back buttons are disabled. At the end of the import 
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process you are automatically sent to the next page of the wizard. It 
is possible to cancel the import process using the Cancel button. This 
will stop further files being imported but will not remove or roll back 
to previous versions of any files that have been overwritten. 

NOTE There is no procedure to remove new (or overwritten) files. 

Figure 12-12 Import progress screen

6. Select whether you wish to view the Import log by pressing View Log 
File, view a different log file by selecting browse and then View Log 
File or select the option Close the Wizard or Restart the Wizard 
and then Finish. The definitions of the elements on the progress 
screen are similar to those given in Table 12-2 on page 274 with the 
exception that where the definition states export for this screen it is 
import.
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Figure 12-13 Import completed

NOTE When the import has been completed the newly imported settings will 
not be visible until the F5 button (Refresh) is pressed.
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Importing associated relations
For items that have associated relations there are various conditions 
that can be set in ACES views and the Import wizard to achieve the 
required results. 

It is not possible to automatically determine which associated relations 
are required for export so this has to be set manually, See “Exporting 
associated relations” on page 268.

The following table shows scenarios if you require to import the Accounts 
but not the Roles:

Table 12-5 Importing accounts but not roles

Role 
associations

Overwrite check 
box Result

Checked Checked Accounts that exist will be 
overwritten and previously 
non-existing accounts will 
be added. Relations to 
existing roles will be 
created but relations to 
any roles that do not exist 
will generate errors.

Unchecked Checked Accounts that exist will be 
overwritten and previously 
non-existing accounts will 
be added. No relations to 
roles will be created.

Checked Unchecked Accounts that exist will be 
generate errors and 
previously non-existing 
accounts will be added. 
Relations to existing roles 
will be created but 
relations to any roles that 
do not exist will generate 
errors
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If you want to import the accounts and the roles the item that is inserted 
last will have the associations, for example: 

• Accounts (associations to Roles unchecked) then Roles (associations 
to Accounts checked)

• Roles (associations to Accounts unchecked) then Accounts 
(associations to Roles checked).

If the only items exported are only present on the source Service Desk 
and have never been previously imported on the destination Service 
Desk the items will be unique and no errors will be created.

All referenced items should also be imported to eliminate errors relating 
to missing or unknown references.

If the Overwrite button is left unchecked no existing data will be 
overwritten. 

Unchecked Unchecked Accounts that exist will 
generate an error and 
previously non-existing 
accounts will be added. No 
relations to roles will be 
created.

Table 12-5 Importing accounts but not roles (Continued)

Role 
associations

Overwrite check 
box Result
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13 System Maintenance

This chapter discusses issues related to Service Desk and its relationship 
to your chosen database.
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The data that should be saved or restored resides in the database that 
the user selects. The choices are limited to Oracle and SQL Server. Any 
backup that includes the database files, for example the .dbf files for 
Oracle, rollback segments etc. or an export of the data itself, is sufficient. 
Please refer to your database documentation for information.

No specific configuration files, other than user preferences on the client 
machines, must be saved individually. As specific files can be replaced, 
renamed or moved from release to release, there is a danger that this 
information may not be relayed to the system administrator. Therefore, 
it is better not to save files individually.

The system administrator, using the backup tools of his choice, can 
backup the system in the following ways:

• Application server: 
A full NT backup including the registry suffices. There are no specific 
configuration files that must be saved individually.

• Web server (for Service Pages): 
Depends upon the platform and directory structure. An NT backup 
can be performed as with the application server. You can also 
reinstall and copy any customized .html files to the desired 
directory.

• Database server: 
A backup of the database files is sufficient. The database 
administrator should be able to identify these files. Some 
administrators find it easier to reinstall the system and database 
software from scratch and then import the data. Please refer to your 
database documentation for information.
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Backing Up and Restoring A Test Database
As you may want to create a test environment to help you to plan your 
implementation of Service Desk 4.5, the Database Configuration Wizard 
contains a ‘hidden’ feature to help you maintain your test database. This 
feature is only visible if the wizard is started from the command line.

For information about the Database configuration Wizard see the HP 
OpenView Service Desk: Installation Guide, Chapter 4 Configuring the 
Database. 

NOTE The Backup and Restore functions described here can use large amounts 
of memory, depending on the size of the database you are backing up and 
restoring. To improve performance with large databases, and avoid 
possible java.lang.OutOfMemory errors you can edit the start script of 
the wizard and add the parameters -Xms128m -Xmx256m to the java 
program. For example: -Xms128m -Xmx256 -jar lib/database.jar.

To use the Maintain Database option in the Database Configuration 
Wizard on Windows:

1. Open a Command Prompt window and navigate to the \server\bin 
folder of your Service Desk 4.5 tree.

2. Use the command sd_dbconfwizard.bat -internal. The Database 
Configuration Wizard starts. 

3. Click next in the Welcome screen.

To use the Maintain Database option in the Database Configuration 
Wizard on UNIX:

1. Run /opt/OV/sd/server/bin/sd_dbconfwizard.sh -internal. 
The Database Configuration Wizard starts. 

2. Click next in the Welcome screen.
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To backup a test database

1. When you start the wizard the Welcome screen is displayed, Click 
Next. The Choose the action you want to perform dialog box is 
displayed:

Figure 13-1 Choose the action dialog box

2. In the Choose the action you want to perform dialog box select 
Maintain Database. The Choose the maintenance task you 
want to perform dialog box is displayed:
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Figure 13-2 Choose the maintenance task dialog box

3. In the Choose the maintenance task you want to perform 
dialog box select Backup Database. This option reads the database 
and stores it four files, a Repo User file, a datastore file, and two 
sizing files for each of the other two files. Click Next, the Prepare 
for object creation dialog box is shown:

NOTE If the database you are backing up is an Oracle database with only 
one user, or a SQL Server database the backup program will still 
create two backup files but the datastore file will be empty. 
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Figure 13-3 Prepare for object creation dialog box

4. Use the Prepare for object creation dialog box to make sure the 
correct database user is being backed up, if the correct database is 
not displayed use the Accounts button and the Server Settings 
Editor is displayed (see the HP OpenView Service Desk 4.5: 
Installation Guide, Chapter 5 - Configuring the Server) use this to 
select the right database. When you return to this screen after 
selecting the database, the details will not show until you press 
Refresh. When the correct database details are displayed, click 
Next.

5. A dialog box is displayed for you to give the file a name and location. 
If you use an existing file name it will be overwritten without 
prompting you to confirm the overwrite. Press Save. Another dialog 
box will be displayed for you to enter the filename for the Repository 
file. The sizing files are named automatically as s_<filename>, 
when the backup files are saved. Press Save to continue.

6. The backup process is initiated.

7. The Database configuration finished dialog box is displayed, 
and a log file of the backup process is shown. Click Finish:
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Figure 13-4 Database configuration finished dialog box

To restore a backed up test database

1. When you start the wizard the Welcome screen is displayed, Click 
Next. The Choose the action you want to perform dialog box is 
displayed:
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Figure 13-5 Choose the action dialog box

2. In the Choose the action you want to perform dialog box select 
Maintain Database. The Choose the maintenance task you 
want to perform dialog box is displayed:

Figure 13-6 Choose the maintenance task dialog box

3. In the Choose the maintenance task you want to perform 
dialog box select Restore Database. The Choose what you want 
to load dialog box is displayed:
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Figure 13-7 Choose what you want to load dialog box

4. In the Choose what you want to load dialog box select Load 
Binary. A dialog box will be displayed, navigate to the backup files, 
select them and click Open to return to the database configuration 
wizard.

5. The process of restoring the database then follows normal database 
configuration as described from Step 3 onwards in the HP OpenView 
Service Desk 4.5: Installation Guide, Chapter 4 - Configuring the 
Database.

To check the integrity of a database

1. When you start the wizard the Welcome screen is displayed, Click 
Next. The Choose the action you want to perform dialog box is 
displayed:
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Figure 13-8 Choose the action dialog box

2. In the Choose the action you want to perform dialog box select 
Maintain Database. The Choose the maintenance task you 
want to perform dialog box is displayed:

Figure 13-9 Choose the maintenance task dialog box

3. In the Choose the maintenance task you want to perform 
dialog box select Check Database. The Check database structure 
progress dialog box is displayed. Ensure the database details are 
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correct, if the are not use the Accounts button and the Server 
Settings Editor is displayed (see the HP OpenView Service Desk 4.5: 
Installation Guide, Chapter 5 - Configuring the Server) use this to 
select the right database. When you return to this screen after 
selecting the database, the details will not show until you press 
Refresh. When the correct database details are displayed, click 
Verify Database Structure to initiate the checking process:

Figure 13-10 Check database structure progress dialog box

4. The Database configuration finished dialog box is displayed. If 
there are errors in the database a pop up dialog box is also displayed 
informing you the database is broken, click OK. Click Finish to close 
the wizard:
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Figure 13-11 Database configuration finished dialog box
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14 Database Sizing

This document contains information to assist you in calculating the 
amount of database storage space needed to run Service Desk 4.5. 
Information is provided for both Oracle 8 and SQL Server 7. 
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This section contains information on the sizing of a database for HP 
OpenView Service Desk 4.5 running on Oracle 8. Oracle version 8.0.5 
was used in calculating the requirements.

An Excel spreadsheet is supplied on the Service Desk 4.5 Windows CD to 
enable you to calculate the database sizes easily. The calculations on the 
spreadsheet correspond to the figures shown below. Instructions for 
using the speadsheets are provided within the Excel file. The Oracle 
database spreadsheet can be found at the location \\doc\database 
sizing\sd oracle8 sizing.xls.

Database sizes will be given for two separate Oracle accounts. One 
account facilitates the storage of the Service Desk repository, the data 
that describes the application. The second account is used for the data 
related to the processes managed by Service Desk, like the helpdesk 
process.

For both accounts an estimate will be given of the storage space that will 
always be needed, and the additional space needed when adding large 
amounts of managed data.

Note that the estimates given in this document are deliberately on the 
safe side; your actual data may take up less space. A more accurate 
estimate can be obtained by comparing the data characteristics at an 
actual site with the assumptions listed for the calculation, and adjusting 
the estimates accordingly.

Repository Database Account

The initial contents of the repository uses approximately 8 MB of disk 
space. Upon installation, the repository contains about 150 views, about 
120 forms, and about 100 templates.
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Most of the repository’s tables are static after installation. Only for a 
limited number of entities is the addition of a larger amount of data 
likely to occur. The following table gives an estimate of the amount of 
additional storage space needed for objects added to each entity.

Service Desk Database Account

Service Desk contains a number of entities that are static after 
installation, such as code values and support hours, that take about 640 
KB of disk space. For every language added, an additional 128 KB must 
be reserved.

The operation of Service Desk is centered around a limited number of 
entities. For each of these entities, the volume processed is specific for 
the Service Desk implementation. The tables in this section present 
material for a rough estimate of the amount of storage space for every 
1000 objects of a given entity.

Table 14-1 Additional Storage Space

Entity KB needed per number of objects

Language 1200 per language

Account 300 per 1000 accounts

View 1000 per 100 views

Form 400 per 100 forms

Template 200 per 100 templates

Table 14-2 Basic Operational Data

Entity KB needed for 1000 objects

Addresses 160

Locations 160

Telephones 80 (Telephone numbers include numbers for fax 
machines, cellular phones, pagers, etc.)
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Attachments 300 (Not actual attachments, but administrative 
data.)

Table 14-3 Personnel and Organizational Data

Entity KB needed for 1000 objects

Workgroups 3500

Organizations 4000

Persons 4300 (Assuming on average a person is a member of 
a single workgroup.)

Table 14-4 Configuration Management Data

Entity KB needed for 1000 objects

Configuration 
items

6000 (Assuming on average a configuration item 
has one parent-child relation and one other relation 
with another configuration item, and one user is 
linked to each configuration item.)

Maintenance 
Contracts

4000

Table 14-5 Change Management Data

Entity KB needed for 1000 objects

Changes 8000

Table 14-6 Helpdesk Management Data

Entity KB needed for 1000 objects

Service Calls 10500 (Assuming on average a service call is related 
to one incident, change or problem.)

Table 14-2 Basic Operational Data (Continued)

Entity KB needed for 1000 objects
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Computations

A rough estimate of the database storage needed can be obtained by 
filling in figures in the table below, or in the Excel spreadsheet:

Incidents 7500

Projects 7500

Table 14-7 Problem Management Data

Entity KB needed for 1000 objects

Problems 7500

Table 14-8 Work Order Management Data

Entity KB needed for 1000 objects

Work orders 7800 (Assuming on average a work order is related 
to a single configuration item.)

Table 14-6 Helpdesk Management Data (Continued)

Entity KB needed for 1000 objects

Table 14-9 Repository Database Computations

Installed 
Contents

> > 8000 KB

Language each x 1200 KB

Account per 1000 x 300 KB

View per 100 x 1000 KB

Form per 100 x 400 KB

Template per 100 x 200 KB

Total: > >
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The following assumptions are made when estimating the amount of 
table space needed:

• 8-KB database blocks are used. 

• Standard extent sizes of 10 KB, 50 KB, and 100 KB are used.

• Where non-mandatory fields exist in Service Desk tables, these are 
used up to 30 percent of their capacity.

Table 14-10 Service Desk Database Computations

Static data > > 640 KB

Language each x 128 KB

Addresses per 1000 x 160 KB

Locations per 1000 x 160 KB

Telephones per 1000 x 80 KB

Attachments per 1000 x 300 KB

Organizations per 1000 x 4000 KB

Persons per 1000 x 4300 KB

Workgroups per 1000 x 3500 KB

Configuration 
items

per 1000 x 6000 KB

Maintenance 
contracts

per 1000 x 4000 KB

Changes per 1000 x 8000 KB

Service calls per 1000 x 10500 KB

Incidents per 1000 x 7500 KB

Problems per 1000 x 7500 KB

Projects per 1000 x 7500 KB

Work orders per 1000 x 7800 KB

Total > >
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• Custom fields and comment fields on history lines are used up to 1 
percent of their capacity.

• An average of 10 history lines is entered with an entity.

• Index entries exist for all table entries. 
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SQL Server Database
This section contains information on the sizing of a database for HP 
OpenView Service Desk 4.5 running on SQL Server 7.0.

An Excel spreadsheet is supplied on the Service Desk 4.5 Windows CD to 
enable you to calculate the database sizes easily. The calculations on the 
spreadsheet correspond to the figures shown below. Instructions for 
using the speadsheets are provided within the Excel file. The SQL Server 
database spreadsheet can be found at the location \\doc\database 
sizing\sd sql server sizing.xls.

Database space needed will be presented for two separate groups of data. 
One group contains the Service Desk repository, the data that describes 
the application. The second group is the data related to the processes 
managed by Service Desk, like the helpdesk process.

For both groups an estimate will be given of the storage space that will 
always be needed, and the additional space needed when adding large 
amounts of managed data.

Note that the estimates given in this document are deliberately on the 
safe side; your data may take up less space. A more accurate estimate 
can be obtained by comparing the data characteristics at an actual site 
with the assumptions listed for the calculations, and adjusting the 
estimates accordingly.

Repository Database Account

The initial contents of the repository uses approximately 8 MB of disk 
space. Upon installation, the repository contains about 150 views, 120 
forms, and 100 templates.

Most of the repository’s tables are static after installation. Only a limited 
number of entities are likely to have data added to them. The following 
table gives an estimate of the amount of storage space needed for 
additional objects added to each of those entities.

Table 14-11 Additional Storage Space

Entity KB needed per number of objects

Language 1400 per language
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Service Desk contains a number of entities that are essentially static 
after installation. These are entities like code values and support hours. 
These take about 560 KB of disk space. For every language added, an 
additional 192 KB must be reserved.

The operation of Service Desk is centered around a limited number of 
entities. For each of these entities, the volume processed will be specific 
to the Service Desk implementation. The tables in this section present 
material for a rough estimate of the amount of storage space for every 
1000 objects of a given entity.

Account 240 per 1000 accounts

View 800 per 100 views

Form 300 per 100 forms

Template 400 per 100 templates

Table 14-11 Additional Storage Space (Continued)

Entity KB needed per number of objects

Table 14-12 Basic Operational Data

Entity KB needed for 1000 objects

Addresses 240

Locations 200

Telephones 160 (Telephone numbers include numbers for fax 
machines, cellular phones, pagers, etc.)

Attachments 360 (Not actual attachments, but administrative 
data.)
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Table 14-13 Personnel and Organizational Data

Entity KB needed for 1000 objects

Workgroups 4200

Organizations 5300

Persons 5700 (Assuming on average a person is a member of 
a single workgroup.)

Table 14-14 Configuration Management Data

Entity KB needed for 1000 objects

Configuration 
items

7500 (Assuming on average a configuration item 
has one parent-child relation and one other relation 
with another configuration item, and one user is 
linked to each configuration item.)

Maintenance 
contracts

3800

Table 14-15 Change Management Data

Entity KB needed for 1000 objects

Changes 9300

Table 14-16 Helpdesk Management Data

Entity KB needed for 1000 objects

Service Calls 12000 (Assuming on average a service call is related 
to one incident, change or problem.)

Incidents 8700

Projects 8500
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A rough estimate of the database storage needed can be obtained using 
the figures outlined below, or in the Excel spreadsheet:

Table 14-17 Problem Management Data

Entity KB needed for 1000 objects

Problems 8700

Table 14-18 Work Order Management Data

Entity KB needed for 1000 objects

Work orders 9400 (Assuming on average a work order is related 
to a single configuration item.)

Table 14-19 Repository Database Computations

Installed Contents > > 8000 KB

Language each x 1400 KB

Account per 1000 x 240 KB

View per 100 x 800 KB

Form per 100 x 300 KB

Template per 100 x 400KB

Total: > >

Table 14-20 Service Desk Database Computations

Static data > > 560 KB

Language each x 192 KB

Addresses per 1000 x 240 KB

Locations per 1000 x 200 KB

Telephones per 1000 x 160 KB
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The following assumptions are made when estimating the amount of 
table space needed:

• Where optional fields exist in Service Desk tables, these are used up 
to 30 percent of their capacity. 

• Custom fields and comment fields on history lines are used up to 1 
percent of their capacity.

• An average of 10 history lines is entered with an entity. 

Index entries exist for all table entries. 

Attachments per 1000 x 360 KB

Organizations per 1000 x 5300 KB

Persons per 1000 x 5700 KB

Workgroups per 1000 x 4200 KB

Configuration Items per 1000 x 7500 KB

Maintenance 
contracts

per 1000 x 3800 KB

Changes per 1000 x 9300 KB

Service calls per 1000 x 12000 KB

Incidents per 1000 x 8700 KB

Projects per 1000 x 8500 KB

Problems per 1000 x 8700 KB

Work orders per 1000 x 9400 KB

Total > >

Table 14-20 Service Desk Database Computations (Continued)
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15 Support Tools

This chapter explains how to use the support tools supplied with Service 
Desk 4.5.
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Service Desk 4.5 provides support tools from the application server, the 
client, and Service Page. These support tools can be used in the event of 
a problem arising with Service Desk that results in a call to the Service 
Desk support line.

The support tools effectively compress logs files and other data into a zip 
file that can be used by a support engineer or sent to Service Desk 
Support as an attachment to an e-mail or service call for analysis.

Server Support Tool

On the server the support tool is called sd_serversupporttool.bat (on 
UNIX use the sd_serversupporttool shell script) and can be found in 
the server\bin folder.

When you run this tool it gathers basic system information, copies the 
server_settings.xml file, and copies the first 1000 lines of both the 
logserver.txt and logdatabase.txt log files. This data is compiled 
into a zip file called 
server_support_information_<date>_<time>.zip and placed in the 
server\support folder.

Client Support Tool

On the client the support tool is called sd_clientsupporttool.bat and 
can be found in the client\bin folder.

When you run this tool it gathers basic system information, copies the 
user_settings.xml file, and the first 1000 lines of the logclient.txt 
log file. This data is compiled into a zip file called 
client_support_information_<date>_<time>.zip and placed in the 
client\support folder.

Service Pages Support Tool

For service pages the support tool is called 
sd_servicepagessupporttool.bat (on UNIX use the 
sd_servicepagessupporttool shell script) and can be found in the 
service pages\bin folder.
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When you run this tool it gathers all Tomcat log files, copies the various 
xml files in the Tomcat folder and copies the hpovsdservicepages.log 
log file. This data is compiled into a zip file called 
servicepages_support_information_<date>_<time>.zip and placed 
in the service pages\support folder.
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